
  

   ScaleLink Pro 
 
 
 
 

   USER GUIDE 
 
 
 

For Version 3.24 
January 2005 

 
 

ISHIDA CO., LTD 
 

  



Copyright © 2001-2004 Ishida Co. Ltd., Japan 
 
No part of this manual may be reproduced or transmitted in any form or by any means, electronic or mechanical, 
without permission in writing from Ishida Co. Ltd. 
 
Microsoft Windows is a registered trademark of Microsoft Corporation. 
 
 

  



Revision History 

Date Program 
Version 

Page/Sectio
n 

Description 

4th July 2003 3.11 35 Added note about ADO version of ScaleLink Pro 
4th July 2003 3.2 107 Updated system requirements section 
18th Nov 2003 3.21 86, 144 Added explanation of e-mail settings 
1st April 2004 3.22 59, 

122 
1. Revised explanation of store name & address for 
AC-4000 
2. Added additional explanation of label size settings. 

18th June 
2004 

3.22b 96 Removed reference to being able to disable the auto 
resend feature and automatic checking of off-line 
scales, as this can no longer be disabled. 

30th June 
2004 

3.22c 110 - 114 Updated explanation of Options setup dialog to match 
recent changes. 

30th June 
2004 

3.22c 7.1 Added explanation of price zones in PLU list report 

8th May 2004 3.22c 3.1, 9.8 Added note that automatic resending to scale can be 
disabled. 

8th August 
2004 

3.23 2, 6.5, 6.9, 
6.12, 6.13 

Added SR-2000 support 

29th October 
2004 

3.24 6.13, 6.14, 
7.3 

Added support for SR-2000 preset key images. 

26th 
November 
2004 

3.24c 6.13, 
Appendix 
A.2 

Revised support for SR-2000 preset key images. 
Added explanation of price zone setting in user access 
control. 
Added explanation of setting PLU active/inactive as a 
price zone field. 

11th January 
2005 

3.2x Appendix C Updated list of integer codes used as Automation 
method parameters. 

25th January 
2005 

3.24d 6.13 Added explanation of default key for SR presets. 

    
 

  



Contents 
 
1. Introduction .......................................................................................................................................... 1 

How to Use This Manual ................................................................................................................. 1 
2. Getting Started...................................................................................................................................... 2 

Which Communications Link are You Using?........................................................................ 2 
Starting ScaleLink Pro............................................................................................................. 4 
Finding a PLU ......................................................................................................................... 5 

If you know the PLU number ......................................................................................... 5 
If you know some or all of the PLU name ...................................................................... 5 
If you do not know the PLU number or name ................................................................ 5 

Adding a New PLU ................................................................................................................. 5 
Editing and Deleting PLUs...................................................................................................... 5 

To edit the selected PLU................................................................................................. 5 
To delete the selected PLU ............................................................................................. 6 

Changing PLU Prices .............................................................................................................. 6 
Using the Price Change Dialog ....................................................................................... 6 
Markdown Price Changes ............................................................................................... 6 

Nutrition .................................................................................................................................. 6 
Using the PLU Edit Window................................................................................................... 7 

Entering the PLU description.......................................................................................... 8 
Entering the PLU settings ............................................................................................... 8 
Changing the PLU number ............................................................................................. 8 
Saving your changes ....................................................................................................... 9 
Changing the displayed PLU .......................................................................................... 9 
Adding a new PLU.......................................................................................................... 9 
Closing the PLU Edit window ........................................................................................ 9 

Editing Other Scales Data...................................................................................................... 10 
Editing a campaign........................................................................................................ 10 
Editing advertising messages ........................................................................................ 11 
Editing ingredient and other messages.......................................................................... 11 
Editing keyboard presets ............................................................................................... 12 
Memo/SR-2000 presets (EMZ and SR-series scales only) and Index presets (EMZ-series 
scales only).................................................................................................................... 14 
Editing the store name and address............................................................................... 15 
Editing store settings (EMZ-series scales only) ............................................................ 15 
Editing tray settings (EMZ-series scales only) ............................................................. 16 

Other Features ....................................................................................................................... 17 
3. Communicating with the Scales ......................................................................................................... 19 

3.1 On-Line Communications........................................................................................................ 20 
Establishing Communications with the Scales ...................................................................... 20 
Sending Data to the Scales .................................................................................................... 20 
Sending a Range of Records to the Scales ............................................................................ 20 
Filtering Data Sent to the Scales............................................................................................ 22 
Disabling the Communication Link....................................................................................... 22 
Enabled vs. Connected .......................................................................................................... 22 
Off-Line Operation................................................................................................................ 23 

3.2 Data Save Communications ..................................................................................................... 24 
Managing Data Save Files (AC-3000) .................................................................................. 24 
Managing Data Save Files (WM-3002)................................................................................. 24 
Operation (AC-3000) ............................................................................................................ 25 

Receiving a Data Save File from the Scales ................................................................. 25 
Opening the Received File in ScaleLink Pro ................................................................ 25 
Editing the Data Save File Data .................................................................................... 26 
Saving the Data Save File and Transmitting to the Scale ............................................. 26 

Operation (WM-3002)........................................................................................................... 28 
Receiving a Data Save File from the Scales ................................................................. 28 
Opening and Editing the Received File in ScaleLink Pro............................................. 28 

  



Transmitting to the Scale .............................................................................................. 29 
3.3 Astra/AstraXT Serial Communications ................................................................................... 30 

Receiving Data from the Scale .............................................................................................. 30 
Sending Data to the Scale...................................................................................................... 31 

4. Using an IF21FD................................................................................................................................ 33 
Using an IF21FD to Receive Data from the Scales ............................................................... 33 
Using an IF21FD to Transfer Data to the Scales................................................................... 34 

5. The PLU Database.............................................................................................................................. 35 
Database Formats .................................................................................................................. 35 
Selecting the Database........................................................................................................... 35 
Managing Databases.............................................................................................................. 36 

5.1 Microsoft Access Database Format ......................................................................................... 36 
Features and Restrictions....................................................................................................... 36 

5.2 Ishida PLU Database Format ................................................................................................... 37 
Features and Restrictions....................................................................................................... 37 

5.3 Multi-User Operation............................................................................................................... 37 
6. Editing PLUs and Other Scales Data.................................................................................................. 38 

6.1 Using the PLU Search Window............................................................................................... 38 
Finding a PLU ....................................................................................................................... 39 

If you know the PLU number ....................................................................................... 39 
If you know some or all of the PLU name .................................................................... 39 
If you do not know the PLU number or name .............................................................. 39 
Searching by POS code (bar code) ............................................................................... 39 
Searching by department and group code ..................................................................... 39 

Adding a New PLU ............................................................................................................... 39 
Editing or Deleting a PLU..................................................................................................... 40 
Deleting a Range of PLUs..................................................................................................... 40 
Cutting and Pasting PLUs ..................................................................................................... 40 
Quick Price Changes ............................................................................................................. 41 
Nutrition ................................................................................................................................ 42 
Ingredients ............................................................................................................................. 43 

6.2 Using the PLU Edit Window ................................................................................................... 44 
6.3 Editing Price Master Records (IP-EMZ only) ......................................................................... 47 

Creating and Editing Price Master Records........................................................................... 47 
6.4 Advertising Messages .............................................................................................................. 49 

Creating and Editing Advertising Messages.......................................................................... 49 
Deleting an Advertising Message.......................................................................................... 49 

6.5. Messages ................................................................................................................................. 50 
Creating and Editing Messages ............................................................................................. 50 
Deleting a Message................................................................................................................ 52 

6.6 Campaigns................................................................................................................................ 53 
Creating and Editing Campaigns........................................................................................... 53 
Deleting a Campaign ............................................................................................................. 54 

6.7 Keyboard Presets ..................................................................................................................... 55 
Managing Keyboard Data...................................................................................................... 55 
Creating and Editing Keyboard Presets................................................................................. 55 

6.8 Operators.................................................................................................................................. 58 
6.9 Store Name and Address (AC-3000, AstraXT, AC-4000, and SR-2000) ............................... 59 
6.10 Store Settings (EMZ series only) ........................................................................................... 60 

Creating and Editing Store Settings....................................................................................... 60 
Deleting Store Settings .......................................................................................................... 60 

6.11 Tray Settings (EMZ series only) ............................................................................................ 61 
Creating and Editing Tray Settings ....................................................................................... 61 
Deleting Tray Settings ........................................................................................................... 61 

6.12 Department and Group (AC-4000, SR-2000, and EMZ series only)..................................... 62 
Creating and Editing EMZ Department and Group Names................................................... 62 
Deleting EMZ Department and Group Names ...................................................................... 62 

6.13 Memo and Index Presets (EMZ and SR series only) ............................................................. 63 
SR Presets Overview ............................................................................................................. 63 

  



Creating and Editing SR Presets............................................................................................ 63 
Creating and Editing Memo Presets ...................................................................................... 66 
Creating and Editing Index Presets ....................................................................................... 67 

6.14 SR-2000 alpha Images (SR series only) ................................................................................ 69 
Creating and Editing SR Images ........................................................................................... 69 

7. Reports ............................................................................................................................................... 71 
7.1 The PLU and Message Reports................................................................................................ 71 
7.2 Production Reports .................................................................................................................. 73 

Accumulating Production Data Totals................................................................................... 73 
Production Data Files ............................................................................................................ 73 
Adjusting Production Data Totals ......................................................................................... 74 
PLU Production Report ......................................................................................................... 75 
Department and Group Production Report ............................................................................ 77 
Daily and Weekly Totals Reports.......................................................................................... 79 
Operator Totals and Operator Override Totals Reports ........................................................ 80 
Hourly Totals Report ............................................................................................................. 81 

7.3 SR-2000 alpha Image List Report............................................................................................ 82 
8. Importing and Exporting Data............................................................................................................ 83 

8.1 Text File Import ....................................................................................................................... 83 
Using Pre-Defined Text File Import Operations ................................................................... 83 
Specifying a Text File Import Operation Directly................................................................. 84 
Text File Import Operation.................................................................................................... 85 

8.2 Text File Export ....................................................................................................................... 86 
Text File Format .................................................................................................................... 86 
Using Pre-Defined Text File Export Operations ................................................................... 86 
Specifying a Text File Export Operation Directly................................................................. 87 

8.3 Database Import ....................................................................................................................... 88 
Using Pre-Defined Database Import Operations ................................................................... 88 
Specifying a Database Import Operation Directly................................................................. 88 
Import Operation and Price Zones......................................................................................... 89 

8.4 Loading PLUs and Other Data from the Scales ....................................................................... 90 
Procedure for Loading Data from the Scales (ID-ENQ) ....................................................... 90 

9. Advanced Features and Utilities......................................................................................................... 91 
9.1 Event Logging.......................................................................................................................... 91 

9.1.1 Event Log ..................................................................................................................... 91 
Viewing the Log ........................................................................................................... 91 

9.1.2 PLU Update and Exception Log................................................................................... 92 
9.1.3 Scale Status Log ........................................................................................................... 92 
9.1.4 Text File Import Logs................................................................................................... 92 
9.1.5 Communication Log ..................................................................................................... 92 

9.2 Departments ............................................................................................................................. 93 
9.3 PLU Range Profile................................................................................................................... 94 
9.4 PLU Active/Inactive ................................................................................................................ 95 
9.5 Batch Mode.............................................................................................................................. 96 

Using Batch Mode................................................................................................................. 96 
Batch Mode and Departments ............................................................................................... 96 
Loading a Batch File ............................................................................................................. 97 

9.6 Price Zones .............................................................................................................................. 98 
9.7 User Access Control ................................................................................................................ 99 
9.8 Scheduler ............................................................................................................................... 100 

Starting the Scheduler Program........................................................................................... 100 
Running the Scheduler ........................................................................................................ 101 
Error Handling..................................................................................................................... 101 
Off-Line Operation.............................................................................................................. 101 
Setting up Scheduler Operations ......................................................................................... 102 

9.9 Sale Wizard............................................................................................................................ 104 
What the Sale Wizard Does................................................................................................. 104 
Using the Sale Wizard ......................................................................................................... 104 

9.10 Automation .......................................................................................................................... 109 

  



Supported Features .............................................................................................................. 109 
Setup File............................................................................................................................. 109 
Handling of Unsent Data ..................................................................................................... 109 
Program Structure 1 - Executing Scheduler Operations...................................................... 110 
Program Structure 2 - Executing Operations Directly......................................................... 111 

Appendix A  Installing ScaleLink Pro at a New Store ......................................................................... 112 
A.1 Installing the Software .......................................................................................................... 112 

System Requirements .......................................................................................................... 112 
Installing ScaleLink Pro ...................................................................................................... 112 
Uninstalling ScaleLink Pro.................................................................................................. 112 
Multi-User Installation ........................................................................................................ 113 

A.2 Setting Up ScaleLink Pro...................................................................................................... 114 
Which Communications Link?............................................................................................ 114 
Networks Containing More Than One Type of Scale ......................................................... 115 
Setting Up the ScaleLink Pro Software............................................................................... 115 
Outputting a Listing of all ScaleLink Pro Settings.............................................................. 115 
Report Settings .................................................................................................................... 121 
Log Settings......................................................................................................................... 122 
Custom Log Settings ........................................................................................................... 123 
Multi-Store Settings............................................................................................................. 125 
Data Save Settings............................................................................................................... 126 
Label Sizes........................................................................................................................... 127 
EMZ Settings....................................................................................................................... 129 
Setting Up ID-ENQ Communications ................................................................................. 131 
Setting Up Data Save Communications .............................................................................. 135 
Setting Up Department and Group Codes ........................................................................... 136 
Setting Up Departments....................................................................................................... 138 
Setting Up the PLU Range Profile ...................................................................................... 140 
Setting Up ScaleLink Pro Users .......................................................................................... 141 
Disabling User Access Control............................................................................................ 143 
Using the User Access Control Feature to Customize ScaleLink Pro ................................. 143 
Setting Up User Profiles ...................................................................................................... 144 
Setting Up Price Zones........................................................................................................ 144 
Setting Up Text File Import and Export .............................................................................. 146 
Setting Up Database Import ................................................................................................ 148 
Setting Up Default Line Fonts............................................................................................. 149 
e-Mail Settings..................................................................................................................... 150 

A.3 PLU Field Setup.................................................................................................................... 151 
Selecting Fields for the PLU Edit Window and PLU Report .............................................. 151 
Customizing a PLU Field (Advanced Settings)................................................................... 152 

Appendix B  Text File Formats and Operations................................................................................... 154 
B.1 Operations ............................................................................................................................. 154 

Operation Commands .......................................................................................................... 154 
Operations ........................................................................................................................... 154 

B.2 Text File Formats .................................................................................................................. 155 
Text File Export Format ...................................................................................................... 155 
Text File Import Format (Additions and Updates) .............................................................. 155 
Text File Import Format (Deletions) ................................................................................... 156 
Operation Command............................................................................................................ 156 
Price Zone............................................................................................................................ 156 
Description Text Formats .................................................................................................... 156 
Keyboard Presets Import File Format.................................................................................. 157 
SaleWizard Import File Format ........................................................................................... 160 

Appendix C  ScaleLink Pro Automation Reference............................................................................. 162 
C.1 ScaleLink Pro Object ............................................................................................................ 162 
C.2 ScaleLink Pro Properties ....................................................................................................... 162 
C.3 ScaleLink Pro Methods ......................................................................................................... 162 
C.4 Parameter Codes.................................................................................................................... 163 
C.5 Method Details ...................................................................................................................... 165 

  



 

  



1. Introduction 
This manual describes how to use ScaleLink Pro, the Ishida PLU Editor. 

The aim of the ScaleLink Pro software is to simplify the process of creating and managing the 
PLU and other information used in Ishida scales. ScaleLink Pro includes the following features. 

• Provides a visual interface for creating and editing the following scales data. 
 PLUs 
 Ingredients and other messages 
 Nutrition information 
 Advertising messages (scrolling messages) 
 Keyboard presets 
 Campaigns 
 Store name and address 
 Tray data 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

Scales data can be sent to and read from the scales via a serial port or LAN connection. 

Quick price change feature 

Search function for quickly locating the desired PLU 

PLU and production data reports 

Batch mode for off-line changes 

Price zone feature for multi-store operation 

Text file import and export 

Import from ODBC database 

Scheduler feature for automating often-used operations 

Print scale keyboard templates 
 
 
 
 
 
 

How to Use This Manual  

If you are a new user wishing to familiarize 
yourself with the software. 

 See Chapter 2  Getting Started 

If you are about to install a copy of ScaleLink 
Pro and configure it for a particular store. 

 See Appendix A  Installing ScaleLink Pro 
at a New Store 

If you wish to learn how to use a specific 
feature. 

 Lookup the feature in the Contents and find 
the relevant chapter. 

If you require information about the operation 
of a particular menu or other command. 

 Refer to On-Line Help (click Index in the 
Help menu.) 
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2. Getting Started 
This section gives a quick tutorial on how to use ScaleLink Pro and introduces the main 
concepts you will need to edit and manage scales data. 

This section assumes that ScaleLink Pro has already been installed and setup for your store. (If 
not, see Appendix A  Installing ScaleLink Pro at a New Store. ) 

Which Communications Link are You Using? 
ScaleLink Pro provides two different methods of communicating with the scales. It is assumed 
that your copy of ScaleLink Pro has already been configured for one (or both) methods, that the 
cabling is installed and plugged into the correct sockets, and that the target scale or MSCU is 
turned on. If not, an error message will appear when you attempt to communicate with the 
scales. In this case, contact the person responsible for installing the system. 

If you have an Ishida IF21FD backup unit, it is also possible to use ScaleLink Pro without a 
communications link to the scales. In this case, use the Import IF21FD and Export IF21FD 
commands in the File menu to read and write data on the floppy disk. 

The two different methods of communicating with the scales are described briefly below. 

On-line 
communications 

The ID-ENQ and AstraXT communication protocols use a serial port or 
LAN for an on-line connection to the scale. 
This method operates in the background and changes you make in the 
ScaleLink Pro database are sent to the scale immediately. If the scale is 
off-line (for example if the power is turned off or the network connection is 
down), the data is stored and automatically resent when the scale comes 
back on-line. 

The right-hand end of the status bar at the bottom of the ScaleLink Pro 
screen displays the current status of scale communications, including 
whether any unsent data is waiting. For a more detailed view of the scale 
communications status, select Comms Link Status in the Comms menu. 

If your copy of ScaleLink Pro is not configured to use on-line 
communications. “Scale Comms: Off-Line” appears at the right-hand end 
of the status bar. 

 

Data Save This method communicates with the Data Save function on the scales. 
Unlike on-line communications, data transfer with the scales must be 
initiated manually. 

The basic flow of operations when using Data Save communications is as 
follows: 

• 

• 

• 

• 

Receive the Data Save file from the scales. 

Open the received file in ScaleLink Pro 

Use ScaleLink Pro to edit the file data 

Save the Data Save file and transmit to the scales. 

These steps are described in full in the Data Save section of Chapter 3  
Communicating with the Scales. 

 

Astra/AstraXT 
serial 
communications 

Like the Data Save function, this method also requires that data transfer 
with the scales be initiated manually. 

This method is used to send or receive a full set of data to the scale at one 
time. Individual data records cannot be sent independently. 

The operation is described in full in the Astra/AstraXT Serial 
Communications section of Chapter 3  Communicating with the Scales. 
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Important Note for Data Save and Astra/AstraXT Serial Comms Users 

After completing this tutorial, which teaches the basic operations of the ScaleLink Pro software, 
proceed to Chapter 3  Communicating with the Scales for an explanation of Data Save and/or 
Astra/AstraXT serial communications. 
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Starting ScaleLink Pro 
When you start ScaleLink Pro, the program automatically loads the database that was open 
when you last exited. (The database is not loaded if auto-loading of the database is set off in 
the setup. In this case, use the File menu to open a database or Data Save file.) 

The figure below shows the initial screen. 

Note: Screen appearance may differ depending on how your copy of ScaleLink Pro is 
configured. 

 

 

 

 

 
Inactive PLUs are displayed in red. 
Use the Active/Inactive toolbar button to 
mark PLUs as active or inactive

Click here to list all PLUs. 
Use the ↑, ↓, PgUp and PgDn 
keys to scroll the PLU list 

Click here to enter a search string. 
The list only displays PLUs that 
match the search string.

Click on these fields to search for 
a PLU by bar code, department or 
group

Toolbar: Click on a button to edit, 
etc. the currently selected PLU 

4 



The initial screen opens with the cursor in the PLU No. field of the PLU Search window. The 
PLU Search window provides a number of methods for you to find the PLU you are looking for 
and to edit or delete the selected PLU. You can also add new PLUs from this window. 

Finding a PLU 

If you know the PLU number 
Enter the PLU number in the PLU No. field. The specified PLU appears selected in the PLU list. 

If you know some or all of the PLU name 
The PLU name is the first line of the PLU description that appears on the label. Enter the initial 
characters of the PLU name in the Search field. The PLU list displays only those PLUs with 
names that start with the entered text. For example, entering “BEEF” displays all PLU names 
starting with the word “beef”. (The search is not case-sensitive: entering  “beef” is the same as 
entering “BEEF”.) 
 
You can also use the wildcard characters (‘*’ and ‘?’) to specify a more detailed search 
condition. For example, entering “*BEEF” displays all PLU names containing the word “beef”. 

The search re-executes automatically each time you type a character. The response 
 

may be a bit slow on older computers. In this case, allow a few seconds for the list to 
update.  

If you do not know the PLU number or name 
When the cursor is in the Search field, the PLU list only displays those PLUs that match the 
search condition. Move the cursor back to the PLU No. field (e.g. click on the field) to clear the 
search results and display all PLUs in the PLU list. 
Next, use the scroll bar, the up and down arrow keys, or the PageUp and PageDown keys to 
scroll the PLU list until you find the PLU you are looking for. 

See Chapter 6 Creating and Editing PLUs for a full explanation of the PLU Search window. 

Adding a New PLU 
Click the New PLU button in the PLU Search window toolbar. This opens a dialog for you to 
enter then PLU number. The number defaults to the next unused PLU number. Enter an 
unused number, then click OK to open a PLU Edit dialog. 

If you entered the number of an existing PLU, the data for that PLU is displayed. Otherwise, a 
new PLU is created and the initial values of the fields in the lower half of the dialog are set to 
their default values. 

The cursor is initially positioned in the PLU description field. Enter the PLU description. Next, 
use the mouse or TAB key to move the cursor to the price field and enter the PLU price. 

Next, check the PLU number (middle-right of window). An unused PLU number is assigned 
automatically but you can change the number if desired. (A warning message appears if you try 
to save the PLU with the same number as an existing PLU.) 

Click the Save button. This saves the PLU in the database and sends the PLU to the scales (if 
connected). 

Click the Close button to return to the PLU Search window. Use the procedure described in 
Finding a PLU above to check that the PLU has been added. 

Editing and Deleting PLUs 
When you have found the new PLU, click on the PLU name in the list to select it. The selected 
PLU appears highlighted. 

To edit the selected PLU 
Click the Edit PLU button. A PLU Edit window opens displaying the data for that PLU. 
The operation of the PLU Edit window is described in more detail below. For now, click the 
Close button at the top right of the window. This returns you to the PLU Search window. 
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To delete the selected PLU 
Click the Delete PLU button. A dialog opens asking whether or not to delete the PLU. Click No 
if you don’t want to delete the PLU. If you click Yes, the PLU is deleted from the database and, 
if connected, a command is also sent to delete the PLU on the scales. 

Changing PLU Prices 
Click the Price Changes button in the PLU Search window toolbar to open a dialog for 
changing PLU prices (or select Price Changes in the PLU menu). 

The purpose of this feature is to allow you to rapidly change the prices of a number of PLUs 
without having to edit each PLU in the PLU Edit window. 

Using the Price Change Dialog 

Enter the new price and press Enter. This saves the specified price and, if connected, sends 
the price change to the scales. A PLU Search dialog opens (defaulted to the next sequential 
PLU number) for you to specify the next PLU number. 

The Next and Prev buttons jump to the next or previous PLU respectively. The Select button 
opens a PLU Search dialog for you to select another PLU. 

Markdown Price Changes 
Selecting Markdown Price Changes in the PLU menu opens a dialog for changing markdown 
prices. The operation is the same as for the standard price change dialog described above. 

Nutrition 
This feature is only applicable to some countries. 

Click the Nutrition button in the PLU Search window (or select Nutrition in the PLU menu) to 
open a dialog for editing the nutrition information for the selected PLU. Enter the data then click 
the OK button to save and, if connected, send the nutrition information to the scales. 

To delete the nutrition information for the selected PLU, select Delete Nutrition in the PLU 
menu. 
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Using the PLU Edit Window 
The following are some quick tips to get you started using the PLU Edit window. See Chapter 6 
Creating and Editing PLUs for a full explanation. 

The appearance of the PLU Edit window depends on how your system is configured. The figure 
below shows an example. 

 

 

 

 

 

 

 

 

 

 

PLU description Font settings for 
description text 

Close PLU Edit 
window 

Save PLU and send to 
scales (if connected) Add a new PLU 

PLU settings. Use TAB key or mouse to select a 
field, then enter value or select from list. 

Click button to display list of 
options 

Specify label size restrictions for description 
text 

Enter a new value 
to save to a 
different PLU No.

Display next or 
previous PLU
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Entering the PLU description 

The large field in the middle of the PLU Edit window contains the PLU description. Click on the 
field to set the input focus to the field and use the mouse or arrow keys to move the cursor. 
Practice using the operations described below to enter or modify the description text. 
 

Operation Explanation 

Insert text Position the cursor at the desired location and enter text from the keyboard. 
The font and label width determine how many characters are displayed per 
line. Press the INS key to switch between insert and overwrite mode. 

 

Select text Drag with the mouse or hold down the shift key and use the left or right arrow 
key to move the cursor over the desired text. The selected text appears 
highlighted. 

 

Change line 
font  

A different font can be set for each line. Position the cursor in the line and 
select the desired font from the Font field. You can also press Ctrl+F to step 
through the available fonts. 

 

Change font 
type 

Characters can be displayed bold, reversed, in italic, and/or underlined. 
Select some text and click the buttons above the description field to turn each 
character type attribute on or off for the selected text. 

 

Change label 
size 

Set the Desc. Size Width field to the actual label width to be used for this 
PLU. This updates the description field to only display as many characters as 
will fit on the label. 
Set the Length field to the maximum length for the description text in the 
label, including any extra message. The actual length (including any extra 
message) is displayed beneath the Length field. 
A warning message is displayed when you try to save the PLU if the actual 
length is too long. 

 

Cut, Copy or 
Paste 

Use the Edit menu or the standard Windows keystrokes to cut, copy or paste 
description text. 

Entering the PLU settings 
The lower half of the window displays the various PLU settings. Which fields are displayed 
depends on how your system is configured. 
Use the mouse or TAB key to move to a field, then enter or select the desired value. An error 
message appears if you try to move to another field when the value of this field is outside the 
allowed range. 

You can only enter digits. None of the PLU fields accept letters or punctuation 
 

symbols. 

 
Changing the PLU number 
The PLU number field is on the mid-right of the Edit window. You can change the value to save 
the displayed data with a different PLU number. In this case, a warning message appears if a 
PLU with the specified number already exists. Saving the PLU data to a new PLU number does 
not delete the old PLU number and leaves the data for the old PLU unchanged. 
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Saving your changes 
Click the Save button. This saves the PLU in the database and sends the PLU to the scales (if 
connected). 

Changing the displayed PLU 
Click the Next>> or <<Prev buttons to display the data for the next or previous PLU number. (A 
warning message appears if you have not saved your changes to the current PLU.) 
Alternatively, click on the PLU Search window, select the PLU you wish to display, then click 
the Edit button or double-click on the PLU in the list to display that PLU in the PLU Edit window. 

Adding a new PLU 
To add a new PLU, click the New PLU button. This opens a PLU Search dialog to specify the 
number of the new PLU. Enter the new PLU number then press Return. This resets all fields in 
the Edit window to their default values. The new PLU is not saved until you click the Save 
button. 

Closing the PLU Edit window 
Click the Close button to close the PLU Edit window. (A warning message appears if you have 
not saved your changes to the current PLU.) 
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Editing Other Scales Data 
ScaleLink Pro allows you to edit a range of other scales data such as campaigns, messages 
and keyboard presets. Use the Scales menu to open dialogs for editing these data. 

 a campaign 

 

Editing

 

Campaigns are not supported by the AstraXT and EMZ series of scales. 
 
 

 

Click Campaigns in the Scales menu. This opens a selection dialog listing the available 
campaigns. Unused campaigns are indicated by “Spare”. Click on a campaign to select, then 
click the Edit button to open a campaign edit dialog (or simply double-click on the campaign). 

The figure below shows an example campaign edit dialog. 

 

 

Start and end date/time 
of campaign

Name: Used in Scalynx 
only (not sent to scales) 

Delete selected PLU 
from campaign. 

Click on a PLU to select. 
Double click to edit 
campaign price. 

Edit campaign price for 
selected PLU. 

Add PLU to campaign. 
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Enter the campaign name and start and end times. Use the buttons on the bottom right to add, 
edit, or delete PLUs in the campaign. For example, clicking the Add button opens a dialog for 
adding a PLU to the campaign and setting the campaign price. 

Click to open PLU 
search dialog 

Campaign price 

 

Click the Select button to select the PLU number. This opens a PLU selection dialog which 
operates in a similar way to the PLU Search window (described above). 

See Chapter 10 Campaigns for more details about creating and editing campaigns. 

Exception!  The AC-2000/Master system only supports one campaign. If your copy of 
ScaleLink Pro is configured for an AC-2000/Master system, clicking Campaigns in the Scales 
menu takes you directly to the campaign edit dialog. 

 advertising messages 

 

Editing

 

Advertising messages are not supported by the AstraXT series of scales. 
  

Click Advertising Messages the Scales menu. This opens a selection dialog listing the 
available messages. Unused messages are indicated by "Spare". Click on a message to select 
it then click the Edit button to open a message edit dialog (or simply double-click on the 
message). 

Editing ingredient and other messages 

A range of different messages can be programmed depending on the type of scale you are 
using. On the AC-series scales, these typically include extra messages and coupon messages. 
The general operation is the same for each type of message. 

Clicking the menu item corresponding to the message in the Scales menu opens a selection 
dialog listing the currently defined messages. 

Click the Add button to create a new message, or click on an existing message to select, then 
click the Edit button to edit the message (or simply double-click on a message). In either case, 
a dialog opens to edit the message text. 
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Editing keyboard presets 
yboard Presets in the Scales menu. 

 

C
s

Click Ke

 

Keyboard Presets are not available for EMZ-series scales. 
  

 
If your system is configured for a single scale only, clicking Keyboard Presets in the Scales 
menu takes you directly to the keyboard window. Otherwise a selection dialog opens listing all 
scales in your system. Select the scale for which to define keyboard presets, then click the 
Select button to open a keyboard window. 
 
A separate keyboard preset definition can be defined for each scale in the system. 

The figure below shows an example keyboard preset window for an AC-3000 system. 

 

 

 

 

 

 

Click on a key to select. 
Double click to edit. 
Drag&drop to move or copy.

Switch between upper 
and lower keys or 
keysheet template 

Edit selected key.Delete definition 
for selected key. 

lick to save settings and 
end to scale 

Ishida scale keyboards have a shift key. The “lower” preset key definitions specify the key 
meaning when the shift key is pressed. 

The keyboard window also allows you to create a keysheet template which you can printout 
and use as an overlay on the scale keyboard. Click the Keysheet radio button to change the 
display to keysheet template mode. 

You can also copy keyboard definitions from other scales. Select Copy Keyboard from the 
Keyboard menu. 

Click on a key to select, then click the Edit Key button or press Enter. Alternatively, simply 
double-click on the key. This opens a dialog (shown below) for defining the meaning of the key 
and specifying the keysheet template format. 

Similarly, you can remove a key definition by selecting the key and clicking the Delete Key 
button. 
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Open dialog to select PLU or 
message number, etc.. 

Select key meaning (PLU or 
message, etc.). 

Key data 
(PLU No. if PLU, 
Message No. if message, etc.)

Keysheet template text Keysheet template text 
formatting options 

Print preview of key in 
keysheet template 
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Memo/SR-2000 presets (EMZ and SR-series scales only) and Index presets (EMZ-series 
scales only) 
EMZ scales have two types of programmable keys: memo presets and index presets. Both 
provide a way of quickly calling up PLUs from the touch screen on the scale. 
Memo presets define quick keys for calling up a particular PLU. 
Index presets define keys that call up a list of PLUs, specified by a range of PLU numbers. 
The SR-2000 has a function similar to the EMZ memo preset function, except that the presets 
are divided into pages. 
 
Click Memo Presets or Index Presets in the Scales menu. This opens a dialog listing all EMZ 
scales defined in the system. Only one set of memo and index presets can be defined for each 
scale. 
Select the scale to edit, then click Edit. This opens a dialog for editing the key settings. The 
example below is for EMZ memo presets. 
 

 
 
To assign a PLU to a key, select the key and click Edit (or double click on the key). Similarly, to 
remove a PLU from a key. select the key and click Delete. 
Note that the scale has a Shift key to switch between to pages of preset keys. Use the Key 
Page buttons to select which page to program. 
 
The operation of Index Presets is similar, except that you can select up to eight ranges of PLU 
number per key instead of a single PLU. 
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Editing the store name and address 
Click Store Name/Address in the Scales menu. This opens a dialog for editing the store name 
and address. Enter the desired text and click the OK button to save. 
This setting is not used on EMZ-series scales. 
 

Editing store settings (EMZ-series scales only) 
Click Store Settings in the Scales menu. This opens a dialog listing the store definitions. Use 
the Add, Edit, and Delete buttons to add, edit, or delete store settings. 
For example, select a store setting in the list and click Edit to open the dialog shown below for 
editing the store data. 
 

 
 
Specify the desired settings, then click OK to save. 
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Editing tray settings (EMZ-series scales only) 
Click Tray Settings in the Scales menu. This opens a dialog listing the tray definitions. Use the 
Add, Edit, and Delete buttons to add, edit, or delete tray settings. 
For example, select a tray in the list and click Edit to open the dialog shown below for editing 
the tray data. 
 

 
 
Specify the desired settings, then click OK to save. 
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Other Features 
The above sections have given you a quick introduction to the main ScaleLink Pro operations. 
The following lists additional features of ScaleLink Pro and where to look in the manual for an 
explanation. 

 

Feature Description Manual Chapter 

Reports Prints or displays reports listing the 
PLUs, messages, or production data 
uploaded from the scales 

 See Chapter 7  Reports 

Data Save Communicates with the Data Save 
function on the scales 

 See Chapter 3  Communicating 
with the Scales 

IF21FD You can use an IF21FD backup unit 
to transfer data between ScaleLink 
Pro and the scales 

 See Chapter 4  Using an IF21FD 

Price Changes A quick method of updating PLU 
prices 

 See Chapter 6  Creating and 
Editing PLUs 

Change 
Database or 
Department 

Selects which database to edit  See Chapter 5  The PLU 
Database 

PLU 
Active/Inactive 

PLUs can be designated as 
“inactive”. An inactive PLU still 
appears in ScaleLink Pro screens 
but is not sent to the scale. 

 See Chapter 9  Advanced 
Features and Utilities 

PLU Profile A PLU profile specifies the range of 
PLU numbers that are relevant to a 
particular copy of ScaleLink Pro. 
PLUs excluded from the profile do 
not appear in ScaleLink Pro screens 
but remain in the database. 

 See Chapter 9  Advanced 
Features and Utilities 

Text File Data 
Import and 
Export 

Data can be loaded from or saved in 
text file format. 

 See Chapter 8  Importing and 
Exporting Data 

Database Import Data can be loaded from an ODBC 
data source. 

 See Chapter 8  Importing and 
Exporting Data 

Batch Mode Allows changes to be made off-line, 
then loaded into the scales and 
database at a latter time. 

 See Chapter 9  Advanced 
Features and Utilities 

Price Zones In a multi-store configuration, 
different PLU settings such as price 
can be set for each store 

 See Chapter 9  Advanced 
Features and Utilities 
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Feature Description Manual Chapter 

Scheduler ScaleLink Pro operations such as 
loading data from a text file can be 
set to execute at a specified time.. 

 See Chapter 9  Advanced 
Features and Utilities 

Automation ScaleLink Pro supports ActiveX 
automation. This means ScaleLink 
Pro operations can be controlled 
from scripting languages such as 
Visual Basic or Java script. 

 See Chapter 9  Advanced 
Features and Utilities 

ScaleLink Pro 
Setup 

Configures ScaleLink Pro for your 
scales system 

 See Appendix A  Installing 
ScaleLink Pro at a New Store 
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 3. Communicating with the Scales 
ScaleLink Pro provides two different methods of communicating with the scales. 

On-line  
communication 

On-line communications requires a master scale control unit (MSCU) or a 
scale with communications hardware (a “master board”). The main 
features are: 

• Connects to the scales via the serial port on the PC (RS232C) or via 
the LAN (TCP/IP). 

• Changes made on ScaleLink Pro can be sent to the scales 
immediately, even if the scales are in use. 

• Operation is fully automatic. 

 

Data Save: 
(AC-3000, 
WM-3000) 

The Data Save function is primarily provided on the scales as a means of 
data backup and restore. The main features are: 

• The Data Save function saves or restores a complete set of scale 
data at a time. The backed up data can be stored on the PC and 
modified by ScaleLink Pro. 

• Available on AC-3000 scales and WM-3000 series wrappers. 
(Operation is different for each model.) 

• Requires a special adapter (RS-232C to RS-485 converter) to 
connect to the serial port on the PC. 

• Data transfer is initiated manually: using the menu in ScaleLink Pro 
and using Test Mode on the scales. 

 

Astra/AstraXT 
serial 
communication 
 

Similar to the Data Save function, this is primarily provided as a means of 
data backup and restore. The main features are: 

• A complete set of scale data is sent or received at a time. Data is 
received or sent into or out of the ScaleLink Pro database. 

• Applicable to Astra and AstraXT scales. 

• The connection to the scale uses the serial port on the PC. 

• Data transfer is initiated manually: using the menu in ScaleLink Pro 
and using Registration Mode on the scales. 

 

Your copy of ScaleLink Pro should have been configured for one or more methods when 
installed. If unsure, consult with the person responsible for installing. 

You need to know which communication method to use as the operation of ScaleLink Pro 
differs depending on the method used. The following explanation assumes that you have 
decided which system you are going to use, the appropriate cabling is installed, and ScaleLink 
Pro is configured correctly. See Appendix A  Installing ScaleLink Pro at a New Store or consult 
with your Ishida agent for further information. 

If you have an Ishida IF21FD backup unit, it is also possible to use ScaleLink Pro without a 
communications link to the scales. In this case, you use the Import IF21FD and Export 
IF21FD commands in the File menu to read and write data on the floppy disk. 
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3.1 On-Line Communications 
This method operates in the background and changes you make in the ScaleLink Pro database 
are sent to the scale immediately. If the scale is off-line (for example if the power is turned off or 
the network connection is down), the data is stored and automatically resent when the scale 
comes back on-line. 

If your copy of ScaleLink Pro is not configured to use on-line communications. “Scale Comms: 
Off-Line” appears at the right-hand end of the status bar. 

Establishing Communications with the Scales 
ScaleLink Pro establishes the communications link to the scales automatically when the 
program starts. 

Look at the right-hand end of the status bar at the bottom of the ScaleLink Pro screen. This 
displays the current status of scale communications, including whether communications is 
enabled and whether any data is waiting to be sent to an off-line scale. 

Select Comms Link Status in the Comms menu for a more detailed view of the 
communications status for each scale. Use the Enable/Disable and Test Link buttons to set 
links on or off and check whether the links are currently connected. 

Sending Data to the Scales 
If the scales are connected, ScaleLink Pro sends the updated data to the scales whenever you 
make a change (when you click the Save button in the PLU Edit window or the OK button in one 
of the scales data dialogs, for example). 

Accordingly, it is recommended that you always perform editing with the scales connected. 
This keeps the data in the PC database and scales synchronized. If you do wish to make 
changes without sending them to the scales immediately, use batch mode to make the 
changes off-line then load all the changes at once at the desired time. 

 When you open a Data Save file or import from an IF21FD floppy disk, however, the 
loaded data is not sent automatically. In these cases, use Transmit/Receive Scale 
Data in the Comms menu (described below) to send the database contents to the 
scales.  

Sending a Range of Records to the Scales 
Click Transmit/Receive Scale Data in the Comms menu to open the Communication Center 
dialog shown below. This dialog provides a range operations for sending and receiving scale 
data, as described below. 

The operation of the dialog is as follows: 

1. Select the type of data to send or receive using the radio buttons on the top right.. 

2. Specify the scale to send to or receive from (or specify “All Scales” to send to all 
scales). 

3. If sending or deleting data, enter the range of records numbers to send or delete. use 
the Select buttons to select from a list of the data in the database. 

4. Click on the desired operation button at the bottom of the screen to start 
communications with the scale. The operations are described below. 

The status bar at the bottom of the dialog displays the communication progress. 

 If one or more of the Transmission Data options appears dimmed (for example, “Ad 
Messages” below), this indicates that the currently selected scale does not support 
this type of data. Similarly, if one or more of the operation buttons at the bottom of the 
dialog appear dimmed, this indicates that the operation is not supported for the 
selected “Transmission Data” and scale. 
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Operation Explanation 

Send to Scale Sends the specified range of records to the selected scale, or to all scales. If 
data is not sent successfully (a scale is off-line, for example), the unsent data 
is saved and automatically resent when the scale comes back on-line. (See 
Off-Line Operation below.) 

Receive from 
Scale 

Receives all data of the selected “Transmission Data” type from the selected 
scale. You can only receive data from one scale at a time. 

Compare 
(Scale vs. DB) 

Receives data from the scale and compares with the data in the database. If 
differences are found, the results are displayed in a dialog like that shown 
below. Click the View Result Log button to view a detailed log of the 
differences found. (Details of any differences are logged for each scale in the 
file CompareResultsScaleXXX.txt, where XXX is the scale ID number.) 

Click the Synchronize Scale button to automatically send or delete data on 
the scale so that it matches the database. 
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Operation Explanation 

Delete on Scale This deletes a range of records on the scale only. Data is not deleted from the 
database. (To delete data from the database, use the various delete 
commands for each type of data.) Note that this command only deletes scale 
records that also exist in the ScaleLink Pro database. Use Delete All on 
Scale to clear all records from a scale. 

 

Delete All on 
Scale 

This deletes all records of the selected data on the scale only. Data is not 
deleted from the database. This command is the same as Delete on Scale, 
except that operation is faster as it uses a single scale command to delete all 
data rather sending deletion commands to the scale one at a time. 

 

Filtering Data Sent to the Scales 
Filters can be defined for each comms link defining the range of record numbers (PLU numbers, 
etc.) that can be sent via that link. See Appendix A  Installing ScaleLink Pro at a New Store for 
details. 
This is useful when you have multiple comms links and wish to avoid sending unwanted PLUs 
to particular scales (avoid sending bakery PLUs to the produce department scales, for 
example). 

Disabling the Communication Link 
If you wish to disable all communications with the scales, click Options in the Setup menu to 
open the Options dialog. Set Enable On-Line Comms? off and click OK to save. Note, 
however, that the automatic accumulate + resend feature (see Off-Line Operation below) 
does not operate if Enable On-Line Comms? is off.  

Use the same procedure to re-enable communications. 

If using multiple communication links, you can use Show Comms Status in the Comms menu 
to disable individual communication links as described below. 

Enabled vs. Connected 
SLP communication links have “enabled” and “connected” flags. These flags indicate the 
current status of the link and are displayed in the Comms Status dialog. 

A. Enabled/Disabled 

If a comms link is disabled, it is ignored by all communications operations. Within ScaleLink Pro, 
however, the scale is treated as if it exists. The scale keyboard presets can still be edited, for 
example, although any changes will not be sent to the scale. A scale is typically disabled if it will 
be out of service for a long period of time. 

To enable or disable a scale, select Show Comms Status in the Comms menu. Select the 
desired scale, then click the Enable/Disable button. 

B. Connected/Not Connected 

The “connected” status of a comms link basically indicates whether or not the most recent 
attempt to communicate with the scale was successful. If a communication attempt fails due to 
the scale not responding, the scale status is set to “not connected” and no further data 
send/receive operations are attempted for that scale. However, send requests are still saved in 
the request queue for resending when the scale comes back on-line. A “not connected” comms 
link becomes “connected” again when a communication attempt to the scale is successful. 
Communication attempts to a “not connected” scale can be initiated manually by clicking the 
Test Link button from the Comms Status dialog or automatically at preset intervals (currently 
60seconds) if data is waiting to be sent to the scale. 

The following section describes the operation for disabled or “not connected” scales. 
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Off-Line Operation 
If one or more scales are out of service for some reason, you can continue to edit scale data in 
ScaleLink Pro as usual. ScaleLink Pro saves the data that would have been sent to the off-line 
scale and automatically sends this data when the scales come back on-line. 

ScaleLink Pro automatically checks the link to off-line scales that have data waiting at periodic 
intervals. The checking operates in the background. If an off-line scale if detected again, any 
outstanding data for that scale is sent automatically. 

However, automatic resending can be disabled by the "Disable auto-resend of unsent data 
when scale off-line" setting in the Options dialog. As Scalelink Pro only does an automatic 
check to detect when a scale comes back on-line if the scale has data waiting to be sent, the 
scale status is not set back to on-line in the scale status dialog automaticaly. However, the 
status of the scale is updated the next time you send data to the scale or test the link status 
manually. 
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3.2 Data Save Communications 
This method communicates with the Data Save function on the scales. Unlike ID-ENQ, 
communications with the scales must be initiated manually. 

The basic flow of operations when using Data Save communications is as follows: 

1. Receive the Data Save file from the scales. 

2. Open the received file in ScaleLink Pro 

3. Use ScaleLink Pro to edit the file data 

4. Save the Data Save file and transmit to the scales. 

On both the AC-3000 and WM-3002, the Data Save function is accessed via Test Mode. If you 
are not familiar with the operation, refer to the scales operating manual. 

Managing Data Save Files (AC-3000) 
A Data Save file contains a complete set of scales data, of which the data managed by 
ScaleLink Pro is only a subset. Accordingly, ScaleLink Pro cannot create a Data Save file from 
scratch. Instead, you open an existing file to import into the ScaleLink Pro database, make the 
required changes, then save the results back to the original Data Save file. Saving back to the 
Data Save file overwrites the data managed by ScaleLink Pro (PLU and messages, etc.) but 
leaves the other contents of the file unchanged. (Other data stored in a Data Save file may 
include label formats and general scales setup parameters.) 

Accordingly, you need to decide how to manage the Data Save files. Two methods are possible 

1. Receive a fresh copy of the Data Save file from the scales each time you perform 
editing. 
This ensures that the file is up to date. This method is recommended. 

2. Receive a copy of the Data Save file from the scales once and store on the PC hard 
disk. Transmit the file back to the scales after performing editing. 
This method saves you the time of receiving a fresh copy of the Data Save file each 
time you perform editing. However, care is required because the Data Save file 
contains a complete set of scales data. Transmitting the file back to the scales not only 
updates the changes you made in ScaleLink Pro but also resets other data (such as 
general scales setups) to their states when the original copy of the Data Save file was 
received from the scales. 

 

Managing Data Save Files (WM-3002) 
For the WM-3002, ScaleLink Pro stores data received from the scale in a subdirectory called 
ScaleData. The data is stored in the same format as it would be on an IF21FD floppy disk - that 
is, each type of data (PLUs, messages, etc.) is stored in a separate file with the extension 00x, 
where x is a digit. All files with the same extension (e.g. *.001) belong to the same set of data. 

Note that, you must first receive data from the WM-3002 before you can send data back. This is 
a restriction imposed by the way the Data Save function works on the WM-3002. 
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Operation (AC-3000) 

Receiving a Data Save File from the Scales 

The following procedure receives the Data Save file from an AC-3000 series scale. 

1. Connect the PC to the scale via an RS-485 to RS-232 converter. Consult your Ishida 
agent if you do not know the correct cabling requirements. 

2. Turn on the scales and set to Test Mode. 

3. Use the Test Mode menu to select DATA SAVE/LOAD. 

4. Select TRANSFER FILE, enter the IF21 FILE NO. (enter 1) and press the Enter key 
twice. 

5. Use the → key to select SEND: MASTER FILE(*). 
Leave the scales in this state and move to the PC. Do not start sending the file yet. 

6. Click the Comms menu and select Receive (Data Save). A dialog appears indicating 
that ScaleLink Pro is ready to receive data from the scales. 
If an error message appears, it is possible that another application is using the serial 
port. (The serial port is specified in Comms (ID-ENQ) in the Setup menu.) Close all 
other applications and try again. 

7. Press the PRINT key on the scales to start the data transfer. A message appears on 
ScaleLink Pro when the transfer completes. 
If an error message appears, check that the cable is plugged into the correct 
connectors.  

8. If the transfer was successful, a dialog opens for you to specify the file name. Enter an 
appropriate name and click OK. Next, another dialog opens asking whether to open the 
received data. Click Yes to open the received file (see below for more details). 

Opening the Received File in ScaleLink Pro 

If you did not open the Data Save file after receiving it from the scales, or if you have exited and 
restarted ScaleLink Pro in the meantime, you must open the file before starting editing. 

ScaleLink Pro can open a Data Save file in three different ways: 

• Open file but do not import data. 
This selects the specified file but does not import the file contents into the database. 
Clicking Save (Data Save) in the File menu writes the database data into the specified file. 

• Import into new database. 
This closes the current database, creates a new empty database and imports the data 
from the specified Data Save file. The database is assigned the same file name as the 
Data Save file. e.g. If the Data Save file is backup.dsv, the database is created as 
backup.pld. If backup.pld already exists, it is overwritten. 

• Open file and import into current database. 
This imports the file contents into the currently open database. In this case, you can 
specify what to do if the same PLU No., message No. or other scale data ID is found in 
both the Data Save file and database. That is, you can specify whether to overwrite the 
database PLU etc. or leave the database PLU etc. unchanged. 

The default operation is defined at installation. However, if your system is so configured, the 
following dialog appears when you open a Data Save file for you to select which of the above 
methods to use. 
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The overall procedure for opening a Data Save file is as follows: 

 

1. Click Open (Data Save) in the File menu, specify the file name and click OK. 

2. A File Open dialog appears for you to select the file to open. 

3. If your system is configured to display a Data Save Open Options dialog when opening 
Data Save files, the dialog appears. Select the desired options and click OK to open the 
file. 
If the dialog does not open, the Data Save file is opened using the default options. 

Editing the Data Save File Data 

Once you have opened the Data Save file, edit the scale data in the same way as normal. All 
editing changes are saved in the ScaleLink Pro database. 

Saving the Data Save File and Transmitting to the Scale 

When you have finished editing the scale data, click Save Data Save File in the File menu to 
save your changes. 

To transmit the updated data to the scales, select Send (Data Save) in the Comms menu. This 
opens a dialog asking whether to send the current database or to specify a file: 

Transmit 
Current 
Database 

This saves the database contents in the currently open Data Save file and 
transmits the file to the scales. If no Data Save file is currently open, a File 
Open dialog appears for you to specify the file name. 
Transmission requires manual operation at the scales: see below for details.

Select a Data 
Save File 

This option allows you to specify a Data Save file to transmit. A File Open 
dialog opens for you to select the file. Select a file and click OK to start 
transmission. 
Transmission requires manual operation at the scales: see below for details.

The following procedure transmits a Data Save file from the PC to an AC-3000 series scale. 

1. Connect the PC to the scale via an RS-485 to RS-232 converter. Consult your Ishida 
agent if you do not know the correct cabling requirements. 

2. Turn on the scales and set to Test Mode. 

3. Use the Test Mode menu to select DATA SAVE/LOAD. 
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4. Select TRANSFER FILE, enter the IF21 FILE NO. (enter 1) and press the Enter key 
twice. 

5. Use the → key to select RECEIVE: MASTER FILE(*). 
Leave the scales in this state and move to the PC. Do not start receiving the file yet.

6. Click the Comms menu then select Send (Data Save). A dialog opens, click the 
Transmit Current Database or Select a Data Save File button. If necessary, a File 
Open dialog opens for you to specify the file to transmit. 
If an error message appears, it is possible that another application is using the serial 
port. (The serial port is specified in Comms (Data Save) in the Setup menu.) Close all 
other applications and try again. 

7. Press the PRINT key on the scales to start the data transfer. A message appears on 
ScaleLink Pro when the transfer completes. 
If an error message appears, check that the cable is plugged into the correct 
connectors.  
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Operation (WM-3002) 

Receiving a Data Save File from the Scales 

 The following explanation assumes that the IF21 communications have been setup 
correctly. In particular the scale type must have been set to "WM-3002". 
  

The following procedure receives the Data Save file from a WM-3002 wrapper. 

1. Connect the PC to the wrapper. Consult your Ishida agent if you do not know the correct 
cabling requirements. 

2. Turn on the wrapper and set to Test Mode. 

3. Use the Test Mode menu to select DATA SAVE/LOAD. 

4. On ScaleLink Pro, click the Comms menu and select Communicate with Scales 
(WM-3002). A dialog appears asking whether to save the current database in IF21 
format. Select No. 

5. A dialog appears asking you to specify the directory in which to save the received scale 
data. Specify the desired directory then click OK. 

6. Use the Data Save screen on the wrapper to send all data to the PC. Refer to the 
wrapper manual for details. 

7. During communications, ScaleLink Pro displays a dialog indicating the progress of the 
data transfer. When communications is complete, click the Close button in this dialog. 

8. If the transfer was successful, a dialog opens asking you whether to open the received 
data. Click Yes to open the received file (see below for more details). 

Opening and Editing the Received File in ScaleLink Pro 

When data is received from the wrapper, it is saved in the directory specified in step 5 above. 
You can import this received data at any time by selecting Import IF21FD from the File menu. 
This imports the received data into the current database. 

Once you have imported the received file, edit the scale data in the same way as normal. All 
editing changes are saved in the ScaleLink Pro database. 
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Transmitting to the Scale 

When you have finished editing the scale data, use the procedure described below to transmit 
the data back to the wrapper. 

1. Connect the PC to the wrapper. Consult your Ishida agent if you do not know the correct 
cabling requirements. 

2. Turn on the wrapper and set to Test Mode. 

3. Use the Test Mode menu to select DATA SAVE/LOAD. 

4. On ScaleLink Pro, click the Comms menu and select Communicate with Scales 
(WM-3002). A dialog appears asking whether to save the current database in IF21 
format. Select Yes if you wish to send the current database. 
Select No if you wish to send previously received data back to the wrapper. 

5. If you selected Yes, a dialog appears asking you to specify the directory in which to 
output the current database in IF21FD format. Specify the directory used when 
receiving data from the wrapper. Click OK when ready. 
* The operation of this dialog is described in Chapter 4 Using an IF21FD. 

6. A dialog appears asking you to specify the directory containing the scale data. Specify 
the same directory as step 5 above, then click OK. 

7. Use the Data Save screen on the wrapper to receive the desired data from the PC. 
Refer to the wrapper manual for details. 

8. During communications, ScaleLink Pro displays a dialog indicating the progress of the 
data transfer. When communications is complete, click the Close button in this dialog. 
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3.3 Astra/AstraXT Serial Communications 
This method is used to transfer a full set of scale data at a time between the scale and 
ScaleLink Pro database. Communications uses the serial port on the PC and is initiated by 
manual operation on the scale. 

Receiving Data from the Scale 
The procedure is as follows. The example screens are for the AstraXT, but Astra operation is 
largely identical. 

1. Click the Serial Comms (Astra/AstraXT) → Receive (AstraXT) (or Receive 
(Astra)).This displays the dialog show below. 

 

 
  

The operation of the scale may vary somewhat from that described below, depending 
on which Astra model you are using. If in doubt, consult the Astra Operation Manual. 

  

2. ScaleLink Pro is now ready to receive data from the scale. However, to start the 
transfer you need to perform the following operations on the scale. 

Remove any keysheet from the Astra keyboard to expose the programming keyboard.

3. On the Astra, enter 9000 using the numeric keys on the right, then press the MODE 
key. The scale display shows "registration" indicating registration mode. 

4. Next, press the down arrow key a number of times until "communication" (Astra) or 
“RS-232C” (AstraXT) appears . 

5. Press the ENTER key once to display "Send Data", again to display "All Data", then a 
third time to start sending data. 

Alternatively, when "All Data" is displayed, press the down arrow to select the type of 
data to send, then press ENTER to start sending data. 

If the data transfer is successful, the scale will display "Sending", then "Data Sent OK", 
then "All Data". 

6. Go back to the PC. If the data transfer is successful, the received data will be updated 
in the database. If unsuccessful, an error message will appear. 
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Sending Data to the Scale 
The procedure is as follows. The example screens are for the AstraXT, but Astra operation is 
largely identical. 

1. Click the Serial Comms (Astra/AstraXT) → Send (AstraXT) (or Send (Astra)).This 
displays the dialog show below. 

 

 
 

2. Select the data you wish to send, then click OK. If you selected keyboard presets and if 
there is more than one AstraXT defined in your system, a dialog opens asking which 
scale keyboard (in the ScaleLink Pro database) to send. 

 ScaleLink Pro does not support the Astra directly. However, the Astra and 
AstraXT keyboard layouts are the same so you can select an AstraXT 
keyboard to send to an Astra scale. 

 

3. If sending to an Astra, a dialog opens asking whether to append the data being sent to 
the existing scale data or whether to overwrite the existing scale data. Select the 
desired option, then click OK. 

 

 

 
3. Next, the following dialog appears with instructions on how to setup the scale to receive 

data. 
Check that the cable connecting the PC to the scale is plugged in correctly. 
Also, remove any keysheet from the Astra keyboard to expose the programming 
keyboard. 
Turn on the Astra and set to REGISTRATION mode (on the Astra keyboard, enter 
9000, then press the MODE key). 
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4. Next, press the down arrow key a number of times until "communication" (Astra) or 

“RS-232C” (AstraXT) appears, then press ENTER, followed by the down arrow. The 
scale should display “Download” or "Receive Data". 

5. Press ENTER again. The scale displays "Receiving" indicating that it is now ready to 
receive data. 

6. Go back to the PC and click the OK button in the above dialog to start sending. A 
message appears when sending completes. 
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4. Using an IF21FD 
An alternative to using a communications link to transfer data to and from the scales is to use 
the Ishida IF21FD backup unit. The IF21FD is used to backup and restore scales data onto a 
floppy disk. ScaleLink Pro can read and write the data on the floppy disk. 

Using an IF21FD to Receive Data from the Scales 
Use the following procedure. 

1. Use the IF21FD to backup the scales.  

2. Insert the IF21FD floppy disk in the PC’s floppy drive, then select Import IF21FD from 
the File menu. 

3. This opens the dialog shown below for you to specify which data to load. 
 

 
 

 

4. Enter the IF21 file number . 

5. The buttons below the Directory path field allow you to specify where to read the files 
from without having to type in the full directory path. 
If you are importing data from a floppy disk, click the Floppy drive A: button. 
If importing from other than the A: drive, either enter the path in the Directory path field 
or use the Browse button to open a dialog for selecting the path. 

6. If you do not wish to import all files, set the Select files button ON and check the boxes 
corresponding to the types of file you wish to import. 

7. Use the buttons at the top right of the dialog to specify whether or not to overwrite 
existing data in the database. 

8. Click the OK button to import the specified data from the floppy disk. 

 

This imports the data from the floppy disk to the ScaleLink Pro database. You can now edit the 
data in the same way as normal. 
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Using an IF21FD to Transfer Data to the Scales 
The following procedure describes how to use the IF21FD to setup the scales with the current 
database settings. 

1. Use the IF21FD to backup the scales.  

2. Insert the IF21FD floppy disk in the PC’s floppy drive, then select Export IF21FD from 
the File menu. 

3. This opens the dialog shown below for you to specify which data to save on the floppy 
disk. 

 

 
 

4. Enter the IF21 file number . 

5. The buttons below the Directory path field allow you to specify where to save the files 
without having to type in the full directory path. 
If you are exporting data to a floppy disk, click the Floppy drive A: button. 
If you wish to save the data on other than the A: drive, either enter the path in the 
Directory path field or use the Browse button to open a dialog for selecting the path. 

6. If you do not wish to export all files, set the Select files button ON and check the boxes 
corresponding to the types of file you wish to export. 

7. Click the OK button to export the specified data to the floppy disk. 

8. Insert the floppy disk in the IF21FD and use to restore the data to the scales. 

 

34 



5. The PLU Database 
ScaleLink Pro stores the scales data in a database. Whenever you change the scales data, 
whether by receiving data from the scales, importing a Data Save or IF21FD file, or using the 
ScaleLink Pro screens, ScaleLink Pro updates this database with the new data. 

Database Formats 
Two database file formats are available: 

• 
• 

Microsoft Access (*.MDB) format 
Ishida PLU database (*.PLD) format 

The default database format can be specified at installation. 

Microsoft Access format databases are accessed using the Microsoft Data Access Objects 
(DAO) software. An alternative version of Scalelink Pro is available that uses Microsoft Active 
Data Objects (ADO) instead of DAO. The ADO version uses a later version of the Microsoft 
Access (MDB) database file format that is compatable with Microsoft Access 2000. However, 
the New Database command in the File menu is not available in the ADO version. 

Selecting the Database 
When you start ScaleLink Pro, the program automatically loads the database that was open 
when you last exited. (Unless auto-loading of the database is set off in the setup. In this case, 
use the File menu to open a database or Data Save file.) 

As most stores will keep all data in a single database, no further action is required and you can 
start editing scales data immediately. 

However, in special cases such as when managing data for more than one store, you may use 
ScaleLink Pro to edit multiple databases. If you need to change the database, click Change 
Database in the File menu to open a dialog for selecting the new database file. Selecting a 
database file closes the current database and opens the new database. You can only have one 
database open at a time. 

(If there is no currently open database, use Open Database in the File menu to open the 
desired database.) 

 The operation is somewhat different if your copy of ScaleLink Pro is setup for multiple 
departments. In this case, use the Change Department command in the File menu 
to switch between departments. This automatically closes the current database and 
opens the database for the new department.  

 Your user access settings can be set to restrict you to a specified database or 
department only. In this case, the Change Database or Change Department and 
other database access commands do not appear in the File menu. 
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Managing Databases 
The following operations are available for creating and managing databases. 

However, the following explanation is not applicable if your copy of ScaleLink Pro is setup for 
multiple departments. In this case, all databases are created when the departments are defined. 
(See Appendix A.1 Setting Up ScaleLink Pro at a New Store.) 
 

Operation Explanation 

Create a new empty 
database 

Click New Database in the File menu. This closes the current 
database then opens a dialog for you to specify the file name for the 
new database. Enter the file name and click OK to create and open 
the new empty database. 

Copy current database Click Save As in the File menu. This opens a dialog to specify the file 
name for the new database. Enter the file name and click OK. This 
copies the current database to the specified file name and makes this 
new database the current open database. The old database file 
remains unchanged. 

Create database from 
Data Save file 

Depending on how your copy of ScaleLink Pro is configured, you may 
also be able to create a new database by opening a Data Save file (by 
clicking Open (Data Save) in the File menu.) 

Compact database The performance of Microsoft Access (MDB) format databases 
deteriorates over time as unused data accumulates. 
It is recommended that you periodically compact the database (click 
on Compact Database in the File menu) to remove unused data. 
Compaction is not required for Ishida (PLD) format databases. 

Restrict the range of 
displayed PLUs 

ScaleLink Pro has an optional PLU range profile feature. This feature 
is used to restrict which PLUs appear in the ScaleLink Pro screens 
and reports. 
It is useful for multi-store operation where the same master file (PLU 
database) is used for all stores, but where not all stores carry the 
same products. 
See section 9.3 PLU Range Profile for an explanation. 

5.1 Microsoft Access Database Format 
This is the standard Microsoft Access database format. ScaleLink Pro uses the Microsoft Data 
Access Objects software to perform database access. 

Features and Restrictions 
• 

• 

• 

Allows multi-user operation.* 

Can be linked to third party database management systems (DBMS) such as SQL Server 
or Oracle. 
Note:  Configuring the link requires specialist expertise such as a database administrator. 
Contact your Ishida agent for details. 

Database contents can be viewed by third party software such as Microsoft Access. 
However, care is required as any changes made to the database may result in 
misoperation when the database is opened in ScaleLink Pro. 

* See 5.3 Multi-User Operation below for details. 
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5.2 Ishida PLU Database Format 
This is a proprietary database structure that is backward compatible with version 1.0 of 
ScaleLink Pro (Scalynx). (You can open version 1.0 files in version 2.0, but not vice versa.) 

Features and Restrictions 
• 

• 

Does not allow multi-user operation. 

Performance is general faster than the Microsoft Access format. 

Cannot be opened using third-party software. Use the Text File Export function (or Save As to 
MDB format) if you need to transfer data to other software. 

 

5.3 Multi-User Operation 
Multi-user operation means that more than one user can access the same database at the 
same time. Here, a "user" can be another person running the main ScaleLink Pro program or 
the ScaleLink Pro scheduler program performing an automatic operation in the background. 

Multi-user operation is only available on MDB format databases. If multi-user operation is OFF 
or if the PLD database format is used, ScaleLink Pro does not allow more than one user to 
access the database at one time. A message appears to notify you of a "database busy" error if 
you try to open a database that is already open by another user. 

To allow multi-user operation, set the Multi-user database access (MDB only) check box ON 
in the Options dialog (see Multi-User Installation in Appendix A.1 Setting Up ScaleLink Pro at a 
New Store). 

Normally, ScaleLink Pro operates by taking a snapshot of the database when it starts up, and 
writes changes to the database each time you save a record. When multi-user access is set 
ON, ScaleLink Pro reads the latest copy of PLU or other data records when you open the edit 
window or dialog for that record. This updates the record with any changes made by other 
users. However, any changes made by another user while you are editing a record do not 
appear on your screen. Saving a record updates the entire record in the database and 
overwrites any changes made previously by yourself or another user. 

Note, however, that records added by other users are not visible until you close and reopen the 
database. Similarly, records deleted by other users do not disappear from ScaleLink Pro until 
you close and reopen the database. 
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6. Editing PLUs and Other Scales Data 
This section describes how to manage PLU data. 

6.1 Using the PLU Search Window 
The PLU search window opens automatically when you start ScaleLink Pro. Use the PLU 
Search window for the following operations. 

Note: Screen appearance may differ depending on how your copy of ScaleLink Pro is 
configured. 

• Finding a PLU 
• Adding a new PLU 
• Editing or deleting a PLU 
• Deleting a range of PLUs 
• Cutting and pasting PLUs 
• Quick price changes 
• Marking PLUs as active or inactive 
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Finding a PLU 

If you know the PLU number 
Enter the PLU number in the PLU No. field. The specified PLU appears selected in the PLU list. 

If you know some or all of the PLU name 
The PLU name is the first line of the PLU description that appears on the label. Enter the initial 
characters of the PLU name in the Search field. The PLU list displays only those PLUs with 
names that start with the entered text. For example, entering “BEEF” displays all PLU names 
starting with the word “beef”. (The search is not case-sensitive: entering  “beef” is the same as 
entering “BEEF”.) 
You can also use the wildcard characters (‘*’ and ‘?’) to specify a more detailed search 
condition. For example, entering “*BEEF” displays all PLU names containing the word “beef”. 

 The search re-executes automatically each time you type a character. The response 
may be a bit slow on older computers. In this case, allow a few seconds for the list to 
update.  

If you do not know the PLU number or name 
When the cursor is in the Search field, the PLU list only displays those PLUs that match the 
search condition. Click the PLU No. field to clear the search results and display all PLUs in the 
PLU list. 
Next, use the scroll bar, the up an down arrow keys, or the PageUp and PageDown keys to 
scroll the PLU list until you find the PLU you are looking for. 

Searching by POS code (bar code) 
Your copy of ScaleLink Pro may have been configured to allow you to search for PLUs by POS 
code (bar code). In this case a POS code field appears next to the PLU number field at the top 
of the window. 
The operation is the same as for the PLU field. 

Searching by department and group code 
Your copy of ScaleLink Pro may have been configured to allow you to search for PLUs by 
department and group code. In this case, department and group fields appears next to the PLU 
number field at the top of the window. 
The PLU list only displays PLUs belonging to the selected department and group. 

Adding a New PLU 
1. Click the New PLU button or select New PLU from the PLU menu. This opens a PLU 

Selection dialog for you to specify the PLU number. The next free PLU number appears 
as the default. Enter the PLU number then click OK. 
Next, the PLU Edit window opens displaying the data for the new PLU. 
The fields in the lower half of the window are set to their default values. 
The specified PLU number is set in the PLU number field, but you can change the 
number if desired. (A warning message appears if you try to save the PLU with the 
same number as an existing PLU.) 
The operation of the PLU Edit window is described in 6.2 Using the PLU Edit Window. 

2. Enter the PLU description and other data, then click the Save button. This saves the 
PLU in the database and sends the PLU to the scales (if connected). 

3. Click the Close button to close the window and return to the PLU Search window. Use 
the procedure described in Finding a PLU above to check that the PLU has been 
added. 

 

39 



Editing or Deleting a PLU 
1. Use the procedure described in Finding a PLU above to find the PLU to edit or delete. 

Click on the PLU in the list to select. 

2. To edit the PLU: click the Edit PLU button, select Edit PLU from the PLU menu, or 
double-click on the PLU in the list. 
This opens a PLU Edit window displaying the data for the selected PLU. 
The operation of the PLU Edit window is described in 6.2 Using the PLU Edit Window. 

3. To delete the PLU: click the Delete PLU button. 
A dialog opens asking you to confirm whether to delete the PLU. Take care as there is 
no means of undeleting a deleted PLU. 
Click Yes to delete the PLU from the database and, if connected, send a command to 
delete the PLU on the scales. 

Deleting a Range of PLUs 
1. Select Delete PLUs from the PLU menu. This opens a dialog for you to specify the 

range of PLUs to delete. 
 

 

2. Enter the start and end PLU numbers or use the Select buttons to open a PLU selection 
dialog. The PLU selection dialog operates in the same way as the PLU Search window 
(see Finding a PLU above). 

Alternatively, click the Delete All button to delete all PLUs in the database and scales. 

3. Click OK to delete the PLUs from the database and, if connected, send commands to 
delete each PLU on the scales. 

Cutting and Pasting PLUs 
You can use the Edit menu or the standard Windows keystrokes to cut, copy and paste PLUs in 
the PLU list field of the PLU Search window. 

When pasting a PLU, a dialog appears asking how to paste the PLU into the database 
(overwrite existing PLU or assign a new PLU number). 
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Quick Price Changes 
This feature is provided to allow you to update prices quickly without editing the entire PLU. 
You can change either the standard price or the markdown price. The operation is the same in 
both cases. 

1. To change standard prices, click the Price Changes button or select Price Changes 
from the PLU menu. To change markdown prices, select Markdown Price Changes 
from the PLU menu. 
This opens a price change dialog. 

 

 

2. Enter the new price and press Enter. This saves the specified price and, if connected, 
sends the price change to the scales. 
A PLU search dialog opens automatically for you to select the next PLU number. 
This feature is useful if you have a list of PLU price changes to make that are not in 
sequential order. 
If Scalelink Pro is configured to have multiple prices per PLU, use the TAB key to move 
from one price field to the next, then press ENTER, as described above, to save the 
changes and move to the next PLU. 
The intention is to allow you to change a large number of prices with the minimum 
number of keystrokes. 

3. If necessary, use the mouse to click the <<Prev, Next>>, or Select button to find the 
desired PLU number. 
Clicking the Select button opens a PLU selection dialog. The PLU selection dialog 
operates in the same way as the PLU Search window (see Finding a PLU above). 

4. When finished, click the OK button (to save the currently displayed price change) or 
Cancel button (to close the dialog without saving). 
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Nutrition 
This feature edits the nutrition data for the selected PLU. Nutrition data is only used in some 
countries. The Nutrition button and menu item are only displayed if your copy of ScaleLink Pro 
is setup to use nutrition. 

 Version 3 of ScaleLink Pro added a new option for handling nutrition data whereby 
the same nutrition data can be shared by multiple PLUs. Previously, each PLU had a 
separate nutrition data record. However, this feature is only supported by AstraXT 
scales and cannot be used in systems that contain older scale models. 
If nutrition data sharing is enabled, the top right of the nutrition dialog displays a list 
where you can specify the PLUs to which to assign the nutrition data. The operation is 
described below. 

 

 

1. Click the Nutrition button or select Nutrition from the PLU menu. This opens the 
nutrition edit dialog shown below. (The dialog below shows USA format nutrition. The 
appearance of the dialog may be different for other countries, but the operation is the 
same.) 

 

 
2. Enter the information in each field, then click the OK button. This saves the nutrition 

information and, if connected, sends the information to the scales. 

To assign the nutrition data to a different PLU number, use the Select button to change 
the PLU, then click the OK button. 

To close the dialog without saving your changes, click the Cancel button. 
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Operation when Nutrition Data Sharing is Enabled 

AstraXT and later scales allow the same nutrition data to be shared by more than one PLU. In 
this case, the top right of the nutrition dialog displays a list where you can specify the PLUs to 
which to assign the nutrition data. The following operations are available: 

Operation Explanation 

Assign to PLU Opens a dialog to select another PLU to which to assign the current 
nutrition data. If nutrition is already assigned to the PLU, the old 
assignment is cleared. 

Remove from PLU Clears the nutrition data from the selected PLU. 

New Nutrition Creates a new nutrition record with the current data and assigns to the 
selected PLU. The old nutrition record remains assigned to the other 
PLUs. 

Changes to the PLU data are updated in the database and sent to the scale when you click the 
OK button. If the changes result in a nutrition record no longer being assigned to any PLU, it is 
deleted. 

Ingredients 
In some countries, ingredients information can be assigned to a PLU in a similar way to 
nutrition. 

If Ingredients data is supported for your system, an Ingredients button appears at the top of 
the PLU Edit window. Click the button to open a dialog for editing the ingredients for the PLU. 

The ingredients data is handled in the same way as extra messages in both Scalelink Pro and 
on the scales. Accordingly, the operation of the ingredients edit dialog is the same as for the 
extra message dialog. See Editing the message text in 6.5. Messages for details. 
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6.2 Using the PLU Edit Window 
This section describes how to use the PLU Edit window. 

The contents of the PLU Edit window depends on how your system is configured. The figure 
below shows an example. 

 The operation of the PLU Edit window is somewhat different for EMZ series scales. 
The basic operation is the same as described in this section, but some additional 
functions are available. After reading this section, please refer to section 6.3 Editing 
Price Master Records.  
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The main elements of the PLU Edit window are as follows: 

Control Element Explanation 

PLU description 
field and associated 
controls 

Located in the upper-left half of the window. The PLU description field 
consists of a row of controls for setting the font, font type and label width, 
and an edit area (with a scroll bar) for editing the description text. 
How to use this field is explained below (see Editing the PLU description).

PLU data fields Located in the lower half of the window. These fields are used to set the 
various parameters, such as the price, that determine how the PLU is 
printed on the scales. 
The parameters to be displayed can be configured when ScaleLink Pro is 
installed. Your copy of ScaleLink Pro should only display those 
parameters that are relevant to your store. 
Use the mouse or TAB key to move the cursor to the desired field and 
enter a value or select an option from the list. A message appears if you 
enter a value outside the allowed range. 
If the price zone mode is "Head Office" (see Price Zones), asterisks 
indicate the price zone fields. Clicking the right mouse button on a price 
zone field opens a popup dialog for editing the values for each price 
zone. 
Depending upon how your copy of ScaleLink Pro is configured, the PLU 
data fields may be split into a number of tab pages. In this case a tab bar 
appears at the bottom of the PLU Edit window. Click the tabs to display 
the corresponding pages of fields. 

Save button Located at the top left of the window. Click to save any changes you have 
made and send the PLU data to the scales (if connected). 

Close button Located at the top right of the window. Click to close the PLU Edit 
window. A warning message appears if you have any unsaved changes.

<<Prev and Next>> 
buttons 

Located at the top of the window. Click to display the next or previous 
PLU number. A warning message appears if the current PLU has any 
unsaved changes. 
NOTE:  You can also use the PLU Search window to change the 
displayed PLU. Click on the PLU Search window to make it the active 
window, select the desired PLU in the list, then click the Edit button. 

New PLU button Click to create a new PLU. A PLU search dialog opens for you to specify 
the new PLU number. 

PLU No. field Located on the right of the window. Enter a new PLU number if you wish 
to save the displayed data to a new PLU. A warning message appears 
when you click the Save button if a PLU with that number already exists. 
Saving the PLU data to a new PLU number does not delete the old PLU 
number and leaves the data for the old PLU unchanged. 

Nutrition button This button only appears if your copy of ScaleLink Pro is configured to 
use nutrition. 
Click to edit the nutrition for the PLU. 

Ingredients button This button only appears if your copy of ScaleLink Pro is configured to 
use ingredients. 
Click to edit the ingredients for the PLU. 

Message, etc. 
Browse buttons 

A Browse button appears to the right of some fields. Click this button to 
open a selection dialog listing the available settings for the field. 
Typically, a Browse button appears for fields such as messages that link 
to data specified elsewhere in ScaleLink Pro. 

Price Zone Only appears if the price zone mode is "Head Office" (see Price Zones).
Select the price zone you wish to edit. This refreshes the display with the 
data for the selected price zone.  Any changes to price zone fields 
(indicted by asterisks) are saved as price zone-specific data. 
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Control Element Explanation 

Sale or Campaign 
icon 

A special icon appears to the left of the PLU No. field (in the description 
format bar) to indicate if the PLU belongs to a campaign or sale. Click the 
icon to edit the campaign or sale. 
Campaigns and sales are described in 6.6 Campaigns and 9.9 Sale 
Wizard respectively. 

 

Editing the PLU description 

The PLU description field consists of a row of controls for setting the font, font type and label 
width, and an edit area (with a scroll bar) for editing the description text. 

Click on the edit area to select the field and use the mouse or arrow keys to move the cursor 
within the field. The following operations are available in the PLU description field. 

 

Operation Explanation 

Insert text Position the cursor at the desired location and enter text from the keyboard. 
The font and label width determine how many characters are displayed per 
line. Press the INS key to switch between insert and overwrite mode. 

 

Select text Drag with the mouse or hold down the shift key and use the arrow keys to 
move the cursor over the desired text. The selected text appears highlighted.

 

Change line 
font  

A different font can be set for each line. Position the cursor in the line and 
select the desired font from the Font field. 
Alternatively, press Ctrl+F to step through the available fonts. 

 

Change font 
type 

Characters can be displayed bold, reversed, in italic, and/or underlined. 
Select some text and click the buttons above the description field to turn each 
character type attribute on or off for the selected text. 

 

Desc. Size 
(mm) 

Set the Width field to the actual label width to be used for this PLU. This 
updates the description field to only display as many characters as will fit on 
the label. 
Set the Length field to the maximum length for the description text in the 
label, including any extra message. The actual length (including any extra 
message) is displayed beneath the Length field. 
A warning message is displayed when you try to save the PLU if the actual 
length is too long. 

NOTE: These settings are only used within ScaleLink Pro. They have no 
effect on the actual label dimensions on the scales. 

 

Cut, Copy or 
Paste 

Use the Edit menu or the standard Windows keystrokes (listed below) to cut, 
copy or paste description text. 

Keystroke   Operation 
Ctrl+X or Shift+Del  Cut 
Ctrl+C or Ctrl+INS  Copy 
Ctrl+V or Shift+INS  Paste 
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6.3 Editing Price Master Records (IP-EMZ only) 
The IP-EMZ allows you to specify up to 5 price master records per PLU. Each price master 
record contains not just a price, but also a range of other settings such as bar code settings, 
logo, and tray. This is intended for use in processing center or similar environments where you 
are packing product for more than one store. Which price master to use is specified in the store 
settings for each store. 

 
 Support for multiple price master records can be disabled if you do not require it. In 

this case, the price and other settings that would have been specified on the price 
master screen are instead specified in the PLU Edit window, in the same way as 
other PLU data fields. 
You do not need to read this section if the multiple price master function is disabled 
on your copy of Scalelink Pro. 

 

 

Creating and Editing Price Master Records 
If the price master feature is enabled, a Browse button appears to the right of the price field in 
the PLU Edit window as shown below. 

 

 

Price master Browse button 

 

1. Click the browse button to open the EMZ price settings dialog shown below. 
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Typically, your copy of Scalelink Pro will have been configured to only show the fields that you 
use. In this case, the dialog will appear somewhat different to that shown above. 

 

2. Select the tab for the price master you wish to edit. 

3. Set the Use Price check box ON or OFF, depending on whether you want to use this 
price master record. 
Note that at least one price master record must be enabled. Scalelink Pro will prohibit 
you from turning the Use Price check box OFF for all five records. 

4. Enter values in the various fields, and then click the tab for the next price master you 
wish to edit, or click Close when you have finished 

Note that any changes you make to the price master records are not saved or sent to the scale 
until you save the PLU. 
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6.4 Advertising Messages 
This section describes how to create and edit advertising messages. You can define up to ten 
advertising messages in ScaleLink Pro. Which of these messages to display is set on the scale 
itself. 
  

The AstraXT series of scales do not support advertising messages. 
 

Creating and Editing Advertising Messages 
 

1. Click Advertising Messages in the Scales menu. This opens a dialog displaying the 
available advertising messages. Unused messages are listed as “Spare”. 

2. Click on a message to select it then click the Edit button to open a dialog to edit the 
message (or simply double-click on a message). 

The appearance of the dialog depends on the country and type of system you are using 
(AC-2000 or AC-3000, etc.). The examples below are for the AC-3000. 

USA version 

Non-USA versions 

 
3. Enter the message and other settings. 

4. When you have finished, click OK to save the message and, if connected, send the 
message to the scales. 

5. This returns you to the advertising message selection dialog. Click the Close button to 
close the dialog. 

Deleting an Advertising Message 
1. Click Advertising Messages in the Scales menu. This opens a dialog displaying the 

available advertising messages. Unused messages are listed as “Spare”. 

2. Click on a message to select, then click the Delete button. A warning message appears 
asking you to confirm deletion. 
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6.5. Messages 
This section describes how to create and edit the various messages used on the scales. 
Which messages are available will depend on which messages are supported on the model of 
scale you are using. 

The different types of message are listed below: 

Name Supported Scale Model 

Extra messages All AC series scales, AstraXT, SR series 

Extra messages #2 and #3 AC-4000 and later AC series scales, AstraXT, SR series 

Coupons AC-3000, AC-4000 (excluding New Zealand), AstraXT, SR series 

Ingredients AC-3000 (New Zealand only), EMZ series 

POP messages* EMZ series, AC-4000 (Taiwan only), AstraXT (Taiwan only), SR 
series 

Storage temperature, 
Storage instructions 

EMZ series 

Free messages #1 to #5  SR and EMZ series 

Origin message EMZ series 

Comment message EMZ series 
* POP messages are available on all scale models. However, on most AC series and AstraXT scales, the 
messages are predefined in the scale memory and cannot be modified by Scalelink Pro. 

The operation is the same for all types of message. 

Creating and Editing Messages 
1. Click the appropriate command in the Scales menu to open a dialog like that shown 

below displaying the currently defined messages. 
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2. Click the Add button to create a new message, or click on an existing message to 
select, then click the Edit button to edit the message (or simply double-click on a 
message). 
A dialog opens to edit the message. 

 

 

3. Enter the message name. The name entered here appears in the message selection 
dialog (step 2 above). 

4. Enter the message text. The operation of the message text field is described below. 

5. Optionally, you can change the message number in the Msg No. field to save the 
displayed message with a different number. A warning message appears when you 
click the OK button if a message with that number already exists. 

6. When you have finished, click OK to save the message and, if connected, send the 
message to the scales. 
This returns you to the message selection dialog. Click the Close button to close the 
dialog. 
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Editing the message text 

The message text field consists of a row of controls for setting the font, font type and label width, 
and an edit area (with a scroll bar) for editing the message text. 

Click on the edit area to select the field and use the mouse or arrow keys to move the cursor 
within the field. The following operations are available in the PLU description field. 

 

Operation Explanation 

Insert text Position the cursor at the desired location and enter text from the keyboard. 
The font and label width determine how many characters are displayed per 
line. Press the INS key to switch between insert and overwrite mode. 

 

Select text Drag with the mouse or hold down the shift key and use the left or right arrow 
key to move the cursor over the desired text. The selected text appears 
highlighted. 

 

Change line 
font  

A different font can be set for each line. Position the cursor in the line and 
select the desired font from the Font field. 

Alternatively, press Ctrl+F to step through the available fonts. 

 

Change font 
type 

Characters can be displayed bold, reversed, in italic, and underlined. Select a 
section of text and click the buttons above the message field to turn each 
character type attribute on or off for the selected text. 

 

Change label 
width 

Set the Label Width field to the actual label width to be used. This updates 
the message field to only display as many characters as will fit on the label. 

NOTE: This setting is only used within ScaleLink Pro. It has no effect on the 
actual label width on the scales. 

 

Cut, Copy or 
Paste 

Use the standard Windows keystrokes (listed below) to cut, copy or paste 
message text. 

Keystroke   Operation 
Ctrl+X or Shift+Del  Cut 
Ctrl+C or Ctrl+INS  Copy 
Ctrl+V or Shift+INS  Paste 

 

 

Deleting a Message 
1. Click the appropriate command in the Scales menu. This opens a dialog displaying the 

currently defined messages. 

2. Click on a message to select it then click the Delete button. A warning message 
appears asking you to confirm deletion. 
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6.6 Campaigns 
This section describes how to create and edit campaigns. Campaigns allow you to change the 
price of specified PLUs for a fixed time period. The prices return to normal when the campaign 
has finished. 

The number of campaigns you can define depends on the type of scales system you are 
connected to. 

 The AstraXT series of scales do not support campaigns. See “Sale Wizard” in 
Chapter 9 Advanced Features and Utilities for details on how to use ScaleLink Pro to 
provide a similar function.  

Creating and Editing Campaigns 
1. Click Campaigns in the Scales menu. 

2. If your scales system supports more than one campaign at a time: 

 A dialog opens displaying the available campaigns. Unused campaigns are listed as 
“Spare”. 
Click on a campaign to select it then click the Edit button to open a campaign edit 
dialog (or simply double-click on a campaign). 

 If your scales system only supports one campaign at a time: 

 A campaign edit dialog opens. 

 

 

3. Enter the campaign name. The name entered here appears in the campaign selection 
dialog. (Step 2 above. Multi-Campaign systems only.) 

4. Enter the start and end date and time of the campaign. 
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5. Enter the campaign PLUs. 

 Click the Add button to add a PLU to the campaign. This opens a dialog (shown 
below) to specify the PLU number and price. 

Select a PLU in the list and click the Edit button to edit a campaign PLU. This opens 
a dialog (shown below) to specify the PLU number and price. 

Select a PLU in the list and click the Delete button to delete a PLU from the 
campaign. 

 

 

6. When you have finished, click the OK button to save your changes and, if connected, 
send the campaign to the scales. 

An icon appears in the PLU edit window, as shown below, if the PLU is assigned to a 
 

campaign. Click on the item to edit the campaign settings (steps 3 to 5 above). 
The same icon also appears if the PLU is assigned to a Sale Wizard sale. 
However, the icon does not appear if the sale or campaign has already finished. 

 

  

 
 

 

Deleting a Campaign 
You can only delete campaigns if your scales system supports multiple c
campaign systems, simply set the campaign end date to a date that has 
disables the campaign. 

For multi-campaign systems: 

1. Click Campaigns in the Scales menu. This opens a dialog displa
campaigns. Unused campaigns are listed as “Spare”. 

2. Click on a campaign to select it then click the Delete button. A wa
appears asking you to confirm deletion. 

 

Campaign icon
ampaigns. For single 
already passed. This 

ying the available 

rning message 
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6.7 Keyboard Presets 
Keyboard presets allow you to define the meaning of keys on the scale keyboard. Ishida scales 
have a shift key, so you can define two meanings for each key. Meanings that can be assigned 
to keys include PLU numbers, extra messages, and coupon messages. 

You can also create a keysheet template which you can printout and use as an overlay on the 
scale keyboard. This is the same function that was previously provided as the Ishida Keysheet 
Template utility program. 

ate keyboard definition can be defined for each scale. 

Some printer drivers have a bug that causes them to print rotated text incorrectly. If 
A separ

 

you have trouble printing keysheet templates, try changing the Bypass bug in 
printer driver? setting (Select Options from the Setup menu and select the General 
#2 page). If neither setting works, try changing the print orientation from portrait to 
landscape. 

 

Managing Keyboard Data 
A separate keyboard definition is assigned to each scale and stored in the site setup file along 
with the scale definitions. 

If you are setting up a new site and wish to copy the existing keyboard definitions from an 
existing site, you should load the site setup file from the existing site and use this as the basis 
for settig up the new site. 

Unfortunately, there is no function for copying keyboard definitions from one site setup file to 
another. 

Creating and Editing Keyboard Presets 
1. Click Keyboard Presets in the Scales menu. 

2. If your system supports multiple scales: 

 A dialog opens displaying a list of the scales in your system. 
Select the desired scale and click the Select button (or simply double-click on a 
scale). 
This opens a keyboard edit window. 

 If your system supports a single keyboard preset definition only: 

 A keyboard edit window opens. 

The figure below shows an example keyboard edit window for an AC-3000 scale. 
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3. Edit the keyboard definition as described below. 

4. When you have finished, click the Save button to save your changes and, if connected, 
send the keyboard definition to the scales. Click the Close button to close the window.

Editing the keyboard definition 

The following operations are available: 

Operation Explanation 

Save Clicking the Save button saves the keyboard settings in the database and, if 
connected, sends the keyboard preset definitions to the scale. 

Close Clicking the Close button closes the keyboard edit window. 

Print Clicking the Print button prints the keysheet template. 

Edit key Double-click on a key, or click on the key then click the Edit Key button. 
This opens a dialog for specifying the key meaning and keysheet template 
format. 

Note that preset definitions cannot be made for the standard keys on the right 
of the keyboard (the keys that appear grayed in the keyboard edit window). 
The preset key settings in the dialog are disabled for these keys. 

56 



 

Edit key 
(cont..) 

The Key Preset boxes on the left of the dialog specify the upper and lower 
key meanings. Click Key Type to specify the key meaning and enter the value 
(PLU number or message number, etc.) in the Data field. 
For some key types, you can use the Select button to open a dialog listing the 
available values. 

The Template Printing box on the right of the dialog specifies how to print the 
key in the keysheet template. Enter the text and format settings (background 
color, font, split key, etc.). A preview of the key format is shown in the bottom 
right of the dialog. The Copy -> keys on the left of the dialog copy the key 
meaning (PLU name, etc.) into the keysheet template text field. 

The Double Key settings allow you to link the selected key to an adjacent 
key. The effective result is a single, larger key. This is used, for example, by 
the standard PLU and Print keys. 

 

Delete key Click on a key then click the Delete Key button to delete the definition for that 
key. This resets the key to the default settings. 

Drag & drop 
keys 

You can use the mouse to drag settings from one key to another. If you hold 
down the CTRL key when you release the mouse button, the settings are 
copied instead of being moved (that is, the settings are not removed from the 
source key). 

Display mode Click the Upper, Lower, or Keysheet buttons to select which type of 
information to display in the keyboard window. 
Ishida scales have a shift key, so you can define two meanings for each key. 
The “Lower” key is the key meaning when the shift key is pressed. 
 

Zoom Set the display magnification. 

Scale Displays the scale name. 

Set Default Selecting Set Default from the Keyboard menu opens a key edit dialog to 
define the default key settings. The default key settings relate to the keysheet 
template only and specify the default background color and font, etc. 

Clear Changes Selecting Clear Changes from the Keyboard menu undoes any changes 
made to the keyboard since it was last saved. 

Delete 
Keyboard 

Selecting Delete Keyboard from the Keyboard menu deletes the keyboard 
from the database and deletes all preset key settings on the scale. 

Copy 
Keyboard 

Selecting Copy Keyboard from the Keyboard menu opens a scale selection 
dialog. Select a scale to copy all the key settings from that scale. 
You can copy a keyboard from a scale with a different keyboard layout (e.g. 
AC-3000 to AstraXT), but you will need to rearrange the key positions 
manually after copying. 

Import 
Keyboard 
Template 

Select Import Keyboard Template from the Keyboard menu to import a 
keysheet template file created using the Ishida Keysheet Template utility 
program. 
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6.8 Operators 
This defines the names of the scale operators. The names defined here are used in the 
operator totals report. 

1. Click Operators in the Scales menu. 

2. A dialog appears listing any existing operators. 
Click the Add button to add a new operator or select an operator in list and click the 
Edit button to edit that operator. 

3. Enter the operator name and ID number in the dialog shown below, then click the OK 
button to save your changes and, if connected, send the operator data to the scales.
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6.9 Store Name and Address (AC-3000, AstraXT, AC-4000, and SR-2000) 
This defines the store name and address printed on PLU labels. 

 1. The store name and address is stored separately for AC-4000 and other scale 
models. This is because the AC-4000 supports formatted text but the other scales do 
not. If your system includes both AC-4000 and other scale models, two separate 
menu commands will appear in the Scales menu for editing store data. In this cse, 
you must enter your store name and address twice. 

 

 2. This function is not used on EMZ series scales. See section 6.10 Store Settings for 
details of how to set the store name and address on an EMZ series scale. 

 

1. Click Store Name (AC-3000/AstraXT) or Store Name (AC-4000) in the Scales 
menu. 

2. If your system supports multiple stores: 

 A dialog opens displaying a list of stores. 
Click on a scale ID to select then click the Edit button (or simply double-click on a 
scale ID). 
This opens a store name and address edit dialog. 

 If your system supports a single store name and address: 

 A store name and address edit dialog opens. 

3. Enter the information for your store then click the OK button to save your changes 
and, if connected, send the store name and address to the scales. 

 

Note: The appearance of the AC-4000 dialog is different as it allows fonts to be specified. 
Otherwise the operation is the same. 
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6.10 Store Settings (EMZ series only) 
In addition to the store name and address, this specifies a range of settings such as the label 
formats to use that allow you to print different labels for each store. The store setting function is 
primarily intended for processing center type applications where you are packing products for 
more than one store. 

Creating and Editing Store Settings 
1. Click Store Settings in the Scales menu. This opens a dialog listing all the stores 

defined in your system. 

2. Click on a store to select then click the Edit button (or simply double-click on the 
store). Alternatively, click the Add button to add a new store. 
This opens an EMZ Store Settings dialog, as shown below. 

 

 
 

3. Enter the store name and address and other store settings, then click the OK button 
to save your changes and, if connected, send the store settings to the scales. 

Deleting Store Settings 
1. To delete a store from the system, click Store Settings in the Scales menu. This 

opens a dialog listing all the stores defined in your system. 

2. Click on a store to select then click the Delete button. 
A confirmation dialog appears. Click OK to delete the store. 
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6.11 Tray Settings (EMZ series only) 
This specifies the dimensions, weight, and various wrapper related parameters for each tray 
you use. 

Creating and Editing Tray Settings 
1. Click Tray Settings in the Scales menu. This opens a dialog listing all the trays 

defined in your system. 

2. Click on a tray to select then click the Edit button (or simply double-click on the tray). 
Alternatively, click the Add button to add a new tray. 
This opens an Edit EMZ Tray dialog, as shown below. 

 
 

3. Enter the tray size and other tray settings, then click the OK button to save your 
changes and, if connected, send the tray settings to the scales. 

Deleting Tray Settings 
1. To delete a tray from the system, click Tray Settings in the Scales menu. This opens 

a dialog listing all the trays defined in your system. 

2. Click on a tray to select then click the Delete button. 
A confirmation dialog appears. Click OK to delete the tray. 
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6.12 Department and Group (AC-4000, SR-2000, and EMZ series only) 
This specifies the department and group names to use on the scale. 

 This function is not the same as the department and group codes used within 
Scalelink Pro. The Scalelink Pro department and group code function is intended for 
use with AC-3000 series scales, and is typically disabled when Scalelink Pro is used 
with EMZ series scales to avoid confusion between the two functions. 
The Scalelink Pro department and group code function is described in the Setting Up 
Department and Group Codes section of Appendix 1  Setting up Scalelink Pro at a 
New Store. 

 

 

Creating and Editing EMZ Department and Group Names 
1. Click Department or Group in the Scales menu. This opens a dialog listing all the 

departments or groups defined in your system. 

2. Click on a department or group to select then click the Edit button (or simply 
double-click on the department or group). Alternatively, click the Add button to add a 
new department or group. 
This opens an Edit EMZ Department dialog, as shown below. 

 

 
 

3. Enter the department or group name and number, then click the OK button to save 
your changes and, if connected, send the settings to the scales. 

Deleting EMZ Department and Group Names 
1. To delete a department or group from the system, click Department or Group in the 

Scales menu. This opens a dialog listing all the departments or groups defined in 
your system. 

2. Click on a department or group to select then click the Delete button. 
A confirmation dialog appears. Click OK to delete the department or group. 
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6.13 Memo and Index Presets (EMZ and SR series only) 
EMZ and SR series scales have a touch screen which can be programmed by assigning 
functions such as calling up a PLU to regions of the screen ("keys"). 

The SR series has a single preset key function that can define multiple pages of preset keys. 

EMZ scales have two types of programmable keys: memo presets and index presets. Both 
provide a way of quickly calling up PLUs from the touch screen on the scale. 
• Memo presets define quick keys for calling up a particular PLU. 
• Index presets define keys that call up a list of PLUs, specified by a range of PLU numbers. 

Note:  Preset key definitions are stored in the site setup file along with the scale definitions. 

SR Presets Overview 
Preset keys on the SR-2000 alpha are divided into up to 99 pages. The three types of page are 
as follows: 

Preset Page Type Description 

Function Key Page One page only. This is the default page. All preset key functions such 
as PLU call up can be assigned to keys on this page. 

Category Key Page One page only. This page is used as an index to the preset key pages 
described below. Each preset key page can be assigned to a category 
("group") and the category assigned to a preset key on the category 
key page. The user can then press the key on the category key page to 
jump to the first preset key page assigned to the associated category. 
The user can then press the PAGE key to scroll through all the preset 
key pages belonging to that category. 

Preset Key Pages 2 
to 99 

The preset keys on these pages can be assigned to various functions 
such as PLU call up. Also a "group" key can be defined to specify the 
category ("group") to which this page belongs. This is used to scroll 
through pages in the same category as described in the Category Key 
page explanation above. 

Creating and Editing SR Presets 
1. Click Memo/SR-2000 alpha Presets in the Scales menu. 

This opens a dialog listing all EMZ and SR scales defined in the system. Only one 
set of presets can be defined for each scale. 

2. Click on a scale to select then click the Edit button (or simply double-click on the 
scale).  
If you have selected an SR series scale, this opens an Edit SR-2000 alpha Presets 
dialog, as shown below. 
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3. SR series presets consist of multiple pages (the number of pages depends on the 

scale). The available pages are listed in the Pages list box on the left of the screen. 
As you can see from the example above, there are three types of page. The 
operation of each type is as follows: 

Function key page:  Main page. PLU call-up and other functions can be assigned to 
each key. 

Category key page:  This acts as a menu for opening the preset key pages. 

Preset key pages:  PLU call-up and other functions can be assigned to each key on 
these pages. 

Click on a page in the Pages list box to display that page in the preset key area (right 
side of screen). 

To assign a function to a key, select the key and click Edit (or double click on the 
key). Similarly, to remove a function from a key. select the key and click Delete. 

You can use the mouse to drag settings from one key to another. If you hold down 
the CTRL key when you release the mouse button, the settings are copied instead of 
being moved (that is, the settings are not removed from the source key). 

4. If more than one SR series scale is defined, you can use the Copy Kbd. button to 
copy the preset data from another scale. 

Similarly you can use the Copy Page button to copy settings from one preset key 
page to another. 

5. You can use the Default Key button to set the default background and text colors 
and the default font. It is a good idea to set the defaults before you start creating a 
keyboard. 

The default settings apply to all pages. 

6. Editing a key opens the Edit Preset Key dialog shown below. 
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 Use this window to set the key meaning, text, colors, and key size. The key text 
permits carriage returns and the text area size (number of lines and number of 
character per line) depends on the selected key size and font. 

You can assign a bitmap image to display in the key. In this case, select the image 
from the predefined list of images in the Image ID field. The selected image appears 
in the preview panel on the right. 
The images are defined using SR-2000 alpha Images in the Scales menu. You can 
also go directly to the image edit window from this dialog by clicking the Edit Images 
button. The operation is described in 6.14 SR-2000 alpha Images. 
Note: You can only select images with the same size as the key (small, medium, or 
large). Changing the key size clears the image ID setting. 

When finished, click OK to close the dialog and return to the Edit SR-2000 alpha 
Presets dialog. 

5. When finished, click OK to save your changes and, if connected, send the settings to 
the scales. 
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Creating and Editing Memo Presets 
1. Click Memo Presets/SR-2000 alpha in the Scales menu. 

This opens a dialog listing all EMZ and SR scales defined in the system. Only one 
set of memo presets can be defined for each scale. 

2. Click on a scale to select then click the Edit button (or simply double-click on the 
scale).  
If you have selected an EMZ series scale, this opens an Edit Memo Presets dialog, 
as shown below. 

 
 

3. To assign a PLU to a key, select the key and click Edit (or double click on the key). 
Similarly, to remove a PLU from a key. select the key and click Delete. 

You can use the mouse to drag settings from one key to another. If you hold down 
the CTRL key when you release the mouse button, the settings are copied instead of 
being moved (that is, the settings are not removed from the source key). 

Note that the scale has a Shift key to switch between to pages of preset keys. Use 
the Key Page buttons to select which page to program. 

4. When finished, click OK to save your changes and, if connected, send the settings to 
the scales. 
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Creating and Editing Index Presets 
1. Click Index Presets in the Scales menu. 

This opens a dialog listing all EMZ scales defined in the system. Only one set of 
index presets can be defined for each scale. 

2. Click on a scale to select then click the Edit button (or simply double-click on the 
scale).  
This opens an Edit Index Presets dialog, as shown below. 

 

 
 

3. To assign a series of PLU number ranges to a key, select the key and click Edit (or 
double click on the key). This opens an Edit Index Preset Key dialog, as shown 
below. 

 

 
 

 Either type the PLU numbers for each range into the edit fields, or click on the PLU 
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number field you wish to enter, and then click the Select button to open a dialog for 
selecting the PLU number. 

Click OK when you have finished entering PLU number ranges to return to the Edit 
Index Presets dialog. 

4. To remove the settings from a key. select the key and click Delete. 

You can use the mouse to drag settings from one key to another. If you hold down 
the CTRL key when you release the mouse button, the settings are copied instead of 
being moved (that is, the settings are not removed from the source key). 

When finished, click OK to save your changes and, if connected, send the settings to 
the scales. 
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6.14 SR-2000 alpha Images (SR series only) 
SR series scales have a touch screen which can be programmed by assigning functions such 
as calling up a PLU to regions of the screen ("keys"). You can also assign bitmap images to 
each key. This section describes how to define the bitmap images used in the touch screen 
preset keys. 
How to setup the preset keys is described in 6.13 Memo and Index Presets. 
 
Image sizes 
Only bitmap images in one of the following three sizes are permitted. These sizes correspond 
to the three preset key sizes. 
 Small  66(W) x 49(H) dots 
 Medium 135(W) x 49(H) dots 
 Large  135(W) x 101(H) dots 
 
Note:  SR-2000 images are stored in the site setup file along with the preset key and scale 
definitions. 

Creating and Editing SR Images 
1. Click SR-2000 alpha Images in the Scales menu. 

This opens a dialog listing the currently defined images, as shown below. 
 

 
2. To add a new image, click the Add button. A File Open dialog appears for you to 

specify the bitmap file. Select the file and click OK. 
If you selected a bitmap that does not match one of the above three permitted sizes, 
a message appears to notify you of this and the bitmap image cannot be added to 
Scalelink Pro. 
If you selected a valid bitmap, the following dialog appears. 
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3. Enter the image number and a name for the image. When adding a new image, the 

image number defaults to the next unused number. The image name is used to 
select the image in the preset key setup dialog. 
Click OK when finished. 

4. To edit an existing image, select the image and click the Edit bnTo edit an existing 
image, select the image and click the Edit button. This opens the above dialog. 
Note that you can only edit the Image No. and Name. 
To change the bitmap image, delete the old image and use the above procedure to 
create a new image. 
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7. Reports 

7.1 The PLU and Message Reports 
These reports generate a list of the registered PLUs, messages, or other data in the database. 

The PLU report lists the PLU number, PLU description, and a number of additional PLU fields 
such as the price. Which additional PLU fields are printed can be configured when ScaleLink 
Pro is installed, but only as many parameters are printed as will fit on a single line. (The line 
length adjusts automatically based on the size of the printer paper.) Accordingly, if you wish to 
include more fields in the report, it is recommended that you set your printer to landscape 
mode. 

To set landscape mode, click Print Setup in the File menu to open a printer setup dialog. You 
must set the printer page size and orientation before opening the report window for the report 
size to adjust automatically. (Note, however, that not all printers support landscape printing.) 

The message reports list the message text only. 

The operation for each type of report is the same. The following describes the procedure in the 
case of the PLU report. 

1. If necessary, click Print Setup in the File menu to check the printer settings. 

2. Click PLU List in the Reports menu to open a PLU report window. 

 

 

 

3. Use the Select buttons to specify the range of PLUs to print, then click the Print 
button to start printing. 

4. When finished, click the Close button to close the PLU Report window. 
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Report Window Operations 

The following operations are available using the tool bar at the top of the PLU Report window. 

 

Operation Explanation 

Specify range 
of PLUs to 
print 

Use the Select buttons to specify the start and end PLU or message 
numbers for the report. 

 

View report 
on-screen 

Use the <<Prev Page and Next Page>> buttons to step through the report 
pages on-screen. 

If necessary, use the scroll bars to scroll sections of the report page into 
view. 

 

Preview 
printing 

Click Print Preview in the File menu. 

 

Start printing Click the Print button or click Print in the File menu. 

 

Export to text 
file 

Click the Export button to open a File Save As dialog to specify the file in 
which to save. Click OK to output the report contents to the text file. Each 
line of the report is output with the fields separated by commas. 
NOTE:  You can export the entire PLU database using the text file export 
function. (See Chapter 8 Importing and Exporting Data.) 

Full desc/ 
1st line only 

Click these buttons to switch between displaying the full PLU description 
text or the first line only. 

Show extra 
message text 

Select the Show Extra Message and/or Show Nutrition command in the 
Report menu to specify whether or not to include extra message and/or 
nutrition text in the report. The text appears after the PLU description. 
Note:  Show Nutrition is only available in Hong Kong. 

Show price 
zone data 

If price zones areenabled, select the Show Price Zone Data command in 
the Report menu to specify whether or not to include price zone values in 
the report. When turned on, this lists the value of price zone fields for each 
zone. When turned off, only the default vvalue is listed. 

Active or 
Inactive 
PLUs only 

Select the Show Active PLUs Only, Show Inactive PLUs Only, or Show 
Both Active and Inactive PLUs commands in the Report menu to select 
which PLUs to include in the report. 

Close window Click the Close button. 
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7.2 Production Reports 
The following production reports are available. 

• 

• 

• 

• 

• 

• 

PLU Production* 

Department and Group Production 

Daily and Weekly Totals* 

Operator Totals 

Operator Override Totals 

Hourly Totals 

* For Hong Kong, these include rewrap and next day totals. 

  
Operator totals and hourly totals are not available for some scales versions. If not 
available, the Operator Totals and/or Hourly Totals commands do not appear in the 
Reports menu. 
 

 

Accumulating Production Data Totals 
Before you can display any production reports, you must load the production data from the 
scales (click on Load Production Data from Scales in the Comms menu). 

The scales accumulate production data by PLU, by operator, and by hour. The totals on the 
scales are cleared each time they are read by ScaleLink Pro. 

In other words, the scales do not accumulate daily and weekly PLU totals. If you require 
accurate hourly, daily and weekly reporting, it is important that you load the production data 
from the scales on a regular basis (at least once a day, preferably). 

In this case, it is recommended that you use the Scheduler to automatically load the production 
data from the scales at preset intervals. 

Production Data Files 
The production data loaded from the scales is stored in a database. The database file name is 
the same name as the PLU database file, but the suffix "Prod": 

Example:  PLU database: Bakery.MDB ⇒ Production data database:  BakeryProd.MDB 
 

The following file operations are available: 

• 

• 

• 

• 

Production data is automatically deleted after a specified time. See Appendix A  Installing 
ScaleLink Pro at a New Store for details. 

You can clear the production data totals at any time via the Clear Production Totals on 
PC command in the Comms menu. 

Production data can be exported to a text file. The exported data can be imported into 
other software packages such as Excel for more sophisticated reporting. 

Production data totals can be adjusted from within ScaleLink Pro. See Adjusting 
Production Data Totals below. 
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Adjusting Production Data Totals 
A facility is provided to modify the received production data from within ScaleLink Pro. The 
procedure is as follows. 

1. Click Adjust PLU Production Data in the Comms menu. 

2. Click Select and select the PLU to modify. 

3. Select the date to modify. 

4. Each time you change the PLU or date selection, the lower half of the dialog updates 
with the production data from each scale for that PLU/date combination, including 
any existing user adjustments. 
Enter your adjustments in the Quantity, Weight, and Price fields, then click the 
Apply button to update the database. 
Your adjustments appear in the production data list in the row titled "User 
Adjustments". 

5. Repeat steps 2 to 4 for each PLU/date to be adjusted. 

 

 

The adjustments are treated as another scale in the production data reports and export 
functions. 
When exporting production data, adjustments appear as scale ID = 32767. 
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PLU Production Report 
The PLU production report lists the production totals (quantity, total weight, and total value) for 
each PLU. You can control the report content as follows. 

• 

• 

• 

• 

The range of PLUs to display based on PLU number and/or department+group code. 

The date range for the PLU totals 

Calculate totals for a specified scale (comms link) only or for all scales. 

Sort PLU totals by PLU number, quantity, weight, or value. 

The procedure for printing a PLU production report is as follows. 

1. If necessary, click Print Setup in the File menu to check the printer settings. 

2. Click PLU Production in the Reports menu to open a report setup dialog. 

3. Select the various options from the dialog, then click OK to open the report window. 
 

 

4. The operation of the report window is described below. If you wish to print the report, 
click the Print button. 

5. When finished, click the Close button to close the report window. 
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Report Window Operations 

The following operations are available using the tool bar at the top of the report window. 

Operation Explanation 

Specify range of 
PLUs to print 

Use the Select buttons to specify the start and end PLU numbers for the 
report. 

 

View report 
on-screen 

Use the <<Prev Page and Next Page>> buttons to step through the report 
pages on-screen. 

If necessary, use the scroll bars to scroll sections of the report page into 
view. 

 

Preview printing Click Print Preview in the File menu. 

 

Start printing Click the Print button or click Print in the File menu. 

 

Export to text 
file 

Click the Export button to open a File Save As dialog to specify the file in 
which to save. Click OK to output the report contents to the text file. Each 
line of the report is output with the fields separated by commas. 
NOTE:  You can also use the text file export function to export the raw 
totals data to a file. 

Close window Click the Close button. 
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Department and Group Production Report 
The Department and Group production report lists the production totals (quantity, total weight, 
and total value) for each department and group. You can control the report content as follows. 

• 

• 

• 

Select totals by department only or by department and group 

The date range for the totals 

Calculate totals for a specified scale (comms link) only or for all scales. 

The procedure for printing a Department and Group production report is as follows. 

1. If necessary, click Print Setup in the File menu to check the printer settings. 

2. Click Dept. and Group Production in the Reports menu to open a report setup 
dialog. 

3. Select the various options from the dialog, then click OK to open the report window. 
 

 

4. The operation of the report window is described below. If you wish to print the report, 
click the Print button. 

5. When finished, click the Close button to close the report window. 
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Report Window Operations 

The following operations are available using the tool bar at the top of the report window. 

Operation Explanation 

View report 
on-screen 

Use the <<Prev Page and Next Page>> buttons to step through the 
report pages on-screen. 

If necessary, use the scroll bars to scroll sections of the report page into 
view. 

 

Preview printing Click Print Preview in the File menu. 

 

Start printing Click the Print button or click Print in the File menu. 

 

Export to text 
file 

Click the Export button to open a File Save As dialog to specify the file in 
which to save. Click OK to output the report contents to the text file. Each 
line of the report is output with the fields separated by commas. 
NOTE:  You can also use the text file export function to export the raw 
totals data to a file. 

Close window Click the Close button. 
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Daily and Weekly Totals Reports 
The daily totals and weekly totals reports list the production totals (quantity, total weight, and 
total value) for a specified range of PLUs totaled by date (day or week). 

The following options are available for specifying the range of PLUs to total. 

• 

• 

• 

• 

List totals for a single PLU or a specified range of PLU numbers. 

List totals for all PLUs with a specified department* and group code. 

Calculate totals for a specified scale (comms link) only or for all scales. 

Specify the range of dates to list. 
* The "department code" means the department field in the PLU. This is not the same as the Departments function (an 
optional function that may not be used on your copy of ScaleLink Pro). 

The procedure for printing a daily or weekly report is as follows. 

1. If necessary, click Print Setup in the File menu to check the printer settings. 

2. Click Daily Totals or Weekly Totals in the Reports menu to open a report setup 
dialog. 

3. Select the various options from the dialog, then click OK to open the report window. 
 

 

4. The operation of the report window is the same as for the Department and Group 
production report described above. If you wish to print the report, click the Print 
button. 

5. When finished, click the Close button to close the report window. 
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Operator Totals and Operator Override Totals Reports 
The operator totals report lists the production totals (quantity, total weight, and total value) for 
each operator. The operator override report lists discounts and unit price overrides for each 
operator, but is only available on the AstraXT. Operators are identified by the operator number, 
but you can assign a name to each operator using the Operators function. 

The operation is the same for both reports. 

You can control the report content as follows. 

• 

• 

Specify the date range for calculating the operator totals. 

Calculate totals for a specified scale (comms link) only or for all scales. 

The procedure for printing an operator totals report is as follows. 

1. If necessary, click Print Setup in the File menu to check the printer settings. 

2. Click Operator Totals or Operator Totals (Overrides) in the Reports menu to open 
a report setup dialog. 

3. Select the various options from the dialog, then click OK to open the report window. 
 

 

4. The operation of the report window is the same as for the Department and Group 
production report described above. If you wish to print the report, click the Print 
button. 

5. When finished, click the Close button to close the report window. 
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Hourly Totals Report 
The hourly production report lists the production totals (quantity, total weight, and total value) 
by hour. You can control the report content as follows. 

• 

• 

Specify the date range for listing the hourly totals. 

List totals for a specified scale (comms link) only or for all scales. 

 The scales continue accumulating hourly data indefinitely until the totals are read by 
ScaleLink Pro and cleared. This means that you must load the production data from 
the scales at least once a day to get meaningful hourly totals. If not, the hourly totals 
will include production from previous days. 
The recommended method is to use the Scheduler to automatically load the 
production data from the scales at preset intervals. 

 

The procedure for printing an hourly production report is as follows. 

1. If necessary, click Print Setup in the File menu to check the printer settings. 

2. Click Hourly Totals in the Reports menu to open a report setup dialog. 

3. Select the various options from the dialog, then click OK to open the report window. 

 

 

4. The operation of the report window is the same as for the Department and Group 
production report described above. If you wish to print the report, click the Print 
button. 

5. When finished, click the Close button to close the report window. 
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7.3 SR-2000 alpha Image List Report 
This report lists the SR-2000 alpha images. These are the images used in the SR-2000 alpha 
preset key function and are defined using SR-2000 alpha Images in the Scales menu. 

To open the report window, select Reports -> EMZ/SR -> SR-2000 alpha Images. This opens 
a window listing all the images defined in the system. 

The operation is the same as for the other reports described above. That is, use the Next Page 
and Prev. Page buttons to scroll through the report and click the Print button if you want to 
output the report to a printer. Click the Close button to close the window when finished. 
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8. Importing and Exporting Data 

8.1 Text File Import 
ScaleLink Pro has a flexible text file import function to allow data to be imported from other 
systems. 

See Appendix B Text File Formats and Operations for a detailed explanation of the technical 
specifications of the standard text file format. 

 Special custom formats may also be added from time to time for specific customers. 
These are not covered by the ScaleLink Pro documentation. Contact your Ishida 
agent if you require details.  

Using Pre-Defined Text File Import Operations 
ScaleLink Pro has the ability to define standard text file import operations. This avoids the need 
to specify the import parameters each time you perform an import operation. 

See Setting Up Text File Import and Export in Appendix A.2 for details on defining standard text 
file import operations. 

The procedure for importing PLU and other scales data from a text file when standard text file 
import operations have been setup for your system is as follows. 

1. Click on Import from Text File in the Tools menu. 

2. A Select Text Import dialog opens listing the available import operations. Select the 
desired operation and click the Select button to start the import. 

3. Alternatively, if you wish to specify the import settings directly, click the Customize 
button. Subsequent operation is described below. 
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Specifying a Text File Import Operation Directly 
If you clicked the Customize button in the above procedure, or if no standard text file import 
operations have been setup for your system, you can specify the import settings directly. 

The procedure is as follows. 

1. Click on Import from Text File in the Tools menu. 

2. A File Open dialog appears for you to select the file to import. 

3. Next the Text File Import Settings dialog opens for you to set the various import 
options. 
Select the type of data to import, the format and the operation. 

See Appendix B Text File Formats and Operations for details of the file format. 

 

 
4. Click OK to start the import. 
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Text File Import Operation 
ScaleLink Pro reads the data from the specified text file and updates changes in the database. 
If Send to scales is specified (and the scales are connected), changes are also transmitted to 
the scales. 

 For update operations, records are only sent to the scales if the data is modified. 
Records are not sent to the scales if the data in the text file is the same as in the 
database. 

A price zone field can optionally be included for PLU and price change importing. The way the 
field is interpreted depends on how your copy of ScaleLink Pro is configured, as follows. 

 

 

 ScaleLink Pro Mode 

 Price Zones Disabled Local Store Mode Head Office Mode 

Price Zone 
Fields 

If price zone field = 0
Default values are 
updated 

If price zone field ≠ 0
Not updated 

If price zone field = 
Local price zone 
Price zone-specific 
values for local price 
zone are updated. 

If price zone field ≠ 
Local price zone 
Not updated 

 

Price zone-specific values 
for specified price zone are 
updated. 

Non-price 
Zone 
Fields 

If price zone field = 0
Default values are 
updated 

If price zone field ≠ 0
Not updated 

If price zone field = 
Local price zone 
Default values are 
updated. 

If price zone field ≠ 
Local price zone 
Not updated 

Default values are updated.

 

Use Bar Code Instead of PLU 

This option only applies to PLU, price change, and campaign PLU importing. It is ignored for 
other data. If selected, the PLU number field is assumed to contain a bar code (POS code). 
ScaleLink Pro searches its PLU database for a PLU with the same bar code and performs the 
PLU update or price change, etc. on that PLU. 

Auto-Assign PLU Number by Department 

This option only applies to PLU importing. It is ignored for other data. If selected, the PLU 
number field is ignored. Instead, ScaleLink Pro searches its PLU database for a PLU with the 
same bar code (POS code) as specified in the text file and updates that PLU. If no matching bar 
code is found (or if the text data does not contain a bar code field), the data is treated as a new 
PLU and a PLU number is assigned automatically based on the department. That is, the first 
unused PLU number in the range specified for the department is assigned (see Setting Up 
Departments in Appendix A.2 Setting Up ScaleLink Pro). If all PLU numbers in the specified 
range are already used, the first unused PLU number in the entire PLU number range is 
assigned and an error message displayed. 
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8.2 Text File Export 
ScaleLink Pro can output PLU and other scales data to a text file. This is useful if you wish to 
transfer data to another software package such as Excel. 

Text File Format 
ScaleLink Pro provides two standard text file formats (comma-delimited and TAB-delimited). In 
both cases, all data from the specified database table is output one line per record with fields 
delimited by either comma or TAB characters. 

An option is also provided to output a line containing the field names ("column titles") as the first 
line of the text file. These are useful for identifying the meaning of each column when the text 
file in imported into Excel, for example. 
Column titles are also used by the text file import function to identify the order in which fields 
appear in the text file. 

 Special custom formats may also be added from time to time for specific customers. 
These are not covered by the ScaleLink Pro documentation. Contact your Ishida 
agent if you require details.  

Using Pre-Defined Text File Export Operations 
ScaleLink Pro has the ability to define standard text file export operations. This avoids the need 
to specify the export parameters each time you perform an export operation. 

See Setting Up Text File Import and Export in Appendix A.2 for details on defining standard text 
file export operations. 

The procedure for exporting PLU and other scales data to a text file when standard text file 
import operations have been setup for your system is as follows. 

1. Click on Export to Text File in the Tools menu. 

2. A Select Text Export dialog opens listing the available export operations. Select the 
desired operation and click the Select button to start the export. 

3. Alternatively, if you wish to specify the export settings directly, click the Customize 
button. Subsequent operation is described below. 
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Specifying a Text File Export Operation Directly 
If you clicked the Customize button in the above procedure, or if no standard text file export 
operations have been setup for your system, you can specify the export settings directly. 

The procedure is as follows. 

1. Click on Export from Text File in the Tools menu. 

2. A File Save As dialog appears for you to select the output text file. 

3. Next the Text File Export Settings dialog opens for you to set the various export 
options. 
Select the type of data to export, the file format, and whether to include a line of 
column titles. The Specify Fields button lets you select which fields you want to 
export and also to specify the sequence of fields in the output file (PLU export only).

(See Appendix B Text File Formats and Operations for details of the export format.) 
 

 
4. Click OK to start the export. 
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8.3 Database Import 
ScaleLink Pro can import data from external databases using ODBC. 

However, the database schema must use the table and column names expected by ScaleLink 
Pro. Contact your Ishida agent for details. 

A feature of the database data format is that formatted text (PLU description and extra 
message text, etc.) is stored with each line's text and font information in separate fields. 
(ScaleLink Pro database files store the text using the proprietary Ishida format.) 

Using Pre-Defined Database Import Operations 
ScaleLink Pro has the ability to define standard database import operations. This avoids the 
need to specify the import parameters each time you perform an import operation. 

The procedure for importing PLU and other scales data from an external database when 
standard database import operations have been setup for your system is as follows. 

1. Click on Import from Database in the Tools menu. 

2. A Select Database Import dialog opens listing the available import operations. 
Select the desired operation and click the Select button to start the import. 

3. Alternatively, if you wish to specify the import settings directly, click the Customize 
button. Subsequent operation is described below. 

Specifying a Database Import Operation Directly 
If you clicked the Customize button in the above procedure, or if no standard database import 
operations have been setup for your system, you can specify the import settings directly. 

The procedure is as follows. 

1. Click on Import from Database in the Tools menu. 

2. A Database Import Settings dialog appears for you to set the import parameters, as 
shown on the next page. 

3. Select either an ODBC data source or a Microsoft Access (*.MDB) database file. 
If importing from an ODBC data source, enter the connection string. Leaving this 
field blank opens a dialog for you to select the data source. 

4. In the lower half of the dialog, select the type of data to import (more than one type 
can be selected) and whether to send the data to the scales. 

5. Click OK when ready to start the import. 
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Import Operation and Price Zones 
The import operation loads the data from the external database and updates the current 
ScaleLink Pro database. New records are added and existing records are overwritten. 

The PLU and price change tables include a price zone field. The way the field is interpreted 
depends on how your copy of ScaleLink Pro is configured, as follows. 

 

 ScaleLink Pro Mode 

 Price Zones Disabled Local Store Mode Head Office Mode 

Price Zone 
Fields 

If price zone field = 0
Default values are 
updated 

If price zone field ≠ 0
Not updated 

If price zone field = 
Local price zone 
Price zone-specific 
values for local price 
zone are updated. 

If price zone field ≠ 
Local price zone 
Not updated 

 

Price zone-specific values 
for specified price zone are 
updated. 

Non-price 
Zone 
Fields 

If price zone field = 0
Default values are 
updated 

If price zone field ≠ 0
Not updated 

If price zone field = 
Local price zone 
Default values are 
updated. 

If price zone field ≠ 
Local price zone 
Not updated 

Default values are updated.
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8.4 Loading PLUs and Other Data from the Scales 
If you are using the on-line (ID-ENQ) communications link, you can load PLU and other scale 
data from a scale. Note, however, that available data differs depending on the scale model. 

Procedure for Loading Data from the Scales (ID-ENQ) 
This loads PLU data only from the scales. 

1. Start ScaleLink Pro. If necessary, select New Database from the File menu to 
create a new empty database. 

2. Select Transmit/Receive Scale Data from the Comms menu to open the 
Communication Center dialog. This dialog provides operations for sending and 
receiving scale data. 

3. In the Communication Center dialog, select the scale to receive from and the type o 
data to receive, then click the Receive from Scale button. 

4. The progress of the data transfer is displayed in the status bar at the bottom of the 
dialog. If successful, the received data is updated in the ScaleLink Pro database. 

 

90 



9. Advanced Features and Utilities 

9.1 Event Logging 

9.1.1 Event Log 
ScaleLink Pro can generate an event log recording changes to the database and other 
significant operations. This can help you work out what happened in the event of problems. 

You can view the log by clicking View Log in the Tools menu. 

Whether to generate an event log and related settings are specified as part of the general setup. 
(See Appendix A  Installing ScaleLink Pro at a New Store for details.) 

Viewing the Log 

A number of different log display options appear under the View Log sub-menu in the Tools 
menu. 

Selecting Customize... opens the following dialog for you to specify the range of the event log 
to display. 

 

 

Select the type of events to display in the top half of the dialog, and specify the date range in the 
bottom half of the dialog. 

Clicking OK outputs the selected data to a temporary text file and opens Notepad to view the 
file contents. 
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9.1.2 PLU Update and Exception Log 
In addition to the general event log described above, two special logs are provided to record 
changes to PLU data (the PLU Update Log) and PLUs that are not successfully sent to a 
particular scale (PLU Exception Log). The file names and length of time that log entries are kept 
in the files are specified as part of the general setup. (See Appendix A  Installing ScaleLink Pro 
at a New Store for details.) 

For the PLU Exception Log, note that PLUs are not logged as unsent until you exit ScaleLink 
Pro. This is because ScaleLink Pro automatically attempts to resend data to off-line scales, so 
a PLU record is not considered to be unsent until automatic resending is abandoned (when you 
exit ScaleLink Pro). 

Both the PLU Update Log and PLU Exception Log record PLU operations performed by the 
Scheduler as well as by the main ScaleLink Pro program. 

No menu command is provided to view these log files. Instead, simply open the files in 
Windows Notepad or some other text editing or viewing program. 

9.1.3 Scale Status Log 
If enabled in the setup (See Custom Log Settings in Appendix A), this outputs the current status 
of each scale to a text file when logging is invoked. Loging can either be invoked manually by 
selecting Update Scale Status Log from the Tools menu or by clicking the icon in the toolbar. 
Alternatively, the scheduler can be used to invoke logging at periodic intervals. 

This log is typically generated automatically using the scheduler and used as a quick way for 
the network administrator to check the current scale status without needing to start up the 
Scalelink Pro application. 

A function is also available in the scheduler to e-mail the results of the scale status report to 
designated e-mail addreses. The addreses and other e-mail settings are specified by selecting 
e-Mail Settings from the Tools menu. The e-mail function is not available in all countries. 
Contact your Ishida agent for details. 

9.1.4 Text File Import Logs 
These logs store details of PLU text import operations. The content includes a summary of 
import operations performed, details of what data was updated in each PLU record, and details 
any errors (such as off-line scales) that occurred when sending the updated data to the scales. 

The logs are provided for specific customers and the operation may vary depending on how 
your copy of Scalelink Pro is configured. Contact your Ishida agent if you require a similar 
logging function for your site. 

9.1.5 Communication Log 
A separate communications log function is also provided. This logs all traffic on the 
communication links and can be used to analyze any communication-related problems. 
Separate logs can be created for each communication link. The maximum log file size can be 
specified to prevent these files from becoming too large. In this case old data is deleted from 
the beginning of the log files each time ScaleLink Pro starts. (See Setting Up ID-ENQ 
Communications in Appendix A  Installing ScaleLink Pro at a New Store for details.) 
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9.2 Departments 
The departments feature is useful in stores where you wish to manage the PLU and other scale 
data separately for each department. 

 This Department feature is not the same as the department and group code used in 
the PLU data. 
  

The feature works by storing the information for each department in a separate database. 

The currently selected department is shown in the title bar of the PLU Search and Edit windows. 
All ScaleLink Pro operations including editing and displaying data only apply to that department. 
Similarly, data is only sent to or received from the department's designated master scale. 

To change the selected department, click Change Department from the File menu and select 
the department from the displayed list. 

See Appendix A  Installing ScaleLink Pro at a New Store for details on how to define the 
departments for your store. 

 The Departments feature is optional. Also, the user access function gives the system 
administrator the option of restricting a user's access to a designated department 
only. 
The Change Department command does not appear in the File menu if your copy of 
ScaleLink Pro is not configured for departments or if your user settings restrict you to 
a single department only. 
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9.3 PLU Range Profile 
The PLU range profile function is used to restrict which PLUs are visible in ScaleLink Pro. It is 
intended for multi-store operation where the same master file (PLU database) is used for all 
stores, but where not all stores carry the same products. 

The PLU range profile function specifies ranges of PLU numbers to exclude from all ScaleLink 
Pro screens and operations. In this way, ScaleLink Pro can be made to only show those PLUs 
that are actually used in the store, making searching for PLUs easier. 

The PLU range profile is stored in a separate file (extension *.PRF), allowing a different profile 
to be used for each copy of ScaleLink Pro. 

Also, a PLU profile file can be specified in your the user access settings. 

Operation 

Once the profile is loaded, no special operation is required. ScaleLink Pro functions as normal 
except that PLUs in the restricted range are no longer visible. Similarly, you cannot add a new 
PLU with a number in the restricted range. (This also applies to PLUs loaded from a text file, 
Data Save/IF21FD file, or directly from the scales. In this case, a message appears to notify 
you if PLUs have not been imported because they are excluded by the PLU range profile.) 

The following table lists the operations for administering the PLU range profile. 

 

Operation Explanation 

Setting the PLU 
range profile 

Click PLU Range Profile in the Setup menu to open a dialog to edit the 
PLU profile. The dialog allows you to add, edit, or delete ranges of PLU 
numbers. PLU numbers in the specified ranges are excluded from all 
ScaleLink Pro screens and operations. 
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9.4 PLU Active/Inactive 
This feature allows you to mark selected PLUs as inactive. This means the PLU is deleted from 
the scale, but remains in the database and appears on ScaleLink Pro screens. 

Inactive PLUs appear red in the PLU Search window. 

If this feature is enabled, the following methods are available to set the PLU active/inactive 
status. 

• 

• 

In the PLU Search window 
Select the PLU in the list, then click the Active/Inactive button in the toolbar. 

In the PLU Edit window 
Set the active/inactive status using the radio buttons at the top right of the PLU Edit 
window. 
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9.5 Batch Mode 
Batch mode is used to make changes to the PLU and other scales data without updating the 
database and without sending the changes to the scales. Instead, the changes are stored in a 
batch file that can be loaded at a latter time. 

This allows you to enter changes in advance, then load all the changes at once. 

Another use for the batch mode feature is in a multi-store environment. You can use batch 
mode to make changes to a central database then distribute the resulting batch file to each 
store where it can be used to update the store's own copy of the database. To provide flexibility, 
the batch file load function allows the local store user to select which changes to load. 

The key features of batch mode are: 

• 

• 

• 

• 

• 

• 

• 

Changes made during batch mode do not update the database or scales. 

Changes are saved in a batch file that can be loaded at a latter time. 

All changes made during batch mode disappear when you exit batch mode (the database 
returns to the state when batch mode started) 

When loading a batch file, you can view the changes beforehand and exclude changes 
you do not wish to update. 

You can use the Scheduler to automatically load a batch file at a preset time. 

Batch mode changes made to one database can be loaded into a different database. 
(Useful for distributing updates in a multi-store environment.) 

A single batch file can contain changes for more than one department. 

 

Using Batch Mode 
The procedure for using batch mode is as follows 

1. Select Start Batch Mode from the Tools menu. 

2. Specify the name of the batch file in the Save As dialog. If you specify an existing file, 
ScaleLink Pro asks you whether to delete any existing data in the file. 

3. Edit PLU or other scales data. Any operation that updates the database will be 
stored in the batch file instead. 

4. When you have entered all the desired changes, select End Batch Mode from the 
Tools menu. 
This restores the database to the state when you started batch mode. 

Batch Mode and Departments 
If your copy of ScaleLink Pro is configured for multiple departments, you can save batch 
changes for more than one department in the same batch file. Just use Change Department in 
the File menu to switch between departments as usual. 

If loading the batch file into a different system, data for a particular department is only loaded if 
the destination system contains a department with the same name. (Names are not case 
sensitive.) 
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Loading a Batch File 
The procedure for loading a batch file is as follows 

1. Select Load Batch File from the Tools menu. 

2. A dialog opens to select the batch file to load. 
Also, use the check boxes at the bottom of the dialog to specify whether to view the 
file contents before loading and whether to send the data to the scales. 

3. If you selected View File Contents, a dialog opens listing all the changes in the 
batch file. 
The dialog content depends on how your system is configured 

Multiple Departments 
If the batch file contains changes for more than one department, the dialog lists the 
departments contained in the file. Use the Include and Exclude buttons to specify 
whether or not to load the data for each department. Use View Records to display 
the dialog (shown below) for viewing the individual records in the batch file. 

Single Department 
If your system is not configured for departments or the batch file only contains data 
for a single department, the dialog shown below appears immediately. 

Select records in the list and use the Include and Exclude buttons to specify 
whether or not to load each record. 
Click OK when finished. 

 

 

4. The selected changes in the batch file are loaded into the database and (optionally) 
sent to the scales. 
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9.6 Price Zones 
Price zones are intended for use in a multi-store environment. The price zone feature allows 
different values to be set for specific data fields in each PLU. Typically, this is used to set 
different prices for different groups of stores (hence the name "price zones"). However, the 
price zone feature can be used to set store-specific values for most PLU data fields (the main 
exception is the PLU description). 

Which PLU fields can have price zone-specific values is defined as part of the setup. (See 
Appendix A  Installing ScaleLink Pro at a New Store for details.) 

The setup also defines the price zone names and the operation mode. Three different price 
zone operation modes are available: 

 Mode Explanation 

Disabled Turns off the price zone feature. Any price zone data in the database is 
ignored and all operations use the default data. 

Local Store The price zone for the store is specified in the setup. 
ScaleLink Pro operation is the same as when the price zone feature is 
disabled except that the data for the specified price zone is displayed 
instead of the default data. 
Any changes made to price zone fields in local store mode are set as 
price zone-specific data. 

Head Office The operation of the PLU Edit window changes as shown below to allow 
you to edit the data for all price zones: 

 

Select price zone to display 
and edit.  

Right click mouse 
on price zone field 
to list the field 
values for each 
price zone. 
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9.7 User Access Control 
The ScaleLink Pro system administrator can setup a list of authorized users. In this case, a 
logon dialog opens when you start ScaleLink Pro asking you to specify your user name and 
password. 

The ScaleLink Pro menus only display those commands that are permitted in your user setup. 

In addition to specifying which functions you can use, your user setup may also specify the 
database or department and the PLU profile for your ScaleLink Pro session. 
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9.8 Scheduler 
The scheduler is used to automatically execute specified operations at a specified time. 

You cannot start the scheduler from within ScaleLink Pro. Instead, a separate Scheduler icon 
appears in the ScaleLink Pro sub-menu of the Windows Start menu. 
 

If you wish to run the Scheduler at the same time as the main ScaleLink Pro program, you must 
set the Multi-user database access (MDB only) check box ON in the Options dialog (see 
Multi-User Installation in Appendix A.1 Setting Up ScaleLink Pro at a New Store). 
If the setting is OFF, an error occurs if the Scheduler tries to perform an operation for a 
database that is already open in the main program. 

Starting the Scheduler Program 
Click the Scheduler icon in the ScaleLink Pro sub-menu of the Windows Start menu. 
This opens the main scheduler window shown below. 

The Scheduler automatically opens the schedule file from the previous time the Scheduler was 
run. Use the Open command in the File menu if you wish to open a different schedule file. 

The schedule file stores the list of scheduled operations displayed in the main window. 
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You can also start the scheduler from the command line. The command line parameters are as 
follows: 
 Slp3 -S -R -I -U"User name" -P"Password" <file name> 

Where: 
 -S: Specifies the scheduler (instead of the normal ScaleLink Pro). (Required) 
 -R: Starts the scheduler running immediately. (Optional) 
 -I: Starts the scheduler iconized. (Optional) 
    <file name>: Specifies the schedule file. (Optional) If omitted, the schedule file from the 

previous Scheduler session is used. 
 
If using user access control, specify the user name and password in the command line 
parameters -U"User Name" and -P"Password". 

Running the Scheduler 
Click the Start Scheduler button in the scheduler main window to start the scheduler. The 
scheduler remains idle until the first scheduled operation becomes due. 

The scheduler performs the following steps each time an operation becomes due for execution: 

• 
• 
• 
• 
• 

Delete the error file (if specified). 
Load the database specified in the operation settings. 
Execute the specified operation. 
Write any error messages to the error file (if specified). 
Close the database. 

Error Handling 
The scheduler does not display a message on the screen if an error occurs in a scheduled 
operation. This is for the simple reason that the scheduler is intended to be run unattended, so 
it makes no sense to display a message box and wait for the user to click OK. 

Instead, you can specify that error information be written to an error log or passed to an 
external program. The error log is only created or added to if an error occurred. Accordingly, if 
you delete any old error log file before starting the Scheduler, you can use the fact that an error 
log exists as an indication that some sort of error occurred. 

To execute an external program whenever an error occurs, create your own error handling 
program called ReportError and place in the same directory as the ScaleLink Pro executable 
files. When an error occurs, the Scheduler runs ReportError with the error message specified 
in the command line enclosed in quote marks. For example: 
  ReportError "This is an error message" 

 Scheduler operations are recorded in the ScaleLink Pro event log in the same way as 
user operations. 
 

If an error occurs for an operation, the operation status (the left hand column of the scheduler 
window) is set to "Error". The scheduler does not attempt to execute the error operation again. 
However, if the operation is setup to repeat execution at preset intervals, the scheduler does try 
to execute the operation when it is next due, even if the current status is "Error". 

 

Off-Line Operation 
If a scheduler operation is executed when one or more scales are out of service for some 
reason, the operation is executed as usual and the database is updated. However, the 
scheduler can save the data that would have been sent to the off-line scale and automatically 
sends this data when the scale comes back on-line. Note, however, that automatic resending 
can be disabled by the "Disable auto-resend of unsent data when scale off-line" setting in 
the Options dialog. 

However, the scheduler only checks off-line scales and performs re-sending while the 
scheduler is running. 
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Setting up Scheduler Operations 
Use the Add Operation, Edit Operation, and Delete Operation buttons in the scheduler 
window to setup the scheduler operations. Clicking the Add Operation or Edit Operation 
button opens a scheduler operation edit dialog. 

 

 

The meaning of each item in the dialog is as follows: 

Item Explanation 

Name The name specified here appears in the Operation column in the main 
scheduler window. 

Enable? Set this check box OFF to prevent the operation from being executed when 
due. 

Reset Status The current status of the operation is displayed to the left of this button. Click 
the Reset Status button to set the status of a completed operation back to 
"Waiting" or to clear an error. 

Operation Specify the type of operation to execute. If applicable, a dialog may open to 
setup the selected operation. Changing the operation type deletes any 
existing operation settings. 

Operation 
Settings 

Open a dialog to setup the selected operation. The contents of the dialog 
differ depending on the type of operation selected. 

Database/ 
Department 

Select the database to update for the operation. 

 Specify database file: Specify the database file directly. 

 Specify department: Use the database for the specified department. 
* This option is only available if departments are setup for your copy 
of ScaleLink Pro. 
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Item Explanation 

Execute at Specify the date and time for executing the operation. 

Repeat?/ 
Repeat interval 

Specify whether to execute the operation again after the specified interval. 

Between .. 
and ... 

You can set a time range so that repeat execution of the operation only 
occurs between specified times. 

Log errors in 
file? 

Set this check box ON to log any errors that occur when an operation 
executes. 
See the Error Handling section above for details. 
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9.9 Sale Wizard 
This feature simplifies the process of creating a sale (temporary price changes). The concept is 
similar to the Campaign function. That is, a sale price can be entered for specified PLUs and 
automatically sent to the scale at a predetermined date and time. Similarly, the old prices are 
automatically restored at the end of the sale. Multiple Sale Wizards can be set up and 
scheduled to run at different times. 

The difference with the campaign feature is that, in this case, the price changes and timings are 
controlled either manually or by tasks sent to the Windows Task Scheduler, rather than by the 
scale itself. Also, there is no limit on the number of PLUs that can be included in the sale. 

What the Sale Wizard Does 
The Sale Wizard provides a simple user interface for generating the following: 

• 

• 

A Windows Scheduler task for loading the sale prices 

A Windows Scheduler task for restoring the old prices 

Using the Sale Wizard 
 

1. Select Sale Wizard from the Tools menu, and a dialog like the one shown below will 
appear: 

 
 

The procedure for using the Sale Wizard is as follows: 

 

2. A selection list appears like the one below, listing all of the sale wizards that have 
previously been set up. Select whether to Add a new sale wizard, or Edit or Delete 
an existing sale wizard. Other options are: Start Sale Now, End Sale Now, Refresh 
List and Import Sales. 

  Add:  Adds a new Sale Wizard to the list. See below. 

  Edit:  Edits an existing Sale Wizard. See below. 

  Delete:  Deletes an existing Sale Wizard. 

  Start Sale Now:  Starts the selected sale regardless of its preset Start Date/Time. 

104 



This will change appropriate PLU prices in the database to the sale price, send the 
sale price to the scales and delete the task scheduler event that was created to start 
the sale, if one was created. 

  End Sale Now:  Ends the selected sale regardless of its preset End Date/Time. 
This will change appropriate PLU prices in the database back to their original value, 
send the original value to the scales and delete the task scheduler event that was 
created to end the sale, if one was created. 

  Refresh List:  Refreshes the list of Sale Wizards to reflect any change in status, eg. 
if a task has been started or ended by the Windows Task Scheduler. 

  Import Sales:  You can import sales files which have been created outside 
ScaleLink Pro.  See Appendix 2 for details on the sale file format. 

3. Clicking on Add or Edit will bring up the Sale Wizard configuration dialog described 
below. On the first screen you can select a name for the sale. 
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4.  

 

 

 

 

 

 

Enter the sale price changes. 

If you selected Add, the Sale Wizard immediately prompts you to start entering price 
changes. 

If you selected Edit, the Sale Wizard displays the price changes from the existing 
sale. 

Use the buttons on the right of the window to add, edit, or delete price changes in the 
sale. 

 If you are using the price zone feature in head office mode, you can specify 
different prices for each zone. 

 

 

 

4. Click Next when finished entering price changes 
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5. The Sale Wizard now asks you whether you wish to create Windows Task Scheduler 
tasks to automatically load the price changes at the specified times. 

If so, check the Create Scheduler Tasks button and enter the times to start and end 
the sale. 

To bypass schedule creation, just click the Finish button. 

 

 
6. Click Finish when finished entering schedule details. 

7. The sale wizard creates a Sale Wizard entry in the selection list, and creates a 
Windows Task Scheduler task if specified . 

 

8. The price changes will be executed automatically at the specified time by the 
Windows Task Scheduler. These tasks should not be altered directly through the 
Task Scheduler. Use the Sale Wizard to modify them instead. 
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An icon appears in the PLU edit window, as shown below, if the PLU is assigned to a 
 

sale. Click on the item to edit the sale settings directly. 
The same icon also appears if the PLU is assigned to a campaign. 
However, the icon does not appear if the sale or campaign has already finished. 

 

  

n 
 

 

 

Sale ico
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9.10 Automation 
ScaleLink Pro supports ActiveX automation (also known as OLE automation). This allows 
ScaleLink Pro operations to be controlled by external programs, including programs written in 
scripting languages such as Visual Basic and Java script. 

Example script files are available. Contact your Ishida dealer for details. 

Supported Features 
Appendix C gives a full list of the methods and properties available to external users. However, 
new features will be added in the future based on user requirements. If a feature you require 
does not appear to be currently supported, please contact your Ishida agent. 

The currently supported features are as follows: 

• Text file import/export 

• Read production data from scales 

• Send data to scales 

• Resend unsent data (when data is not sent due to a scale being off-line, for example) 

• Execute Scheduler operations 

Due to the internal structure of ScaleLink Pro, automation is executed using a 
 

separate executable file. This is to prevent any conflicts if a copy of ScaleLink Pro is 
already running. 
See Appendix C for details. 
 

 

Setup File 
When invoked via automation, ScaleLink Pro reads its setup files from the directory in which 
the ScaleLink Pro executable files are located (the installation directory). Ensure that the 
correct setup files are located in this directory. If you wish to use a different setup file for 
automation operations, call the LoadSetup( ) and LoadSiteSetup( ) methods before opening a 
database. 

Handling of Unsent Data 
Any data that could not be sent to a scale due to the scale being off-line is saved and 
automatically resent the next time automation is used to open the same database. 

This is not the same function as automatic resend from the main ScaleLink Pro application. 
That is, any unsent data remaining from an automation operation is not resent automatically by 
the main ScaleLink Pro application. Similarly, unsent data the main ScaleLink Pro application is 
not resent when ScaleLink Pro is run using automation. 

Instead, ScaleLink Pro attempts to resend any unsent data remaining from an automation 
operation the next time automation is used to send data to the scales. You can also use the 
IsUnsentDataWaiting( ) and SendUnsentData( ) methods to explicitly check for and resend 
unsent automation data. 

Unsent data remaining from automation operations is linked to the database file. Accordingly, 
the database must be open before the unsent data can be resent. 

The unsent data is stored in the file <Database file name>.usd. To clear unsent data, just delete 
this file (see the example in Program Structure 2 below). However, do not delete the file while 
the corresponding database is open. 
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Program Structure 1 - Executing Scheduler Operations 
A simple method of using automation is to use the Scheduler to predefine the operations you 
wish to execute from an external program. 

In this case, the external program must have the following structure. 

1. Open schedule file (Use ScheduleOpen(schedule file name).) 

2. Execute schedule operations (Use ScheduleExecOp(schedule operation name).) 

3. Close schedule file (Use ScheduleClose().) 

The figure below shows an example Windows script that opens a schedule file 
C:\ScaleLinkPro\Sample.SCH that contains an operation called Read Prod Data. The script 
executes the operation then closes the schedule file and terminates. 

 
' Windows Script - Execute Scheduler Operation Sample 
 
' Declare ScaleLink Pro object 
Dim ScaleLinkPro 
Set ScaleLinkPro = WScript.CreateObject("Slp3.Document") 
 
' Open schedule file 
Result = ScaleLinkPro.ScheduleOpen (“C:\ScaleLinkPro\Sample.SCH”) 
if Result = False then 
  MsgBox "Error Opening schedule", vbInformation 
  WScript.Quit 
end if 
 
' Execute operation 
Result = ScaleLinkPro.ScheduleExecOp ("Read Prod Data") 
if Result = False then 
  MsgBox "Error executing Read Prod Data", vbInformation 
end if 
 
' Close schedule file 
ScaleLinkPro.ScheduleClose () 
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Program Structure 2 - Executing Operations Directly 
Operations can also be executed directly, independently of any schedule file 

In this case, the external program must have the following structure. 

1. Open database file (Use DatabaseOpen(database file name).) 

2. Execute operations (Use the various operation methods provided.) 

3. Close database file (Use DatabaseClose().) 

The figure below shows an example Windows script that opens a database file 
C:\ScaleLinkPro\Bakery.MDB and imports PLU data from a text file. After executing the 
operation, the script closes the database file then deletes any unsent data. 

 
' Windows Script - Execute Text Import Operation Sample 
 
' Declare constants used by ImportTextFileEx 
Const slpCommaDelim = 0 
Const slpTabDelim = 1 
Const slpAdd = 0 
Const slpUpdate = 1 
Const slpDelete = 2 
Const slpDescIshida = 0 
Const slpDescLineByLine = 0 
Const slpPluTable = 2 
Const slpScrollMsgTable = 3 
Const slpExMsgTable = 4 
Const slpCouponTable = 8 
Const slpNutritionTable = 9 
 
' Declare ScaleLink Pro object 
Dim ScaleLinkPro 
Set ScaleLinkPro = WScript.CreateObject("Slp3.Document") 
 
' Open database file 
Result = ScaleLinkPro.DatabaseOpen (“C:\ScaleLinkPro\Bakery.MDB”) 
if Result = False then 
  MsgBox "Error Opening database", vbInformation 
  WScript.Quit 
end if 
 
' Execute operation - Import text file and send to scales 
Result = ScaleLinkPro.ImportTextFileEx("C:\ScaleLinkPro\Plus.txt", 
slpCommaDelim, slpAdd, slpPluTable, slpDescIshida, True, False, False, 
False) 
if Result = False then 
  MsgBox "Error importing text file", vbInformation 
end if 
 
' Close database 
ScaleLinkPro.DatabaseClose () 
 
' We do not want to save unsent data - so delete unsent data file 
Dim fso 
Set fso = CreateObject("Scripting.FileSystemObject") 
fso.DeleteFile(“C:\ScaleLinkPro\Bakery.MDB.usd”) 
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Appendix A  Installing ScaleLink Pro at a New Store 
This section describes how to install ScaleLink Pro, how to set it up to suit your scales system, 
and how to obtain the initial PLU data. 

A.1 Installing the Software 
This section describes how to install ScaleLink Pro. 

System Requirements 
ScaleLink Pro requires a Windows 98 or higher personal computer. 

The software can also be used on Windows 95 in most cases. 

Operation on Windows XP has been verified for Scalelink Pro version 3.2. 

Installing ScaleLink Pro 
1. ScaleLink Pro may need to install some Windows system files that may also be in use by 

other programs. If you have problems installing ScaleLink Pro, try closing all currently 
running programs, including background programs such as virus checkers, before 
starting the installation. In the latter case, run a virus check on the installation disk before 
installing and again on your entire system after installing. 

2. Click the Start Button, select Settings, and then Control Panel. 

3. Double click on Add/Remove Programs, then follow the instructions that appear on the 
screen. 

4. To run ScaleLink Pro, click the Start Button, select Programs, Ishida, and then ScaleLink 
Pro.  

5. See A.2 Setting Up ScaleLink Pro and follow the procedures described to setup the 
system for this store. 

For a quick summary of how to use ScaleLink Pro once it has been correctly setup, see 2. 
Getting Started. 

Full details on how to operate ScaleLink Pro are available using on-line help (select Index from 
the Help menu). 

Uninstalling ScaleLink Pro 
1. Click the Start Button, select Settings, and then Control Panel. 

2. Double click on Add/Remove Programs, then follow the instructions that appear on the 
screen. 
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Multi-User Installation 
The following describes how to use ScaleLink Pro in a multi-user environment. 

ScaleLink Pro is not designed as a full multi-user program. However, you can install multiple 
copies of ScaleLink Pro on client PCs connected to a network and share a common database 
located on a server. 

Note that some restrictions apply when more than one user attempts to use the PLU database 
at the same time. Specifically, PLD format databases cannot be open by more than one user at 
a time. Also, additions and deletions made by one user to an MDB format database are not 
updated automatically on other users' screens. 

Note that the ScaleLink Pro Scheduler program is treated as a separate user. If you wish to run 
the Scheduler at the same time as the main program, you must setup ScaleLink Pro for 
multi-user access, as described below. 

The procedure is as follows. 

1. Install a separate copy of ScaleLink Pro on each client PC. Use the same folder 
name on each PC. 

2. Use one of the installed copies to create the common PLU database on the server. 

3. On one of the client PCs, setup ScaleLink Pro with appropriate settings for your store 
using the procedure described in Appendix A.2 Setting Up ScaleLink Pro. 

4. Set the Multi-user database access (MDB only) check box ON in the Options 
dialog. 

5. Copy the setup file (SETUP.DEF) to the installation folder on each client PC. (Also 
make a backup copy on the server.) 

6. Make any client-specific changes to the setup (e.g. setup users for each client) at 
each client. 
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A.2 Setting Up ScaleLink Pro 

Which Communications Link? 
ScaleLink Pro can communicate with the scales by a variety of methods. The available 
methods are as follows. 

 

ID-ENQ: ID-ENQ communications requires a master scale control unit (MSCU) or a 
scale fitted with special communications hardware (a “master board”). The 
main features are: 

• Connects to the scales via the serial port on the PC (RS232C) or via the 
LAN (TCP/IP). 

• Changes made on ScaleLink Pro can be sent to the scales immediately, 
even if the scales are in use. 

• Operation is fully automatic. 

 

Data Save 
and 
Astra/Astra
XT Serial 
Comms 

These communication functions are primarily provided on the scales as a 
means of data backup and restore. The main features are: 

• The data transfer operation saves or restores a complete set of scale data 
at a time. The backed up data can be stored on the PC and modified by 
ScaleLink Pro. 

• Available on all AC-3000 series scales (Data Save) and Astra/AstraXT 
scales. 

• Communication is via the serial port on the PC. The AC-3000 Data Save 
function requires a special adapter (RS-232C to RS-485 converter). 

• Data transfer is initiated manually: using the menu in ScaleLink Pro and 
using Test Mode (AC-3000) or Registration Mode (Astra/AstraXT) on the 
scales. 

 

IF21FD: If you have an Ishida IF21FD backup unit, it is also possible to use ScaleLink 
Pro without a communications link to the scales. 
In this case, you use the IF21FD unit to copy data between the scale and a 
floppy disk and use the Import IF21FD and Export IF21FD commands in 
ScaleLink Pro’s File menu to read and write data on the floppy disk. 

 

Before setting up ScaleLink Pro, you must have decided which system you are going to use 
(you can use more than one method) and have installed the appropriate cabling. Consult with 
your Ishida agent for further information. 
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Networks Containing More Than One Type of Scale 
ScaleLink Pro can support scale networks that contain more than one type of scale. Three 
generations of scale are supported by ScaleLink Pro: the AC-2000 series, AC-3000 series, and 
AstraXT. Each generation supports a different set of functions. There are also some 
differences between models within each generation, but these are generally small. 

The System Type setting in the General #1 page of the Options dialog (described in Setting 
Up the ScaleLink Pro Software below) specifies the default set of supported functions. For 
example, if [AC-3000] is selected, AstraXT functions such as extra messages #2 and #3 are 
hidden. 
Take note of the following points when setting this parameter. 

• If mixing AC-2000 and AC-3000 scales, select [AC-3000]. 

• If mixing AC-3000 and AstraXT scales, select [AC-3000] to hide the AstraXT-specific 
functions. This is recommended for consistency of data across all scales. You may select 
[AstraXT] if you wish to enable the AstraXT features such as extra messages #2 and #3, 
but take care as this may cause problems due to these features not being supported by the 
AC-2000 or AC-3000 scales. 

The “system type” for each scale on the network is specified in the communication link setup for 
each scale. See Setting Up ID-ENQ Communications below. 

Setting Up the ScaleLink Pro Software 
Before you can communicate with the scales, you must check that ScaleLink Pro is setup 
correctly for your scales system. Use the following procedure. 

 You can save the current setup to a file or load a previously saved setup using the 
Save Setup and Load Setup commands respectively in the Setup menu. The 
ScaleLink Pro setup consists of all the items set via the Setup menu. 
This feature is useful for copying setups from one copy of ScaleLink Pro to another.  

 A number of alternative setups may be shipped with the ScaleLink Pro installation. 
Use the procedure below to check the default setup. If it does not appear suitable for 
your store (if the version is "USA" but you are in Australia, for example), use the Load 
Setup command to see if a more appropriate setup is available. The names of the 
listed setup files indicate their purpose (for example, NZ.SET contains the New 
Zealand setup). 

Outputting a Listing of all ScaleLink Pro Settings 
Select Output Setup List from the Setup menu to output a list of all ScaleLink Pro setup 
parameters to a text file. 
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1. Start ScaleLink Pro. 

2. If a database does not open automatically, use New or Open Database in the File 
menu to create or open a database. 

3. Click the Setup menu and select Options and to display the following dialog: 

 

 
4. Set the following options: 
 

Item Explanation 

System type: Specifies the default scale type. ScaleLink Pro operation is optimized 
for the selected scale model and functions not applicable to that model 
are hidden. For example, if [AC-3000 Master] is selected, AstraXT 
functions such as extra messages #2 and #3 are hidden. 
When communicating with more than one master scale or MSCU, this 
setting can be overridden for individual scales in the communication 
link setup. 
See Networks Containing More Than One Type of Scale above for 
more details. 

Version: Specifies the default scale version. ScaleLink Pro uses this parameter 
to select which communication message formats to use. 
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Item Explanation 

Enable on-line 
comms: 

Set this check box ON if you are using on-line communications. 

Enable 
left-justified 
fonts? 

Set this flag ON if using AC-3000 series scales that support the full set 
of left-justified fonts. 

Coupon support: Different ID-ENQ message formats are used for sending PLU data to 
the AC-2000 depending on whether or not the scales support coupon 
labels. Set coupon support ON for the AC-3000 series. 

Daisy-chained 
comms link? (USA 
only) 

Set this on if more than one scale is connected to each comms link. 

Campaign data 
includes day of 
week 

Set this on if the scales use the "day of week" version of the campaign 
function. 

Enable PLU 
active/inactive 

Enables or disables the PLU active/inactive function. This function 
allows PLUs to be marked as inactive. Inactive PLUs are deleted from 
the scales but remain in the Scalelink Pro database. 

AstraXT supports 
price change 
message? 

Enable this setting if using an AstraXT model that supports price 
change communications. 

Use nutrition Enable or disable nutrition data editing. Only enable this setting if 
supported by the scales. 

Use same nutrition 
for multiple PLUs 

If this setting is enabled, the same nutrition data can be shared by 
more than one PLU. However, this feature is only supported by 
AstraXT scales and may not be used in systems that include older 
scale models. 

Enable POS/Item 
code prompt for 
new PLU No.? 

If enabled, Scalelink Pro asks the user whether to automatically modify 
the POS code and item code to match the PLU number when the PLU 
number is changed. 

Do not delete 
production totals 
after loading 

If enabled, Scalelink Pro does not delete automatically the production 
total data on the scale after reading this data. 

Disable 
auto-resend of 
unsent data when 
scale off-line. 

Normally, Scalelink Pro saves any data that cannot be sent to a scale 
while it is off-line, and automatically resends the data when the scale 
comes back on-line. Enabling this setting turns off this function. 

AC-4000s use 
master-satellite 
mode 

Select this checkbox if using AC-4000s in a master-satellite 
configuration. If selected, Scalelink Pro sends a message to the 
master scale to update the satellites after each change in the scale 
data. 

Max. PLU No. Specifies the maximum allowed PLU No. This field also controls the 
number of PLU digits (e.g. set to 9999 for 4-digit PLUs, 999999 for 
6-digit PLUs, etc.). The maximum is 99999999 (8-digit PLUs). 
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Item Explanation 

Max. Extra 
Message No.* 

Specifies the maximum allowed extra message No. Specify 99 if your 
scale supports 2-digit extra message numbers and 9999 for 4-digit 
extra message numbers.  The maximum is 99999999 (8-digit Extra 
Messages) 

Max. Coupon 
No.* 
Max. Campaign 
No.* 
Max. Store No.* 

Set these to the number supported by your scales. 

Preset Keys Opens a dialog to set the code to use for each preset key meaning 
(e.g. PLU, Tare, etc.) 
Different scale versions use different codes. Set the correct codes for 
the type of scale system you are connecting to. (Refer to your Ishida 
agent for details.) 

Display font Sets the font used in description text fields. 
If using non-English characters, you must set a font for the character 
set (e.g. Thai, Korean) used by your scales. 

Password, 
Password protect 

If desired, you can password-protect the setup menu commands to 
prevent users from making unauthorized changes. To enable the 
password function, set Password protect? ON and enter a password in 
the Password field. 
This is independent of the User Access Control function. 

NOTE: If you forget the password, press Ctrl+Alt+P in the PLU 
Search window. This displays the current password. 

* If you have a system with both AC-3000 and AstraXT or AC-4000 scales, always set these 
values to match the AC-3000 specifications. Setting a larger number will cause invalid data to 
be sent to AC-3000 scales. 
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5. Click the General #2 tab and set the following options: 
 

 
Item Explanation 

Default  
database  
format 

Specifies whether to use Microsoft Access or Ishida proprietary format 
PLU databases. This only specifies the default format. Both formats 
are still available in File Open and Save As dialogs. 
See Setting Up the PLU Database for details. 

Auto-load 
database at 
startup? 

Specify whether to automatically load the database when ScaleLink 
Pro starts (the database that was open when ScaleLink Pro last 
exited). 
Normally, set this option ON. 

Multi-user 
database access 
(MDB only) 

Specify whether to allow multi-user database access. If OFF, 
ScaleLink Pro does not allow more than one user to have a database 
open at the same time. 
Set this option OFF if you do not need multi-user access. 
See 5.3 Multi-User Operation for more details. 

Automatic 
database file 
backup 

Set this on to automatically backup the database each time you start 
ScaleLink Pro. Click Select Folder to modify the folder in which to 
save the backups. 
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Item Explanation 

Use POS code in 
search window 

Set this on to enable use of the POS code (bar code) in the PLU 
Search window. 

Use Dept & Group 
code in search 
window 

Set this on to enable use of the department and group codes in the 
PLU Search window. 

Use Dept & Group 
codes from Scale 
menu (AC-4000 
only) 

Set this on to use the department and group codes set in the Scale 
menu (the department and group codes sent to the scale). 
If disabled, the department and group codes defined in Department 
Codes in the Setup menu are used instead. 

Show 2 lines of 
PLU description 
in search window 

Set this on to show the first two lines of a PLU description in the PLU 
search window.  

Show comms 
status at startup? 

Set this on to open the comms status dialog automatically when you 
start ScaleLink Pro. 

Bypass bug in 
printer driver? 

Some printer drivers have a bug that causes them to print rotated text 
incorrectly. If you have trouble printing keysheet template, try 
changing this setting. If neither setting works, try changing the print 
orientation from portrait to landscape. 

Use different 
decimal position 
for unit and fixed 
price? 

This is only used in China. In other countries, always set this off. 

Use decimal point 
in percentage 
markdown? 

Set this on if the scale expects percentage markdown values to be 
expressed to one decimal place. 

Support Hiragana 
& Katakana 
(Taiwan)? 

Set this on if the scale supports Hiragana & Katakana characters. This 
is used in Taiwan only. 

Show 
host-supported 
flag in PLU Edit 
screen? 

The host-supported flag function is currently only used in New 
Zealand. In other countries, always set this off. 

Support NZ Digi 
comms 

This is a special setting for use in New Zealand only. 

Skip duplicate 
scale IP address 
check 

If enabled, Scalelink Pro allows you to define more than one scale with 
the same IP address. Generally this should only be used if the scale is 
assigned to different departments. 

AC-3000 supports 
Ex Msg. #2 

Select this checkbox if using the version of the AC-3000 that supports 
a second extra message file. (For use in Thailand only) 

So not send tray 
number to EMZ 

Select this checkbox to inhibit sending the tray number data field to 
EMZ scales. In this case, the tray number setting on the scale remains 
active. 
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Report Settings 
 

 
Item Explanation 

Report font size You can select the font size for the PLU report. The smaller the font 
size, the more information can fit on the report. 

Start day of week Determines the start day of the week to use when accumulating 
weekly totals. 

Save period for 
production data 

Production data is automatically deleted after the specified number of 
days. 

Clear totals Clicking this button deletes all current production data. 
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Log Settings 
ScaleLink Pro generates an event log recording changes to the database and other significant 
operations. 

 
Event Log 

Item Explanation 

Enable logging Use this check box to set event logging on or off. 

Filter Select the type of events you wish to record in the log. 

Keep data for ... ScaleLink Pro automatically deletes old data from the event log after 
the specified number of days. 

Log file name Specify the name of the log file. 

Maximum 
Comms Log Size 

This specifies the maximum size of the comms logs generated by each 
communications link. These logs are compacted to be less than the 
specified maximum size each time ScaleLink Pro starts. 
The comms log for each communications link is specified in the 
communications link setup. 
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Custom Log Settings 
ScaleLink Pro also generates a number of special-purpose logs. The settings for these are split 
over two pages. 

Custom Logs #1 

 
PLU Update & Exception Log 

Item Explanation 

Log PLU Updates Use this check box to set logging of changes to PLU data on or off. 

Log PLU Send 
Failures 

Use this check box to specify whether or not to log PLUs that are not 
successfully sent to each scale. 

Keep data for ... ScaleLink Pro automatically deletes old data from the log files after 
the specified number of days. 

Log file name Specify the name of the log file. 
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Scale Status Log 

Item Explanation 

Enable Scale Status 
Log 

Enables the scale status log. This log saves the current status of each 
scale (whether each scale is enabled or connected). See 9.1.3 Scale 
Status Log for details. 

If you set the Keep Data for setting to zero, the old log is overwritten 
each time it is updated. That is, the log only saves the curent scale 
status. 
 

Custom Logs #2 

 
Text File Import Logs 

Item Explanation 

Create Text Import 
Logs 

Set this on to save the following logs relating to text file import 
operations: 
Summary Log Contains summary information of import 

operations, including text file name and number 
of records imported 

PLU Import Log Contains detailed information on PLU import 
operations, including changes to individual fields 

Send Errors Log Logs PLUs that are not successfully sent to the 
scale (due to a scale being off-line, for example) 
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Multi-Store Settings 
See Setting Up Price Zones. 
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Data Save Settings 
These settings control the importing of Data Save files. 

 

 
 

Item Explanation 

Hide Data Save 
menus: 

Set this flag ON if not using Data Save communications. This 
simplifies ScaleLink Pro operation by removing the Data Save related 
commands from the menus. 
As Data Save communications are not supported for AC-2000 series 
scales, set the flag OFF for the AC-2000 series. 

Display options 
dialog when 
opening? 

Specify whether or not to display the Data Save Open Options dialog 
when opening a Data Save file. If this option is set OFF, the default 
options specified here are used automatically. 

Open but do not 
import data 

This selects the specified file but does not import the file contents into 
the database. Clicking Save (Data Save) in the File menu writes the 
database data into the specified file. 

Import into new 
database 

This closes the current database, creates a new empty database and 
imports the data from the specified Data Save file. The database is 
assigned the same file name as the Data Save file. e.g. If the Data 
Save file is backup.dsv, the database is created as backup.pld. If 
backup.pld already exists, it is overwritten. 

Import, add to 
current database 

This imports the file contents into the currently open database. 
The following two flags only apply when this option is selected. 

 Use database  
 PLU, msg etc. 

If the same PLU No., message No. or other scale data ID is found in 
both the Data Save file and database, the database data is left 
unchanged. 
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Item Explanation 

 Use Data Save file
 PLU, msg etc. 

If the same PLU No., message No. or other scale data ID is found in 
both the Data Save file and database, the database is overwritten with 
the data from the Data Save file. 

Label Sizes 
ScaleLink Pro uses the label size information to control word wrapping when entering product 
description text and similar, and to warn you if the length of product description is too long for 
the label. 

Set all the different label widths and maximum description text lengths used in your store. The 
label widths and lengths set here appear as options in the description size width and length 
menus when editing PLUs and messages. 
If different label formats are used for set ranges of PLUs, enter the start and end PLU No. for 
each label format (you can enter more than one range for the same label size). When you add 
a new PLU, the default label width and maximum description text length specified here are set 
automatically. 
 

 
 

Length 

This is the length (in mm) of the product name area in the label format. ScaleLink Pro displays 
the total length of the product description and any extra message in the PLU Edit window, and 
warns you if the length exceeds this value. 
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The Description Text Line Spacing (dots) is used in this calculation. Set the value specified in 
your label format. 

Default Description Text Width 

This is the actual width (in dots) of the product description area in your label format for a 60mm 
wide label. This is typically slightly less than the actual label width (to allow a margin). 
For example, an actual print width of 440 dots  = 440 x 0.135mm/dot = 59.4mm. In other words, 
when you select a 60mm label width, ScaleLink Pro assumes an actual available print width of 
59.4mm. Other label widths are scaled based on this value. That is, a 40mm label is assume to 
have an actual print width of 40 x 59.4/60 = 39.6mm. 

 

4. Click OK to save the setup information. 

5. Use one of the procedures described below to test the communications link to the 
scales. 
(Which procedure to use depends on whether you are using ID-ENQ or Data Save 
communications. See Which Communications Link? Above.) 
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EMZ Settings 
This page contains a number of settings specific to EMZ series scales. 
 

 
 

Item Explanation 

Single store 
operation (Do not 
allow multiple 
prices, etc. per 
PLU) 

EMZ series scales permit a maximum of five price master records per 
PLU. (See for details.) This is intended for use in processing center or 
similar environments where you are packing product for more than one 
store. 
Set this check box off if you are using the EMZ in a single store 
environment where you have only one price per PLU. 
This setting controls the operation of the PLU Edit window and Price 
Change dialog to suit the way the EMZ scales are used. 

Scale supports 
2-color printing 

Set this on if the EMZ scale has a 2-color print head. 
When set on, the print color can be specified in the PLU Edit window 
and other description text fields. 

Message file 
mapping 

This setting is intended for use in systems which use both EMZ and 
AC-series scales. 
Both the EMZ and AC-series scales support a range of different types 
of messages (extra messages on the AC series, free messages and 
ingredients, etc. on the EMZ). Normally the data for each type of 
message is maintained separately. 
However, if you wish to share messages between the two different 
types of scale (to avoid duplication of data, for example), you can 
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assign EMZ messages to be used in place of AC series messages. For 
example, if you map extra message #1 to free message #1, any 
changes made to free message #1 in Scalelink Pro are sent to the extra 
message #1 file on the AC series scales as well as to the free message 
#1 file on the EMZ scales. 

Important:  If you enable these fields, set the corresponding PLU field 
to Display = OFF in Setup -> Plu Fields. For example, if you map 
extra message #1 to free message #1, the extra message #1 field in the 
PLU data is no longer used so should be removed from the PLU Edit 
window. 
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Setting Up ID-ENQ Communications 
Use the following procedure to setup and test the ID-ENQ communication link to the scales 
(See Which Communications Link? above): 

ID-ENQ communication links can use either RS-232C or TCP/IP communications. 

1. Check that the scales or MSCU are turned on and the necessary cabling is 
connected. 

2. In ScaleLink Pro, click the Setup menu and select Options. Check that the Enable 
Online Comms check box is ON and that Daisy-chained comms link? is set 
correctly, then click OK. 

3. Click on Comms (Online) in the Setup menu to open the Communication Links 
dialog. 

4. Click the Add button to create a new communication link. 

5. Select the type of communication link (RS-232C, TCP/IP, or AstraXT) 

6. This opens a dialog (shown below) for the type of communications link specified. 
Set the comms link name and other parameters (described below). 
When finished, click OK to exit the dialog 

7. If using more than one communication link, repeat steps 4 to 6 until you have created 
all the required communication links. 

8. Click OK to save the settings and exit the dialog. 
 
At any time, you can check the current link statuses or reconnect a link that has become 
disconnected (See Chapter 3 Communicating with the Scales). 

 The comms link setup dialog format differs depending on whether Daisy-chained 
comms link? is set on or off. The following examples are for Daisy-chained comms 
link? = OFF.  

RS-232 Settings Dialog 
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TCP/IP Settings Dialog 

 

 
Communication link settings 

Item Explanation 

Enable link You can disable a link that is not currently being used. 
This avoids unwanted error messages if a link is unavailable for some 
reason. 

Link name Specify the link name. The name specified here is used to identify the 
link in other setting dialogs. 

Scale type The type of scale connected to this communications link. Set "Default 
scale type" unless connecting to a scale other than the type specified 
in the Options dialog. 

Price Zone Assigns the scale to a specific price zone. Set "Use Defaults" if not 
using the price zone feature. 

Comms log ON 
Log file 

ScaleLink Pro can record all communication activity in a log to help in 
fixing communications problems. 
If you set logging on, also specify the name of the log file. 
NOTE:  Log files are cleared each time ScaleLink Pro starts. 

Assume 8-bit 
comms link to 
scales 

Set this check box when communicating with the scales via a TCP/IP 
terminal server if the serial link between the terminal server and scales 
uses 8 data bits. Typically, this setting is only used in Asian and other 
countries that use extended character sets. 
This setting only applies to TCP/IP links. 
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Item Explanation 

Add one day to 
shelf life? 

Setting this ON increments the shelf life field in PLU data by one when 
transmitting to the scale (so zero represent "today", etc.). 

Max. Description 
Text Length 

Select the option that applies for the connected scale. 

Tare Format This setting only applies in the USA when using old single range 
scales in the same system as new dual range scales. In all other cases 
set "Standard". 

Filtering 
(Daisy-chained 
comms link? = 
OFF.) 

You can specify that the communication link only transmit data to the 
scales within a specified range of record numbers. 
Use the Add, Edit, and Delete buttons to specify the filters. 
If no filter is specified for a particular data type, all records for that data 
type can be sent to the scales. 

Scales 
(Daisy-chained 
comms link? = 
ON.) 

Use the Add, Edit, and Delete buttons to add or edit the scales 
connected to this comms link. Clicking the Add or Edit button opens a 
scale setup dialog. The operation is described below. 

TCP/IP settings Set the communication parameters for the link. 
The standard value for the Communication Timeout is 5 seconds. 
You may need to increase the value if the network is congested (e.g. if 
sending to more than 10 scales at a time) or if operating via a WAN 
which has a slower connection time. 
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Scale Setup 

When Daisy-chained comms link? is set ON in the Options dialog, you can connect more 
than one scale to each communication link. In this case, clicking the Add or Edit button in the 
Scale Comms Link dialog displays the following dialog for defining the individual scales. 
The meaning of each field is the same as described above for the Scale Comms Link dialog. 
Important:  The ID-ENQ Machine ID must match the value set in the scale. 
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Setting Up Data Save Communications 
Use the following procedure to setup and test the Data Save communication link to the scales 
(See Which Communications Link? above). 

The procedure is described for an AC-3000 series scale. The operation may differ somewhat 
for other Ishida products. 

1. Connect the PC to the scales via an RS-485 to RS-232 converter. Consult your Ishida 
agent if you do not know the correct cabling requirements. 

2. Turn on the scales and set to Test Mode. 

3. Use the Test Mode menu to select DATA SAVE/LOAD. 

4. Select TRANSFER FILE, enter the IF21 FILE NO. (enter 1) and press the Enter key 
twice. 

5. Use the → key to select SEND: MASTER FILE. 
Leave the scales in this state and move to the PC. Do not start sending the file yet.

6. In ScaleLink Pro, click the Setup menu and select Options. Check that the Hide Data 
Save menus check box is OFF, then click OK. 

7. Click the Setup menu and select Comms (Data Save). Set the Serial Port selection 
to the port used to connect the scales and set the communications parameters. 

8. Click the Comms menu and select Receive (Data Save). A dialog appears indicating 
that ScaleLink Pro is ready to receive data from the scales. 

9. Press the PRINT key on the scales to start the data transfer. A message appears on 
ScaleLink Pro when the transfer completes. 
If an error message appears, check that the cable is plugged in to the correct 
connectors and re-check the Comms (Data Save) settings. 

10. If the transfer was successful, a dialog opens for you to specify the file name. Enter an 
appropriate name and click OK. Next, another dialog opens asking whether to import 
the received data. As we are only testing the comms link at this stage, click No to exit 
the dialog. 

 

This completes setup of the communications link. The next step is to set the PLU profile. 
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Setting Up Department and Group Codes 
Ishida scales include department and group code fields in the data for each PLU. These are 
used to classify each PLU. In ScaleLink Pro, department and group codes are used in the PLU 
search window and for production report totals. 

The scale treats the combined department, group and item code as a single 8-digit code. Within 
ScaleLink Pro, you can specify the number of digits for these fields, provided the total for the 
three fields adds up to 8 digits. The respective field lengths are specified in the PLU field setup. 
See Appendix A.3 PLU Field Setup for details. 

If you wish to use department and group codes at your store, you must first enter the code 
definitions to ScaleLink Pro. 

Use the following procedure: 

1. Click on Department Codes in the Setup menu. 
This displays the dialog shown below. 

 

 

2a. If you have already loaded the PLU data into the database with existing department 
and group codes, click the Auto-Generate List button. This scans the PLUs in the 
database and automatically generates a list of all codes found. 
In this case, arbitrary names are assigned to each department and group. Use the 
Edit button to edit each department. This opens the dialog shown below. 

2b. If you do not have existing PLU data with department and group codes set, click the 
Add button. This opens the dialog shown below. 
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3. Enter the department code and name. 

4. If using the function to automatically assign PLU numbers based on department when 
importing from a text file, set the PLU number range for the department. See 8.1 Text 
File Import for details of this function. 

5. Click the Add button to add a group code definition. This opens a dialog for you to 
specify the group code and name. 

6. Repeat step 4 until all group codes used in the department have been defined, then 
click OK to save. 

7. Repeat the above steps until all department and group codes are defined. 

 

 To enable use of the department and group codes in the PLU Search window, select 
Options from the Setup menu and set Use Dept & Group code in search window 
= ON.  
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Setting Up Departments 
The departments feature is useful in stores where you wish to manage the PLU and other scale 
data separately for each department. 

  
This is not the same as the department and group codes used in the PLU data. 
  

Do I need this feature? 
Use the department feature if you wish to keep data for different departments separate. 
However, you must use the department feature in the following case: 
• If you use the same PLU number for different products in different departments 

 You must have defined all the communication links and scales used in the store 
before you can define the departments. See Setting Up ID-ENQ Communications 
above for details.  

Setup procedure 

Use the following procedure to setup the departments for your site. 

1. Click on Departments in the Setup menu. 

2. Click Add to create a new department. This opens the dialog shown below. 

3. Enter the department name and other settings (described below), then click OK. 

4. Continue until you have added all the required departments, then click OK to exit the 
Edit Department Settings dialog. 
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Settings 

Item Explanation 

Name The department name specified here appears in the department 
selection dialog. 
The title bars of the PLU Search and PLU Edit windows display the 
name of the currently open department. 

Database 
file 

Specify the database file for this department. 

Scales Use the Add and Delete buttons to assign which scales belong to this 
department. Each department must have at least one scale assigned.
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Setting Up the PLU Range Profile 
The PLU range profile function is used to restrict which PLUs are visible in ScaleLink Pro. 

Do I need this feature? 
PLU range profiles are intended for multi-store or multi-department operation where the 
same master file (PLU database) is used for all stores or departments, but where not all 
stores carry the same products. 

The PLU range profile function allows you to specify ranges of PLU numbers to exclude from all 
ScaleLink Pro screens and operations. In this way, ScaleLink Pro can be made to only show 
those PLUs that are actually used in the store or department, making searching for PLUs 
easier. 

 A separate PLU range profile can be assigned to each user. See Setting Up 
ScaleLink Pro Users below for details. 
  
In version 2 and earlier of ScaleLink Pro, the PLU profile settings were stored in a 
separate file. From version 3 onwards the settings are stored in the site setup file. 
 

However, if a user-specific PLU profile is defined, the profile settings for that user are 
stored in the file name specified in the user setup. See Setting Up ScaleLink Pro 
Users below for details. 

 

Use the following procedure to setup the PLU range profiles for your site. 

1. Click on PLU Range Profile in the Setup menu. 

2. Click Add to create a new PLU range. 

3. Enter the PLU range and an optional comment, then click OK 

4. Continue until you have added all the PLU ranges used in this store or department. 
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Setting Up ScaleLink Pro Users 
ScaleLink Pro allows you to define a user name and password for authorized users and to 
restrict access to specific functions. 

Do I need this feature? 
You need to define user settings if you wish to control user access to the ScaleLink Pro 
functions. User access control is automatically disabled if no users are defined. In this case, 
ScaleLink Pro does not prompt for a user name and password at startup and all users can 
access all functions. 

Use the following procedure to setup the ScaleLink Pro users for your site. 

1. Click on Users in the Setup menu. 

2. Click Add to create a new user. This opens the dialog shown below. 

3. Enter the user name and password, then set the access permissions and other 
user settings, on both the tabs described below. Click OK when finished. 

4. Continue until you have added all the required users, then click Close to exit the Edit 
User Settings dialog. 
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User settings - General 

Item Explanation 

Copy settings 
from default user 
profile 

Click this button select a profile to copy the settings from.  Once a new 
profile is selected, existing settings are replaced with the settings from 
the profile.  See Setting Up User Profiles below for details 

Price Zone You can restrict the user to only modify data from a specified price 
zone. This setting is only applicable in head office mode. 
Specify "Use Defaults" to allow the user to access all price zones. 
Note that the Sale Wizard is not available to users with a setting other 
than "Use Defaults". 

Use specified 
database/ 
department only? 

Set this check box on to limit the user to access one designated 
database or department only. 
A File Open dialog or Department Selection dialog opens for you to 
specify the database file or department. 
Use the Select DB/Dept button if you wish to change the specified 
database file or department. 

Specify PLU 
profile? 

Set this check box on if you wish the user to use a specified PLU range 
profile. A File Open dialog opens for you to specify the PLU profile file. 
The file does not need to exist already. 
Use the Select File button if you wish to change the specified PLU 
profile file. 
To enter the actual PLU profile settings for the user, you must log-in as 
that user and use the PLU Range Profile command in the Setup 
menu to set the profile. The profile settings are saved in the users PLU 
profile file (the file set in this field) and applied to all users who have 
this file specified as their PLU profile. 

PLU Access 
permissions 

The Price Changes check box specifies whether the user has 
permission to make price changes. Click on the PLU Field Enable 
Disable button to display a dialog box showing all available PLU fields. 
This allows you to choose individual fields which the user has 
permission to change. 
 

General Access 
permissions 

These check boxes specify whether the user has access to each type 
of scale data. If these check boxes are selected: 
  View  Shows the associated menus commands and 
buttons. 
  Delete  Allows the user to delete data. 
  Update Allows the user to modify data. 
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User settings – Reports and Data Import/Export 

Item Explanation 

Data 
Import/Export 
Permissions 

These check boxes specify access permission to functions related to 
data import and export. 

Report 
Permissions 

These check boxes specify whether the user has the permission to 
create each type of report.  

Disabling User Access Control 
Click the Remove All button in the Edit User Settings dialog to delete all users. This disables 
the user access control feature. 

Using the User Access Control Feature to Customize ScaleLink Pro 
Even if you do not wish to control user access to ScaleLink Pro, you can still use the user 
access control feature to determine which commands appear in the menus. Specifically, you 
can simplify the operation of ScaleLink Pro by hiding those feature that are not used at your 
store. 

To do this, simply create a single user with the unwanted functions disabled. Leave the user 
password blank. 

If only one user is defined and that user has no password specified, ScaleLink Pro applies the 
access permissions for that user automatically but does not display the user logon dialog at 
startup. 
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Setting Up User Profiles 
ScaleLink Pro allows you to define profiles of common user settings and permissions. The 
settings created here can be used to speed up creating new users for the system. If you have 
many users, and groups of users need access to similar features, then a profile can be set up 
specifying default access permissions. When setting up a new user, this profile can be selected 
and these defaults are loaded.  Individual changes can then be made before the user is 
created. 

Use the following procedure to setup the ScaleLink Pro user profiles for your site. 

1. Click on User Profiles in the Setup menu. 

2. Click Add to create a new user profile or Edit to edit an existing one. This opens the 
same dialog that was shown above for setting up a new user. The only difference is 
that you cannot enter a password.  Passwords must be specified for each user 

3. Enter the profile name and set the access permissions and other settings, on both 
the tabs as described above for setting up a new user. Click OK when finished. 

4. Continue until you have added all the required profiles, then click Close to exit the 
Edit Default User Profiles dialog. 

5. Once User Profiles are set up, when you click Add in the Edit User Settings dialog 
box (See step 2 under Setting Up ScaleLink Pro Users above), you will first see a 
Select User Profile dialog. You can either select the profile you wish to use then click 
Select, or click Cancel to use the defaults (i.e. all access enabled).  In either case, 
the Edit User dialog is displayed and user settings can be edited normally. 

Setting Up Price Zones 
The price zone feature allows different values to be set for specific data fields in each PLU. 
Typically, this is used to set different prices for different groups of stores (hence the name 
"price zones"). 

Do I need this feature? 
Price zones are intended for use in a multi-store environment. Use the price zone feature if 
you intend to manage PLU data for multiple stores in a single central database, but need 
the flexibility of setting store-specific values such as price. 
If not required, you can disable the price zone feature. 

Use the following procedure to setup the price zone feature for your site. 

1. Click Price Zones in the Setup menu. 

2. Click Add to create a new price zone. 

3. Enter the price zone name and ID in the dialog, then click OK. 

4. Continue until you have added all the required price zones, then click 
OK to exit the Edit Price Zones dialog. 

5. Click Options in the Setup menu and click on the Multi-Store tab. 
This opens the dialog shown below. 

6. In the left side of the dialog, select the operation mode for this 
installation. If you select local store mode, select the price zone to 
which the store belongs. 

7. In the right side of the dialog, use the Add and Remove buttons to 
specify which fields allow price zone-specific values to be set. 

8. Click OK to complete price zone setup. 
Note: The PLU active/inactive setting may also be used as a price zone field. However, in this 
case you must define the active/inactive field in the PLU field setup. Contact your Ishida agent 
for details. 
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Setting Up Text File Import and Export 
ScaleLink Pro has a flexible text file import and export function. To simplify operation for the 
user, you can pre-define the settings for commonly used import and export operations. 

When the user selects the text file import or export command from the Tools menu, a list of the 
defined import or export operations is displayed. The user can either select a pre-defined 
import/export operation or click the Customize button to specify the import/export settings 
directly. 

Do I need this feature? 
Only use the text file import and export setup feature if you have a commonly used import 
or export operation. The text file import and export functions are still available even if no 
import or export settings are defined. 

The procedure for defining text file import settings is as follows. The operation for defining text 
file export settings is the same. 

1. Select Text File Import from the Setup menu. 

2. Click Add to create a new text file import operation. This opens the 
dialog shown below. 

3. Enter a name and the various settings including the format and 
operation. (See Appendix B Text File Formats and Operations for 
details.) 
The name specified here appears in the list of pre-defined import 
settings when the user clicks Import from Text File in the Tools 
menu. 

4. Click OK to exit the Text File Import Settings dialog. 

5. Repeat steps 2 to 4 until all import operations are defined, then click 
OK to save the setup. 
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Setting Up Database Import 
To simplify operation for the user, you can pre-define the settings for commonly used database 
import operations. 

When the user selects the Import from Database command from the Tools menu, a list of the 
defined import operations is displayed. The user can either select a pre-defined import 
operation or click the Customize button to specify the import settings directly. 

See 8.3 Database Import for details. 

Do I need this feature? 
Only use the database import setup feature if you have a commonly used database import 
operation. The database import function is still available even if no import settings are 
defined. 

The procedure for defining database import settings is as follows. 

1. Select Database Import from the Setup menu. 

2. Click Add to create a new database import operation. This opens the 
dialog shown below. 

 

3. Enter a name. 
The name specified here appears in the list of pre-defined import 
settings when the user clicks Import from Database in the Tools 
menu. 

4. Select whether to import from an ODBC data source or an MDB file 
and set the connection string or file name. (Contact your database 

148 



administrator for details.) 

5. Set the otter settings, then click OK to exit the Database Import 
Settings dialog. 

6. Repeat steps 2 to 5 until all import operations are defined, then click 
OK to save the setup. 

 

 

Setting Up Default Line Fonts 
ScaleLink Pro now allows you to have default line fonts for PLUs, Extra Messages (1, 2 and 3), 
and Coupons, where supported. This means that you can have a default font set for each line, 
up to a maximum of ten lines. The default fonts are then automatically applied when you create 
a new PLU label, extra message, or coupon. To set up default line fonts, click on Default Line 
Fonts in the Setup menu, and a dialog like the one below should appear. 

  
 

Each of the tabs is used in the same way. By default, Default Line Fonts is turned off. If so, the 
only font you can change is the default font for all lines. To turn on Default Line Fonts, follow the 
steps outlined below: 

1. Select the Use Default Line Fonts check box. This enables all the 
individual line options, and changes “All Lines” to “Line 1” 

2. Select the appropriate font for each line from the list box 

2xH means the font is twice the normal height 

2xW means the font is twice the normal width 

3. Click OK to save the changes, or click another tab and repeat steps 1 
and 2 to change more line fonts. 
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e-Mail Settings 
A function is also available in the scheduler to e-mail the results of the scale status log to 
designated e-mail addreses. This function is not available in all countries. Contact your Ishida 
agent for details. 

The procedure for specifying the addreses and other e-mail settings is as follows. 

1. Select e-Mail Settings from the Tools menu. 

2. A dialog opens displaying the e-mail settings. Set the fields as 
described below. 

3. Click OK to save the changes. 

 

Item Explanation 

Store ID This appears in the e-mail subject line and is used to identify the store 
that sent the message. 

SMTP Server The SMTP server to use to send the e-mail. Contact your network 
administrator if unfamiliar with this setting. 

SMTP User Name,
SMTP Password 

Specify these if required by your SMTP server. Contact your network 
administrator if unfamiliar with these settings. These can be left blank 
in many cases, 

From: The e-mail address to appear in the "From" header of the e-mail. 
Depending on the SMTP server, this may need to be a valid e-mail 
address. 

To:, Cc: The e-mail addresses to send the e-mail to. You can specify multiple 
addresses separated by commas in the same way as standard e-mail 
software. 

Body Text 1, 2, 3 Text used in the e-mail body. The format of the body text may be 
different for different countries. 
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A.3 PLU Field Setup 
The data defining a PLU consists of the PLU description and a large number of parameters 
(such as the price) that specify how to print the PLU on a label. Most stores, however, will only 
use some of these parameters. The markdown price and markdown flag parameters, for 
example, are unnecessary if you do not use the markdown feature. 

ScaleLink Pro has the facility to specify which fields to display in the PLU Edit window. This 
simplifies operation by hiding unused fields. Fields not displayed in the PLU Edit window are 
set to their default values (which you can also specify). 

Similarly, you can configure which fields to include in the PLU report (click PLU Report in the 
PLU menu to open a Report window). The first two columns always contain the PLU number 
and description. The remaining columns are filled with those fields selected for inclusion in the 
report, up to the end of the line. If you select more fields than will fit on a line, the excess fields 
are not included in the report. (The line length automatically adjusts based on the size of the 
printer paper.) 

HINT: To fit more fields on a line, set the printer to landscape mode (select Print Setup... 
from the File menu.) 

You can also control how each field is displayed. For example, if a field has a fixed set of 
allowed values, you can present the user a list of options to select from. 

Selecting Fields for the PLU Edit Window and PLU Report 
This section describes how to specify which fields to display in the PLU Edit and Report 
windows. You can also specify how to display each field. 

1. Click PLU Fields in the Setup menu. This opens the dialog shown below. 

2. Use the dialog to select which fields to display in the PLU Edit window and which to 
include in the PLU Report.. 

 

 

3. If you wish to customize individual fields, click the Advanced Settings button. The 
operation is described below. 
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Customizing a PLU Field (Advanced Settings) 
Clicking the Advanced Settings button in the PLU fields setup dialog displays a list of the 
registered PLU fields. To edit the detailed settings for a field, click on the field to select then 
click the Edit button (or simply double-click on the desired field). This opens the dialog shown 
below for customizing the PLU field. 

 The default PLU field settings provided with the installation should be adequate for 
most users. The ability to customize fields is mainly provided to allow for future 
modifications to the scales and to customize the software for different countries. 
Take care when using this feature as incorrect settings can cause misoperation of 
ScaleLink Pro or scales. 

 

 

 

The following describes the meaning of each item. 

Item Explanation 

Name The field name. The name specified here is used as the field title in the PLU 
Edit window and report. Accordingly the name must be short enough to 
display in the PLU Edit window. 

Field Type The field meaning. Select from the list. Do not create more than one field with 
the same meaning. 

Display? Specifies whether to include the field in the PLU Edit window. 

Print in 
Report? 

Specifies whether to include the field in the PLU Report. 

Display Width For numeric fields, this specifies the number of digits to display (not counting 
the decimal point). 
For fields that have a fixed set of allowed values, this specifies the width of the 
field’s column in the PLU Report. Set the width to at least the number of 
characters in the longest field value name. (e.g. in the above example, the 
display width = 9, being the number of characters in “Fix Price”.) 

Digits after 
Dec Pt. 

The number of digits to display after the decimal point. Specify zero to not 
display a decimal point. 
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Which of the following items to set depends on how you wish the field to appear in the PLU Edit 
window. 

For fields that take one of a fixed set of values (e.g. the sales mode can be either “Fixed price” 
or “Weight”), set the allowed values in the Field Values list, as follows. 
 

Item Explanation 

Add Adds a new field value. This opens a dialog to specify the name and numeric 
value of the field value. 

Edit Edits the selected field value. This opens a dialog to edit the name and 
numeric value of the field value. (Double-clicking on a value in the list 
performs the same operation.) 

Delete Delete the selected value. 

Set Default Makes the selected value the default value. This value is set as the default 
when a new PLU is created. 
The default value is indicted in the list by an asterisk (*). 

 

For fields that take any value within a specific range (e.g. the price or weight), leave the Field 
Values list empty and set the following items. 
 

Item Explanation 

Maximum The maximum allowed value of the field. An error message appears if in the 
PLU Edit window if the user specifies a value grater than the maximum. 

Minimum The minimum allowed value of the field. An error message appears if in the 
PLU Edit window if the user specifies a value less than the minimum. 

Default This value is set as the default when a new PLU is created. 
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Appendix B  Text File Formats and Operations 

B.1 Operations 
The text file import function can be used to add new records, update existing records, or delete 
records. 

The operation can either be specified in the ScaleLink Pro text file import dialog, or in the text 
file itself using an "operation command". 

Operation Commands 
The text file format has an optional facility to specify an operation command field as the first 
field in each record. 
The operation command is a single character (upper or lower case) as follows: 

Command Operation 
   A      Addition 
   U      Update 
   D      Deletion 

Operations 
Additions 
Creates a new record with the specified record number. If the specified record number already 
exists, the old data is overwritten. Missing or empty fields are set to their default value defined 
in the PLU Fields Setup. 

Updates 
Updates existing records, if present. If the specified record number does not already exist, a 
new record is created with the default values defined in the PLU Fields Setup. Missing or empty 
fields are set to their existing values. 

Deletions 
Deletes the record with the specified record number, if present. 
A deletion command is still sent to the scales even if the specified record number does not exist 
in the database. 
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B.2 Text File Formats 
ScaleLink Pro defines a standard, general-purpose format for text file import and export which 
is described below. 

 Special custom formats may be added from time to time for specific customers. 
These are not covered by the ScaleLink Pro documentation. Contact your Ishida 
agent if you require details.  

Key features of the standard format are as follows: 

• 

• 

• 

• 

• 

Export data is in a format suitable for importing into packages such as Excel. 

An optional column header line can be included at the start of the import text file to specify 
which fields are present and the order in which they appear. 

Import text file fields can be empty (blank). Empty and missing fields are set to the existing 
value (for update) or default value (for addition). 

If a column header line is specified, the first field can optionally be a control field to specify 
whether the line represents an addition, update, or deletion. 

Character string fields must be enclosed in double quotes (in case the character string 
contains a comma in comma-delimited format). 

Text File Export Format 
In all text file formats, data consists of one record per line. Individual fields in each record are 
separated by the specified delimiter character (either a comma or TAB character). 

When exporting, all fields from the selected data are output. If output column headers is ON, 
the field names are output on the first line of the file (separated by the delimiter character). 
If Include price zone? is ON, a price zone field is included as the second field after the PLU 
number. (This only applies for PLU and Price Change exporting.) 

This format is suitable for importing into packages such as Excel. 

Text File Import Format (Additions and Updates) 
The format for imported text files is the same as for text file exporting except that not all fields 
are required to be present. Fields can either be empty (blank space) or missing (not specified in 
the column headers). In both cases, the field value is set to the existing value (for an update to 
an existing record) or to the default value defined in the PLU Fields Setup (when adding a new 
record). 

The different import format options are as follows 
 
Column Header Line Missing/Empty Fields Explanation 

Not present All fields must be present and 
in the correct order. 
Empty fields are allowed. 

The order of the fields in each line is the 
same as for text file export. 
Operation commands may not be used.

Present Allowed. Missing and empty 
fields are set to existing value 
(update) or default value 
(addition) 

The column header line is used to 
specify which fields are present and the 
order in which they appear. 
The data must always include the 
record number, which must be the first 
data field after the optional operation 
command (see below) 

The simplest way to get a list of the column header names and the order in which ScaleLink Pro 
expects to find the fields is to use the text file export function with output column headers set 
ON, then use a text editor to view the resulting file.  Also use this method to check which fields 
are character string fields that must be enclosed in double quotes. 
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Text File Import Format (Deletions) 
The deletion format consists of the record number only. (Or, if operation commands are used, 
the format consists of the operation command 'D' followed by the record number. For example 
"D,0001" deletes record #1.) 

Operation Command 
If a column header line is present, the first field in each record may optionally be an operation 
command (described in B.1 Operations). The column header name for the operation command 
is "Cmd". 

Price Zone 
If a price zone field is present, it must be the first field after the PLU number. The column 
header name for the price zone field is "PriceZone". 

Description Text Formats 
Format Explanation 

Ishida format The description text is output using the same format as in Ishida ID-ENQ 
communications (i.e. contains embedded control characters). 

Line by Line Each line of the description is output as separate font and text fields. 
However, this format has some important restrictions, described below. 
As a consequence of these restrictions, do not use line by line format if 
you intend to import the text file back into ScaleLink Pro as data will be 
lost. 

 

Line by line format details 

Line by line description text format does not support font type (bold, underline, reverse, or italic) 
information. Also, a maximum of ten lines of description text can be specified. 

The column titles are "Font1,Desc1, Font2,Desc2, ..., Font10,Desc10". The font is the Ishida 
font code character ('1' to '9' and 'A' to E') and the description is the description text for the line, 
enclosed in double quotes. 

 
Example: 
...,Font1,Desc1,Font2,Desc2, ... 
...,3,"Description line 1",3,"Description line 2","","","",... 
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Keyboard Presets Import File Format 
Keyboard preset settings are imported using the same procedure as the other text import 
operations described above. However, because keyboard preset data is assigned to specific 
scales and stored in the site setup file rather than being stored in the main database, there are 
some important differences in the text file format. The codes used to specify prsets are also 
listed. 

Import Format 

The basic format is the same as described above for other text import operations. A title line 
can optionally be specified in the first line of the file. If not specified, the following column order 
is assumed: 

 ScaleId, KeyNo, Type, Data 

 

Column Name Explanation 

ScaleId Identifies the scale to which the keyboard setting belongs. See the 
explanation below. 
This field is optional but one of either ScaleId or ScaleName must be 
specified. 

ScaleName Identifies the scale to which the keyboard setting belongs. The name is 
case-sensitive. Note that ScaleName cannot be used in MSCU systems. 
This field is optional but one of either ScaleId or ScaleName must be 
specified. 

KeyNo The key number in the keyboard. The key numbering is shown below. 
This field is mandatory 

Type A code indicating the preset key meaning. The codes are listed below. 
This field is mandatory 

Data The value assigned to the preset key. For example, if the key type is PLU, 
this specifies the PLU number. Set zero for keys that do not require any 
data. 
This field is mandatory. 

Scale ID 

Note that you can specify the keyboard either by the scale name (which is case-sensitive) or 
the scale ID. The meaning of the scale ID differs depending on the system configuration, as 
follows: 

System Configuration Scale ID 

Standard TCP/IP 
system configuration 

The "Link No." displayed on the right side of the scale comms setup 
dialog (select Comms (On-Line) from the Setup menu). 

Daisy-chained RS-232C 
comms (USA only) 

The "Scale No." displayed on the right side of the scale setup dialog 
(select Comms (On-Line) from the Setup menu, then click Add or 
Edit to open the scale setup dialog). 

MSCU system        ((Link No -1)x 100) + Machine No. 

Link No : The "Link No." displayed on the right side of the 
scale comms setup dialog (select Comms 
(On-Line) from the Setup menu). 

Machine No. The machine No. of the satellite scale (range = 2 to 
32) 
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Key Numbering 

The key numbers for the AC-3000 and AC-4000 are shown below. The lower number indicates 
the key number for the case when the shift key is pressed. Note that the numbering scheme 
includes the four columns of non-preset keys on the right end of the keyboard. Assigning 
presets to these keys will be ignored. 

The AstraXT key numbers are not shown but use the same numbering scheme. 

Key Type Codes 

The table below lists the key type codes. Note that your scales may not support all of the listed 
codes. Also, additional code may be added in future. Consult with your Ishida agent if unsure. 

Code Meaning 

0 Do not assign any meaning to this preset key. 

1 PLU number 

2 Tare 

3 $ discount 

4 % discount 

5 Extra message 

6 Logo 

7 Coupon 

8 Operator 

9 Price 

10 X 

11 Markdown price 

12 SAVE 

13 VOID 

14 Interval 
 (continued on next page...)
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(cont...) 

Code Meaning 

15 99 

16 00 

17 Proportional Tare 

18 Sub Total 

19 Extra Message 2 

20 Extra Message 3 

21 Label Batch 

22 Store 

23 Label Format 

24 Logo #1 

25 Logo #2 

26 Peel Sensor 

27 POP message 

28 Pack Quantity 

29 Units 

30 Cash Drawer 

31 Go to Weighing Mode 

32 Special Price 

33 Fixed Weight 

34 Shelf Life 

35 Unit Price -$ 

36 Unit Price -% 

37 Logout 

38 Barcode Print 

39 Ingredients 

40 Print 2nd Label 

41 Batch Number 

42 Number of Labels 

43 Number of Fixed Price Labels 
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SaleWizard Import File Format 
The SaleWizard can import sale information from a text file as described below. The file format 
is comma or tab delimited text, and the fields must be specified in the sequence listed below. 
However, unused fields may be omitted (no value specified). 

 

Column Name Explanation 

SALES_NO This is the number of the sale to import.  All lines that are to be a part of the 
same sale should have the same number.  More than one sale can be 
imported at a time by giving each set of entries a different number. This field 
is mandatory 

SALES_NAME 

 

This is the name of the sale.  If a sale with the same name already exists, 
the sale will be overwritten.  If different sale names are given for the same 
sale number, the first sale name that appears in the file will be used. 

PLU_NO  This is the PLU number of the item in the sale. This field is mandatory 

OLD_PRICE  Specify the old price of the item.  If none is specified, the price at import time 
is used. 

NEW_PRICE Specify the new price (sale price) of the item. This field is mandatory 

START_DATE This is the start date and time of the sale. The date specified in the first line 
for the sale is used. Any different dates specified on latter lines are ignored.

END_DATE This is the end date and time of the sale. The date specified in the first line 
for the sale is used. Any different dates specified on latter lines are ignored.

PRICE_ZONE Price zone for which to change price. 

REPEAT_TYPE Specifies whether the sale is to be repeated and, if so, how to repeat the 
sale. If REPEAT_TYPE is omitted, operation defaults to REPEAT_TYPE = 0 
(execute sale once only) 
Specify one of the following codes: 

  Value Meaning        
     0 Execute once only (Do not repeat) 
     1 Execute every day at the specified times 
     2 Execute on the specified days of the week, at the specified times
 

START_DOW Specifies which day(s) of the week to start the sale. This field is only 
meaningful when REPEAT_TYPE = 2. 
Specify as a string of "Y" (yes) and "N" (no) characters representing each 
day of the week, starting from Sunday. 

Examples: 1. NYNNNNN = Start sale each Monday 
  2. NYNNYNN = Start sale each Monday and Thursday 
 

END_DOW Specifies which day(s) of the week to end the sale. This field is only 
meaningful when REPEAT_TYPE = 2. 
Specify as a string of "Y" (yes) and "N" (no) characters representing each 
day of the week, starting from Sunday (same as START_DOW, above). 
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Example SaleWizard Import file: 
SALES_NO SALES_NAME PLU_NO OLD_PRICE NEW_PRICE START_DATE END_DATE 

1 Promotion1 1101 3.44 2.33 2002/03/21 20:50:00 2002/03/21 21:10:00 

1 Promotion1 1102 4.44 3.33 2002/03/21 20:50:00 2002/04/21 21:10:00 

1 Promotion1 1103 5.44 4.33 2002/03/21 20:50:00 2002/04/21 21:10:00 

1 Promotion1 1104 6.44 5.33 2002/03/21 20:50:00 2002/04/21 21:10:00 

1 Promotion1 1105 7.44 6.33 2002/03/21 20:50:00 2002/04/21 21:10:00 

2 Promotion2 1101  2.33 2002/03/29 20:00:00 2002/03/29 22:00:00 

… 

161 



Appendix C  ScaleLink Pro Automation Reference 

C.1 ScaleLink Pro Object 
The ScaleLink Pro automation object name is “Slp3.document” and the type library file is 
“Slp3.tlb”. 

 ScaleLink Pro automation is executed using a different EXE file to the main ScaleLink 
Pro. The automation executable file (Slp3Auto.EXE) is generated automatically by 
ScaleLink Pro when it is executed for the first time. 
The reason for using a different EXE file is to prevent any software conflict if 
automation is executed at the same time as the main ScaleLink Pro is running. 

 

C.2 ScaleLink Pro Properties 
Property Meaning Default Value 

ShowErrors Set TRUE to display any errors on screen. 
Errors are displayed in a message box and wait for the 
user to click the OK button. 
Set FALSE if you do not wish execution to wait for user 
input, for example when executing operations 
unattended. 

TRUE 

C.3 ScaleLink Pro Methods 
Method Operation 

ClearProdDatabase() Deletes all existing data from the production database. 

CompareScalesVsDb() Receives PLU data from all scales and compares with the current 
database contents. 

DatabaseClose() Closes the currently open database. 

DatabaseCompact() Compacts the currently open database. 

DatabaseOpen() Opens the specified database file. 

ExportTextFile() Executes the specified text file export operation. Specify the name 
of a text file export operation that has been defined via Text File 
Export in the Setup menu. 

ExportTextFileEx() Performs text file export based on the specified parameters (export 
file name, data to export, export format, etc.) 

GetErrorMessage() Returns a string containing an error message for the previous 
method call. The sting is empty if no error occurred. 

ImportTextFile() Executes the specified text file import operation. Specify the name 
of a text file import operation that has been defined via Text File 
Import in the Setup menu. 

ImportTextFileEx() Performs text file import based on the specified parameters (import 
file name, import data format, send to scales?, etc.) 
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Method Operation 

IsUnsentDataWaiting() Returns TRUE if unsent data is present. “Unsent data” is data that 
could not be sent to a scale due to communication problems (such 
as the scale being off-line). 

LoadSetup() Loads the specified general setup file. Can only be used when no 
database is open. 

LoadSiteSetup() Loads the specified site setup file. Can only be used when no 
database is open. 

ReadProdFromScales() Reads the production totals from the scales and saves in the 
production database. 

ScheduleClose() Closes the currently open schedule file. 

ScheduleExecOp() Executes the specified scheduler operation. 

ScheduleExecSched() Executes all operations in the currently open schedule file. 

ScheduleOpen() Opens the specified schedule file. 

SendToScales() Sends the specified records from the database to the scales. 

SendUnsentData() Sends any unsent data to the scales. 

SetEventLogFile() Temporarily changes the event log file to the specified file. Use if 
you wish to log automation operations separately to user 
operations. 

 

C.4 Parameter Codes 
Some methods use integer codes to specify parameters such as which data to perform the 
operation for. These are listed below. 

Data type: Specifies the type of data for which to perform the operation. 

Value Meaning   
   2 PLUs 
   3 Advertising messages 
   4 Extra messages 
   7 Store name and address (AC-3000) 
   8 Coupons 
   9 Nutrition 
 10 Campaigns 
 11 Campaign PLUs 
 16 Department 
 17 Group 
 29 Extra messages #2 
 30 Extra messages #3 
 70 Comment 
 71 Store name and address (AC-4000, EMZ, etc.) 
 72 Free message #1 
 73 Free message #2 
 74 Free message #3 
 75 Free message #4 
 76 Free message #5 
 77 Free message name 
 78 Origin message 
 79 Storage temperature 
 80 Storage instructions 
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Import/export format: Specifies the format to use for text file import or export 

integer ExportFormat Specifies the export format. 

Value Meaning   
   0 Comma-delimited 
   1 Tab-delimited 
   2 Custom format (SE Asia) 
   3 Custom format (Wal-Mart) 

Descrption text format: Specifies the format to use for description text. 

Value Meaning   
   0 Ishida format 
   1 Line by line 

Import operation: Specifies the import operation. 

Value Meaning   
   0 Add records (overwrite existing records) 
   1 Update records 
   2 Delete records 
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C.5 Method Details 
 

Name 

Boolean ClearProdDatabase() 

Function 

Deletes all existing data from the production database. 

Return Value 

True if successful, False if an error occurred. 

Parameters 

None 

 
 

Name 

Boolean CompareScalesVsDb(long SyncScales) 

Function 

Receives PLU data from all scales and compares with the current database contents. 
Details of any differences are logged for each scale in the file CompareResultsScaleXXX.txt 
(where XXX is the scale ID number). 

If SyncScales is non-zero and differences are found, PLU data is sent to or deleted from 
each scale so that the scale data matches the database. 

Return Value 

True if successful, False if an error occurred. 

Also returns False if differences between the database and scale are still present (that is, if 
differences were found and synchronization was not performed). 

Parameters 

None 

 
 

Name 

Boolean DatabaseClose() 

Function 

Closes the currently open database. 

Return Value 

True if successful, False if an error occurred. 

Parameters 

None 
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Name 

Boolean DatabaseCompact() 

Function 

Compacts the currently open database. 

Return Value 

True if successful, False if an error occurred. 

Parameters 

None 

 

 

Name 

Boolean DatabaseOpen(string FileName) 

Function 

Opens the specified database file. 

Return Value 

True if successful, False if an error occurred or if a database is already open. 

Parameters 

string FileName Full pathname of database file. 
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Name 

Boolean DeleteRecords(integer SendDataType, integer StartRecordNo,  
  integer EndRecordNo) 

Function 

Deletes the specified range of records from the database and scales. 

Return Value 

True if successful, False if an error occurred. 

Parameters 

integer SendDataType Specifies the type of data to delete. 

 See "Data type" in C.3 Parameter Codes for details. 

integer StartRecordNo Specifies the start record number to delete.  
  Specify zero to delete all records. 

integer EndRecordNo Specifies the end record number to delete. 
  Ignored if StartRecordNo = 0 (delete all). 

Remarks 

Sends deletion commands to the scales for all records in the specified range, regardless of 
whether the records exist in the database or not. 
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Name 

Boolean ExportTextFile(string ExportName, string FileName) 

Function 

Executes the specified text file export operation. 

Return Value 

True if successful, False if an error occurred. 

Parameters 

string ExportName Name of a text file export operation that has been defined via 
Text File Export in the Setup menu. 

string FileName Full pathname of output text file. 

Remarks 

If an empty string is specified in the FileName parameter, a File Save As dialog opens for 
the user to select the output text file. 
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Name 

Boolean ExportTextFileEx(string FileName, integer ExportFormat, integer ExportDataType,
  boolean OutputHeaders, integer DescTextFormat, boolean IncludePriceZone,
  integer PriceZone, boolean ExportByScale, boolean UsePosCode, 
  boolean UseScaleNames) 

Function 

Performs text file export based on the specified parameters. 

Return Value 

True if successful, False if an error occurred. 

Parameters 

string FileName Full pathname of output text file. 

integer ExportFormat Specifies the export format. 

 Value Meaning   
    0 Comma-delimited 
    1 Tab-delimited 
    2 Custom format (SE Asia) 

integer ExportDataType Specifies the type of data to export 

 See "Data type" in C.3 Parameter Codes for details. 

boolean OutputHeaders Specifies whether to output column headers. 

integer DescTextFormat Specifies the format for outputting description text. 

 Value Meaning   
    0 Ishida format 
    1 Line by line 

boolean IncludePriceZone Specifies whether to output price zone information. 

integer PriceZone If IncludePriceZone is True, specify which price zone to 
output. 

boolean ExportByScale Specifies whether to output separately for each scale. 

boolean UsePosCode Specifies whether to use the POS code (bar code) instead of 
the PLU number. 

boolean UseScaleNames Specifies whether to use scale ID numbers or scale names for 
production data output. 

Remarks 

If an empty string is specified in the FileName parameter, a File Save As dialog opens for 
the user to select the output text file. 

See Appendix B.2 Text File Formats for more details about the meanings of the various 
output format options. 
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Name 

string GetErrorMessage() 

Function 

Returns a string containing an error message for the previous method call. The sting is 
empty if no error occurred. 

Return Value 

Error message string, or empty string if no error occurred. 

Parameters 

none 

Remarks 

Use the Boolean return value of each method call to determine whether the operation was 
successful. Only call GetErrorMessage() if the previous method call returned False. 
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Name 

Boolean ImportTextFile(string ImportName, string FileName) 

Function 

Executes the specified text file import operation. 

Return Value 

True if successful, False if an error occurred. 

Parameters 

string ImportName Name of a text file import operation that has been defined via 
Text File Import in the Setup menu. 

string FileName Full pathname of text file to import. 

Remarks 

If an empty string or a non-existent file name is specified in the FileName parameter, a File 
Open dialog opens for the user to select the text file to import. 
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Name 

Boolean ImportTextFileEx(string FileName, integer ImportFormat, integer ImportOperation,
  integer ImportDataType, integer DescTextFormat, boolean SendToScales, 
  boolean IncludePriceZone, boolean UsePosCode, boolean UseDeptPlu) 

Function 

Performs text file import based on the specified parameters. 

Return Value 

True if successful, False if an error occurred. 

Parameters 

string FileName Full pathname of output text file. 

integer ImportFormat Specifies the import format 

 Value Meaning   
    0 Comma-delimited 
    1 Tab-delimited 
    2 Custom format (SE Asia) 
    3 Custom format (Wal-Mart) 

integer ImportOperation Specifies the import operation. 

 Value Meaning   
    0 Add records (overwrite existing records) 
    1 Update records 
    2 Delete records 

integer ImportDataType Specifies the type of data to export 

 See "Data type" in C.3 Parameter Codes for details. 

integer DescTextFormat Specifies the format of any description text. 

 Value Meaning   
    0 Ishida format 
    1 Line by line 

boolean SendToScales Specifies whether to send imported records to the scales. 

boolean IncludePriceZone Specifies whether the import data includes a price zone field.

boolean UsePosCode Specifies whether the import data uses POS code (bar code) 
instead of the PLU number. 

boolean UseDeptPlu Specifies whether to assign PLU numbers based on 
department code. 

Remarks 

If an empty string or a non-existent file name is specified in the FileName parameter, a File 
Open dialog opens for the user to select the text file to import. 
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Name 

Boolean IsUnsentDataWaiting() 

Function 

Indicates whether any unsent data is present. “Unsent data” is data that could not be sent to 
a scale due to communication problems (such as the scale being off-line). 

Return Value 

True if unsent data is present, False otherwise. 

Parameters 

None 

 

 

Name 

Boolean LoadSetup(string FileName) 

Function 

Loads the specified general setup file. 

Return Value 

True if successful, False if an error occurred or if a database is already open. 

Parameters 

string FileName Full pathname of database file. 

Remarks 

If this method is not called, the default setup file is used. 

Cannot be used if a database is open. Load the setup file before opening the database. 

The loaded setup file is only used during the current session. Other ScaleLink Pro automation 
or user sessions continue to use the default setup file. 

 

Name 

Boolean LoadSiteSetup(string FileName) 

Function 

Loads the specified site setup file. 

Return Value 

True if successful, False if an error occurred or if a database is already open. 

Parameters 

string FileName Full pathname of database file. 

Remarks 

If this method is not called, the default site setup file is used. 

Cannot be used if a database is open. Load the site setup file before opening the database. 

The loaded site setup file is only used during the current session. Other ScaleLink Pro 
automation or user sessions continue to use the default site setup file. 
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Name 

Boolean ReadProdFromScales() 

Function 

Reads the production totals from the scales and saves in the production database. 

Return Value 

True if successful, False if an error occurred. 

Parameters 

None 

 

 

Name 

Boolean ScheduleClose() 

Function 

Closes the currently open schedule file. 

Return Value 

True if successful, False if an error occurred. 

Parameters 

None 

 

 

Name 

Boolean ScheduleExecOp(string Operation) 

Function 

Executes the specified operation from the currently open schedule file. 

Return Value 

True if successful, False if an error occurred. 

Parameters 

string Operation Name of an operation defined in the currently open schedule 
file. 

Remarks 

The operation is executed regardless of the execution time settings in the schedule file. 

 

 

174 



 

Name 

Boolean ScheduleExecSched(string Operation) 

Function 

Executes all operations in the currently open schedule file. 

Return Value 

True if successful, False if an error occurred. 

Parameters 

None 

Remarks 

Operations are executed regardless of the execution time settings in the schedule file. 

 

 

Name 

Boolean ScheduleOpen(string FileName) 

Function 

Opens the specified schedule file. 

Return Value 

True if successful, False if an error occurred. 

Parameters 

string FileName Full pathname of schedule file. 
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Name 

Boolean SendToScales(integer SendDataType, integer StartRecordNo, 
   integer EndRecordNo) 

Function 

Sends the specified records from the specified database table to the scales. 

Return Value 

True if successful, False if an error occurred. 

Parameters 

integer SendDataType Specifies the type of data to send. 

 See "Data type" in C.3 Parameter Codes for details. 

integer StartRecordNo Specifies the start record number to send. 

integer EndRecordNo Specifies the end record number to send. 

 

 

Name 

Boolean SendUnsentData() 

Function 

Sends any unsent data to the scales. 

Return Value 

True if successful, False if an error occurred. 

Parameters 

None 
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Name 

Boolean SetEventLogFile(string FileName) 

Function 

Sets the event log to use the specified log file. Typically used to save the event log for 
automation operations in a separate file to user operations. 

Return Value 

True if successful, False if an error occurred or if a database is already open. 

Parameters 

string FileName Full pathname of database file. 

Remarks 

If this method is not called, the event log file specified in the default site setup file is used. 

Cannot be used if a database is open. Specify the event log file before opening the database. 

The designated file is only used during the current session. Other ScaleLink Pro automation or 
user sessions continue to use the event log file specified in the default site setup file. 

Calling the LoadSiteSetup( ) method after this method causes the event log file to be reset to 
the default file. 
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